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Introduction About This Guide vi
Introduction

Welcome Welcome to Gentran:Server® Windows® Forms Integration subsystem, Sterling 
Commerce’s Electronic Data Interchange (EDI) form-generation software for the 
Windows operating system. Gentran:Server provides you with the tools that you need to 
design forms to facilitate the keying and printing of EDI documents.
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What’s in this manual

Overview This manual contains a tutorial for Gentran:Server Forms Integration, using the 
EDIFACT 92.1 standard. This tutorial includes a print form example (purchase order) and 
a screen entry form example (invoice). The purpose of this tutorial is to break the form 
creation process into concise and understandable steps, using examples that enable you to 
understand and master the tasks and processes required to create your own forms.

Complete the print form tutorial first. After you have mastered the steps involved in 
creating a print form, you can begin the tutorial for the screen entry form.

Related Manuals To access reference information, refer to the Gentran:Server® Windows® Forms 
Integration online Help or “Gentran:Server® Windows® Forms Integration User’s Guide.” 
For additional information on the various tasks described in this manual, refer to 
“Gentran:Server® Windows® Forms Integration User’s Guide.”

Intended audience This manual is intended for the following users:

◗ Technical users—users with a detailed knowledge of the Windows operating system, 
networking, databases, and communications. 

◗ Novice-to-average experienced users—users who are new to Gentran:Server for 
Windows, EDI, or both. 

◗ EDI Coordinators—users responsible for creating and maintaining the transfer of EDI 
data between Trading Partners.

Prerequisite
knowledge

The audience using this software should be familiar with:

◗ PC and Microsoft® Windows functions
◗ EDI concepts
◗ EDI standard structure
◗ the internal application format
◗ data mapping concepts
◗ Gentran:Server® Windows® product
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Description of Contents

Overview The Forms Integration EDIFACT Tutorial contains the tasks associated with using the 
Forms Integration subsystem. 

Organization of
chapters

The tutorial guide is organized into the following chapters:

◗ Chapter 1, Getting Started, explains the content, organization, conventions, and 
system requirements. This chapter describes how to build forms and how to 
customize global EDI date formats.

◗ Chapter 2, Creating a Print Form, explains the tasks necessary to create a print form 
for an EDIFACT purchase order (ORDERS).

◗ Chapter 3, Creating a Screen Entry Form, explains the tasks necessary to create a 
screen entry form for an EDIFACT invoice (INVOIC).

◗ The Glossary contains definitions of Forms Integration and Gentran:Server terms and 
concepts.
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Online Help

Overview The majority of the Gentran:Server for Windows Forms Integration User’s Guide 
documentation is also contained in the online Help system.
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Getting Support

Introduction Sterling Commerce’s Gentran:Server software is supported by trained product support 
personnel who are available to help you with product questions or concerns.

Note
Gentran:Server Customer Support does not support non-Sterling Commerce products 
(e.g., SQL Server, Oracle, etc.), but can assist you in configuring non-Sterling Commerce 
products to work with Gentran:Server.

Phone number For assistance, please refer to your Getting Started card to determine which support phone 
number you should use.

Before calling
support

To help us provide prompt service, we ask that you do the following:

◗ Attempt to recreate any problem that you encounter and record the exact sequence of 
events. 

◗ When you call product support, you should be prepared to provide us with the 
information below.

Information Description

Identification Your company name, your name, telephone number and 
extension, and the case number (if the question refers to a 
previously reported issue).

System Configuration The Gentran:Server version (and any service packs 
installed) and information about the primary Gentran 
system controller and all machines experiencing 
problems, including: the Windows operating system 
version, amount of memory, available disk space, 
database version, Microsoft Data Access (MDAC) 
version, and Internet Explorer version.

Also, please describe any recent changes in your 
hardware, software, or the configuration of your system.

System Data Store Which machines contain folders in the system data store?

Error Messages Record the exact wording of any error messages you 
receive and the point in the software where the error 
occurred, as well as any log files.

Attempted Solutions Record any steps that you took attempting to resolve the 
problem and note all the outcomes, and provide an 
estimate on how many times the problem occurred and 
whether it can be reproduced.
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Accessing the
Sterling

Commerce
Support Web Site

The Sterling Commerce Customer Support Web Site contains valuable information about 
getting support for Gentran:Server for Windows, including the:

◗ scope of support services
◗ customer support policies
◗ call prioritizing
◗ customer support phone directory
◗ how to create new Support on Demand cases
◗ how to check the status of Support on Demand cases
◗ how to add information to Support on Demand cases

The Customer Support Web Site is constantly updated and all Sterling Commerce 
customers have access to it. This web site also contains the most recent product updates 
and is a valuable source of product information.

Reference
Refer to the Getting Started Card for information on how to access the Customer Support 
World Wide Web Site.

Documentation The Customer Support Web Site contains a documentation library, which has the entire 
Gentran:Server for Windows documentation set. You can download the product manuals 
in PDF format from this library at any time.
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Introducing Forms Integration

Overview The Gentran:Server Forms Integration subsystem enables you to design forms to facilitate 
the keying (screen entry) and printing (print) of EDI documents that you receive inbound 
or send outbound.

What is a form? A form is a set of instructions you define in the Forms Integration subsystem that indicates 
how the system should format data. When you compile the form, Gentran:Server 
generates a translation object. After you register the translation object with Gentran:Server 
and associate the translation object with a partner relationship, the system uses the 
translation object to format EDI documents. The Forms Integration subsystem enables you 
to create print and screen entry translation objects.

Regardless of whether the translation object is print or screen entry, Gentran:Server 
generates the actual format of the translation object based on the EDI file format (in the 
EDI File Format Pane), and displays it in the Layout Pane.

What is a print
translation object?

A print translation object organizes and formats the printout of EDI documents that are 
received from or sent to the trading partners for which you have established a trading 
relationship (inbound or outbound) that utilizes that print translation object. The print 
translation object enables you to view the EDI document in an easily readable format.

What is a screen
entry translation

object?

A screen entry translation object provides a standardized format for keying an EDI 
document into the Document Editor, for translation and transmission to your trading 
partners, for which you have established an outbound trading relationship that utilizes that 
screen entry translation object. The screen entry translation object ensures that your users 
key all the data necessary to create the required EDI document.
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Navigation

Overview The Gentran:Server Forms Integration Window allows you to access its functionality in 
four different ways, as follows:

◗ Click the menu option from the Main Menu Bar.
◗ Click the appropriate button on the Main Toolbar.
◗ Click or double-click the appropriate part of the form.
◗ Click a form component (EDI File Format Pane or Layout Pane) with the right mouse 

button to access a shortcut menu that contains all the functions that are currently 
available for that form component. The shortcut menus enable you to quickly and 
easily access available functionality. The content of the shortcut menus vary, 
depending on the type and level of the selected form component.

Forms Integration
Window

This diagram illustrates the Forms Integration Window.

Main Menu Bar Main Toolbar

EDI File Format Pane Layout Pane
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Forms Integration
Window parts and

functions

This table describes the parts of the Gentran:Server Forms Integration Window.

Main Toolbar The Main Toolbar gives you access to some of the most common operations in 
Gentran:Server. Unavailable items are dimmed. The Main Toolbar is a dockable toolbar, 
so you can affix it to any edge of the client window. This diagram illustrates Main Toolbar.

Part Function

Main Menu Bar The Main Menu Bar contains the menus. 

Note
Detailed descriptions of each of the commands on these 
menus are found in the online Help.

Main Toolbar The Main Toolbar gives you access to some of the 
most common operations in Gentran:Server.

EDI File Format Pane The EDI File Format Pane contains the EDI file 
format. When you click a segment or group in the EDI 
file format, the corresponding frame is displayed in the 
Layout Pane. When you click an element in the EDI 
file format, the corresponding layout component is 
highlighted in the Layout Pane.

Layout Pane The Layout Pane contains the actual format of the 
translation object. Each group (with a maximum usage 
greater than one) and repeating segment has a 
corresponding frame in the Layout Pane. When you 
click a segment or group in the EDI file format, the 
corresponding frame is displayed in the Layout Pane. 
When you click an element in the EDI file format, the 
corresponding layout component is highlighted in the 
Layout Pane.

Layout

Change

Open

New
Save

Compile

Cut

Copy

Paste

Session

Constants

Syntax

Code Lists

Promote

Split

Activate

Deactivate

Tokens

Rules
Generate

Add Text

Layout

Lock Labels

Undo

Redo

Tree Only

Only

View
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EDI File Format Pane

Overview The EDI File Format Pane (left side of the Forms Integration subsystem main window) 
contains the EDI file format. The EDI file must contain all the information that you need 
to include to either create a document using the Document Editor (screen entry translation 
object) or print documents (print translation object), so that your system can accurately 
process the data. 

Generating EDI
files

Gentran:Server generates an EDI file for you, based on the standard (agency), version, 
transaction set, and release (for the TRADACOMS standard only) you selected. The 
system includes all the groups, segments, composites, and elements that are defined by the 
standards agency for the version of the document you selected. 

You typically need to customize the system-generated EDI file by modifying the 
properties of the form components, and using specialized Gentran:Server functions to 
manipulate the EDI file structure.

Reference
See Defining the Type of Form on page 2 - 22 (print) or Defining the Type of Form on 
page 3 - 22 (screen entry) for more information on generating an EDI file when you create 
a new form.

Generating
specialized EDI

standard versions

If you want to use a specialized version an EDI standard that is not available in the 
Gentran:Server standards database, it may be appropriate for you to define the EDI file 
yourself.

Regardless of whether the system generates the EDI file or you define it, the specific EDI 
form components that you use depend on the type of form you are creating. This includes 
the standard, version, and transaction set (document) selected, and which groups, 
segments, composites, and elements your company requires. 

Recommendation
We recommend that you determine which form components you are using before 
generating or defining an EDI file.
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Form components This table describes form components that Gentran:Server uses to define the EDI file 
format.

Icon Description

 A group is a looping structure that contains related segments and/or 
groups that repeat in sequence until either the group data ends or the 
maximum number of times that the loop is allowed to repeat is 
exhausted. Groups are defined by the EDI standards. A group that is 
subordinate to another group is a sub-group (this corresponds to a 
nested looping structure – a loop within a loop). The EDI file is a group 
and therefore, it is visually represented the same way as other groups 
and sub-groups in Gentran:Server.

A segment contains a group of related elements or composite data 
elements that combine to communicate useful data. Segments are 
defined by the EDI standards. A segment can occur once or can repeat 
multiple times. 
A segment is visually represented in Gentran:Server as the following:

A composite is a data element that contains two or more component 
data elements or sub-elements. Composites are defined by the EDI 
standards that use them (EDIFACT, TRADACOMS, and certain ANSI 
X12 standards). 
A segment is visually represented in Gentran:Server as the following:

An element is the smallest piece of information defined by the EDI 
standards. An individual element can have different meaning 
depending on the context. Therefore, elements are normally not 
considered to have useful meaning until they are combined into 
segments. A segment is visually represented in Gentran:Server as the following:

When an element has an operation performed against it, a red 
checkmark is displayed over the element icon.

When a field contains a standard rule a black asterisk appears to the 
right of the element icon.
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Layout Pane

Overview The Layout Pane (right side of the Forms Integration subsystem main window) contains 
the actual format of the translation object. Gentran:Server uses frames to format the EDI 
file for the translation object. Each frame contains the groups, repeating segments, and 
elements at that level (single segments are not represented on the frame). 

List formats For screen entry translation objects, groups (with a maximum usage greater than one) and 
repeating segments are formatted as lists. Elements are formatted as edit boxes (fields) or 
lists on the frame. Elements typically are formatted as fields, but are formatted as a list if 
you apply a standard rule that allows a selection of multiple items. Each group and 
repeating segment also has a corresponding frame that contains all the groups (with a 
maximum usage greater than one), repeating segments, and elements at that level. 

Field formats For print translation objects, groups, repeating segments, and elements are always 
formatted as fields. 

Frames Each group and repeating segment also has a corresponding frame that contains all the 
groups (with a maximum usage greater than one), repeating segments, and elements at that 
level.

Displaying
information

When you click a segment or group in the EDI File Format Pane, the corresponding frame 
is displayed in the Layout Pane. When you click an element in the EDI File Format Pane, 
the corresponding layout component is highlighted in the Layout Pane.
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Building a Form with Forms Integration

Overview This section defines how to proceed with building a form using the Gentran:Server Forms 
Integration subsystem.

Stages of building
a form

This table describes the steps required to build a form using Forms Integration.

Stage Description

1 Prepare and Analyze.
Obtain a layout of how you want the document displayed and determine 
how it corresponds with the EDI standard you are using. Determine 
which operations need to be performed to generate the required layout.

2 Set Global Defaults (first time only).
The first time you use the Gentran:Server Forms Integration subsystem, 
you should establish the default date format that the system will use. 

Reference
See Design and Create the Form on page 2 - 21 (print) or Design and 
Create the Form on page 3 - 21 (screen entry) for more information about 
setting the global date default.

3 Create, Save, and Name a New Form.

Reference
See Design and Create the Form on page 2 - 21 (print) or Design and 
Create the Form on page 3 - 21 (screen entry) for more information about 
creating, saving, and naming a form.

4 Activate the Appropriate EDI Groups, Segments, and Elements.

Reference
See Activating Groups, Segments, Composites, and Elements on 
page 2 - 26 (print) or Activating Groups, Segments, Composites, and 
Elements on page 3 - 26 (screen entry) for more information.

5 Promote, Split, and Change Segments and Groups.

Reference
See Modify Form Components on page 2 - 33 (print) or Modify Form 
Components on page 3 - 32 (screen entry) for more information about 
promoting, splitting, and changing segments and groups.

(Continued on next page)
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6 Customize the EDI Data.

Reference
See Customize the EDI Data on page 2 - 48 (print) or Customize the EDI 
Data on page 3 - 49 (screen entry) for more information.

7 Define the Layout of the Form.

Reference

See Format the Print Form on page 2 - 99 or Format the Screen Entry 
Form on page 3 - 141 for more information about customizing your EDI 
file, including verifying the EDI delimiters.

8 Compile the Form.

Reference

See Compiling the Form on page 2 - 126 (print) or Compiling the Form 
on page 3 - 169 (screen entry) for more information on compiling the 
translation object and translation object naming conventions.

9 Print the Report.
Validate and review the form, and make modifications as needed.

Reference
See Printing the Report on page 2 - 128 (print) or Printing the Report on 
page 3 - 172 (screen entry) for more information.

10 Test the Translation Object.
For a screen entry translation object, create a new document in Document 
Editor, using that translation object. For a print translation object, print a 
document. Verify that the output is correct.

Reference
See Testing the Translation Object on page 2 - 129 (print) or Testing the 
Translation Object on page 3 - 173 (screen entry) for more information.

 (Contd)
Stage Description
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How to Launch Forms Integration

Overview This section describes how to launch the Forms Integration subsystem by means of 
Gentran:Server.

Procedure Use this procedure to launch the Forms Integration subsystem. 

Step Action

1 Select Programs from the Windows Start menu. 

2 Select Gentran Server Forms Integration from the Gentran Server 
Programs group. 

System Response
The system displays the Forms Integration subsystem.
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How to Install Gentran Standards

Overview Note
You need to install Gentran Standards only if you installed Integration Components during 
the Gentran:Server installation.

Reference
See the appropriate Gentran:Server Standards card for information about installing the 
Gentran Standards.
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Overview 0

Introduction

In this chapter This chapter includes the following topics associated with creating a print form:

◗ Form analysis
◗ Creating, saving, and setting up a new form
◗ Customizing the form, including the groups, segments, and elements
◗ Formatting the form, including fields and field labels
◗ Finalizing the form

Purpose of this
tutorial

This tutorial explains how to customize and format a form before it is compiled into a 
translation object. The form that you create is a source form. After that source form is 
compiled, the result is a compiled translation object. You must register the translation 
object with Gentran:Server before you can use the translation object to print messages of 
that type.

Form criteria Gentran:Server generates a basic form based on the following information:

◗ Type of form (print or screen entry)
◗ Standard agency (e.g., EDIFACT)
◗ Standard version (e.g., 92.1)
◗ Message type (e.g., ORDERS)

Mandatory
components

All mandatory groups, segments, composites, and elements for the standard, version, and 
message you specify are available for use (activated) when Gentran:Server creates a form. 
Only these mandatory form components (groups, segments, composites, and elements) are 
activated automatically. You must activate additional form components to accommodate 
the data you expect to receive from your trading partner and then customize and format 
the form so that it is appropriate and useful for your company’s needs.
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Before you begin Before you begin to customize a print form, you should be familiar with the following 
elements of form design:

◗ EDI Standards (how EDI standards work and how the information your users need is 
translated to and from the standards)

◗ Your users (the individuals who use the print translation objects to create printouts of 
processed EDI data)

◗ Your trading partners (the organizations that send you or that you send the EDI data to 
be processed and printed).

You can create a different print form for each combination of message, trading partner, 
and standard version. You can create an unlimited number of print forms, and the number 
of print forms you create is not affected by the number of screen entry forms you create.

Recommendation
We recommend that you mock up a layout of the print form the way you ultimately want it 
to look. As you design the layout, make sure that the form will make sense to the people 
who will use it. By analyzing your company’s needs before you actually create the print 
form, you reduce the amount of time spent later on redesigning or reformatting the form. 
You should include the following design considerations in your form planning:

◗ Which fields should be printed, and which are necessary for the EDI data but do not 
need to be displayed on the printout

◗ Where fields should be located on the form
◗ What labels you will use to identify the fields on the form.
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Phases of Designing a Form

Design phases This table lists the phases of form design.

Phase Description

1 Analyze the EDI File.

2 Design and create the form.

3 Modify form components.

4 Customize the EDI data.

5 Format the print form.

6 Finalize the form.
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Getting started

Overview This tutorial is meant to be completed in its entirety. We strongly recommend that you 
complete each task sequentially. The purpose of completing each task in this tutorial in 
sequential order, as if it were your own scenario, is not only to teach you how to perform 
the individual tasks, but also to teach you a logical approach and methods that should be 
used when you create your own form.

In this tutorial, you will create a new print form based on a scenario we have defined for 
you. This section includes the basics of creating the form, such as defining the scenario 
and analyzing the purpose of the form, creating and saving the form, and setting up the 
form. You can find techniques for customizing the segments, elements, and groups in the 
form, as well as for formatting the organization and appearance of the form, later in this 
chapter.

Print form
scenario

For this tutorial, you will create a print form for the ORDERS message (purchase order) 
using the EDIFACT 92.1 standard. The steps are broken down into manageable pieces so 
you can apply what you learn to your print forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a wide 
variety of pet supplies for pet stores. You will create a form that formats and arranges the 
EDI data you receive from one of your trading partners, Pet Zone (a large pet supply 
retailer), to produce a purchase order printout. You do not want to alter the integrity of the 
EDI data. You do want to interpret some of the codes included in the EDI message into 
more meaningful text.
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Analyze the EDI File 0

Basic Tasks

Introduction To analyze the EDI file, you must determine what data your trading partner will be 
sending you. You and your partner must agree on which standard, version, and message 
you will be using. In this tutorial, you are using an EDIFACT version 92.1 ORDERS 
purchase order. It is important to know what type of information that your partner will 
send you in the purchase order, and what type of data will be contained in each element 
used.

It is very helpful to review the EDI standard that you will use before analyzing the EDI 
file. We recommend that you obtain an EDI standards manual for the standard and version 
that you will use. Standards manuals are available from EDI standards agencies.

After discussing with your partner what they will send, determining which segments and 
elements your company requires, and reviewing the EDI standard, you can list the items 
that you will need to use. You will then make the form components you need available for 
use. 

For an EDIFACT purchase order (ORDERS), the following groups, segments, 
composites, and elements have been defined as mandatory by the standards committee. 

This table describes the components that are activated automatically when you create a 
new form.

Segment Composite Element Description

BGM Beginning of Message

DTM Date/Time/Period

C507

DTM01 Date/Time/Period Qualifier

UNS Section Control

UNS01 Section Identification
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Form analysis The first step in creating a form is to analyze its requirements. If the analysis you perform 
is complete, you will have all the information you need to create the form in an efficient 
and logical manner. If you omit this critical step and proceed directly to creating the form, 
it is likely that creating the form will be a much longer and arduous task, and the form may 
not work the way you need it to, due to oversights and omissions.

Creating a print form for the EDIFACT ORDERS purchase order requires several steps. 
Some steps are performed at the message level (such as activating form components), and 
others are iterative steps that are performed for each group, segment, or element in the 
form. In this analysis phase, you must determine what type of EDI data Pet Zone will be 
sending you, as well as what information you want to print for the purchase order. The 
fields on the form must accommodate all information that you want to print from the 
purchase order your trading partner sends you.

Required
components

This table lists the form components that are required (need to be activated) and are not 
mandatory for the standard.

Note
When you activate a conditional group, segment, or composite, the mandatory subordinate 
segments, composites, and elements are activated automatically. A conditional group, 
segment, or composite is used only if there is EDI data available for an element in it.

Element Description
Data
Type Length

Code Value/Format 
to Be Assigned

Beginning of Message (BGM Segment) (Already Activated)

BGM05 Document/Message Number String 35

BGM06 Message Function, Coded String 3

Date/Time/Period (DTM Segment)

DTM01 Date/Time/Period Qualifier String 3

DTM02 Date/Time/Period String 35 ◗ 4 (Change)
◗ 13 (Request)

Free Text (FTX Segment)

FTX01 Text Subject Qualifier String 3

FTX06 Free Text String 70

Reference (RFF Group)

Reference (RFF Segment)

RFF01 Reference Qualifier String 3

RFF02 Reference Number String 35 (Continued on next page)
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Name and Address (NAD Group)

Name and Address (NAD Segment)

NAD01 Party Qualifier String 3 ◗ AA (Party 
billed)

◗ BY (Buyer)
◗ ST (Ship to)

NAD10 Party Name String 35

NAD16 Street and Number/P.O. Box String 35

NAD17 Street and Number/P.O. Box String 35

NAD19 City Name String 35

NAD20 Country Sub-Entity 
Identification

String 9

NAD21 Postcode Identification String 9

Payment Terms Basis (PAT Group)

Payment Terms Basis (PAT Segment)

PAT01 Payment Terms Type 
Qualifier

String 3 ◗ 10 (Instant)
◗ 18 (Previously 

Agreed Upon)

PAT02 Terms of Payment 
Identification

String 17

PAT05 Terms of Payment String 35

Line Item (LIN Group)

Line Item (LIN Segment)

LIN01 Line Item Number Number 6

Additional Product ID (PIA Segment in LIN Group)

PIA01 Product ID Function Qualifier String 3

PIA02 Item Number String 35

Item Description (IMD:2 Segment in LIN Group)

IMD:206 Item Description String 35 (Continued on next page)

 (Contd)
Element Description

Data
Type Length

Code Value/Format 
to Be Assigned
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Basic Tasks Creating a Print Form2 - 10
Measurements (MEA:3 Segment in LIN Group)

MEA:301 Measurement Application 
Qualifier

String 3

MEA:305 Measure Unit Qualifier String 3

MEA:306 Measurement Value String 18 Format = R0

Quantity (QTY:3 Segment in LIN Group)

QTY:301 Quantity Qualifier String 3

QTY:302 Quantity Number 15 Format = N0

Date/Time/Period (DTM:13 Segment in LIN Group)

DTM:130
1

Date/Time/Period Qualifier String 3

DTM:130
2

Date/Time/Period String 35

Monetary Amount (MOA:5 Segment in LIN Group)

MOA:501 Monetary Amount Type 
Qualifier

String 3

MOA:502 Monetary Amount Number 18 Format = R2

Section Control (UNS Segment)

UNS01 Section Identification String 1

Control Total (CNT Segment)

CNT01 Control Qualifier String 3

CNT02 Control Value Number 18 Format = N0

 (Contd)
Element Description

Data
Type Length

Code Value/Format 
to Be Assigned
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Segment analysis For each mandatory or optional segment activated you must answer the following 
questions:

◗ Is the segment a group?
◗ Will the segment have a maximum use greater than one?
◗ What composites and elements need to be activated for the segment?

This table describes the segment components used in this tutorial.

Component Description

Group Contains related segments and/or groups that 
repeat in sequence until either the group data ends 
or the maximum number of times that the loop is 
allowed to repeat is exhausted.

Repeating segment Consists of elements that repeat in sequence until 
either the data ends or the maximum number of 
times the segment is allowed to repeat is exhausted.

Composite Contains two or more component data elements or 
subelements. Composites are defined by the EDI 
standards that use them (EDIFACT, 
TRADACOMS, and certain ANSI X12 standards).

Maximum use Refers to the number of times it can be used within 
the structure in which it is defined. For example, if 
a segment can be used only once within a group, 
but the group can be used multiple times, the 
segment still has a maximum use of one within 
each occurrence of the group. The standard defines 
the maximum number of times a segment can be 
used, but you must determine which of these 
segments will be used based on what your trading 
partner will be sending you.

Elements Each segment contains elements. Some elements 
are mandatory and others are optional to the 
standard but necessary for your needs. You must 
define all the elements that you will expect from 
Pet Zone for each segment.
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Customization
tasks

Gentran:Server generates a form based on the groups, segments, composites, and elements 
you activate. At this point, the form is compliant with the standard and it contains all the 
necessary components based on the data Pet Zone will send you. However, you need to 
customize the form components to produce a printed report the way your company 
expects it to look.

This table lists the customization tasks described in this tutorial.

Form 
Component Description Customization Task

BGM05 
element

Document/Message 
Number

You will set up the document name (which 
enables you to differentiate between messages 
in the document browsers in Gentran:Server) 
in this element. In addition, the standard allows 
this element to have a maximum length of 
thirty-five characters, but you expect a string 
no longer than ten characters from your trading 
partner. You will change both the maximum 
length of the element and the display length of 
the field to ten. Also, you will change the field 
name to Order Number, which better describes 
the data in this field for your company.

BGM06 
element

Message Function, 
Coded

The code from this element will be used to 
look up the description in a code list table, and 
the description will be printed in another field 
that you create. You will prevent the Message 
Function, Coded field from being displayed on 
the printout, because the more meaningful 
description will be printed instead.

DTM 
segment

Date/Time/Period The standard allows this segment to be used up 
to thirty-five times in one purchase order, but 
you and your trading partner have decided to 
use this segment only once. Therefore, you 
will change the maximum use of this segment 
to one.

DTM01 
element

Date/Time/Period 
Qualifier

This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

(Continued on next page)
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DTM02 
element

Date/Time/Period The standard allows a maximum length of 
thirty-five characters, but you expect a string 
no longer than eight characters from your 
partner. You will change the maximum length 
of the element and the display length of the 
field to eight. Also, you will change the field 
name to Order Date, which better describes the 
data in this field for your company.

FTX segment Free Text The standard allows this segment to be used up 
to five times in one purchase order, but you 
and your trading partner have decided to use 
this segment only once. Therefore, you will 
change the maximum use of this segment to 
one.

FTX01 
element

Text Subject 
Qualifier

This element is required in the purchase order, 
but is not meaningful for your purposes. 
Therefore, you will prevent this field from 
being displayed on the printout.

FTX06 
element

 Free Text The standard allows a maximum length of 
seventy characters, but you expect a string no 
longer than sixty characters from your partner. 
You will change the maximum length of the 
element and the display length of the field to 
sixty. Also, the data in this element will be 
self-explanatory, so you will remove the label 
from this field.

RFF group Reference The standard allows this group to be used up to 
ten times in one purchase order, but you and 
your trading partner have decided to use this 
group only once. Therefore, you will change 
the maximum use of this group. Also, you will 
promote this group so that the fields in this 
group are placed on the same frame as the 
related header fields.

RFF01 
element

Reference Qualifier This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

(Continued on next page)

 (Contd)
Form 
Component Description Customization Task
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RFF02 
element

Reference Number The standard allows a maximum length of 
thirty-five characters, but you expect a string 
no longer than twelve characters from your 
partner. You will change the maximum length 
of the element and the display length of the 
field to twelve. Also, you will change the field 
name to Contract No., which better describes 
the data in this field for your company.

NAD01 
element

Party Qualifier The qualifier from this element will be used to 
look up the description in a code list table, and 
the description will be printed in another field 
that you create. You will prevent the Party 
Qualifier field from being displayed on the 
printout, because the more meaningful 
description will be printed instead.

NAD10 
element

Party Name The data in this element will be explained by 
the qualifier in the Party Qualifier element, so 
you will remove the label from this field.

NAD16 
element

Street and Number/
P.O. Box

The data in this element will be self-
explanatory, so you will remove the label from 
this field.

NAD17 
element

Street and Number/
P.O. Box

The data in this element will be self-
explanatory, so you will remove the label from 
this field.

NAD19 
element

City Name The standard allows a maximum length of 
thirty-five characters, but you expect a string 
no longer than thirty characters from your 
partner. You will change the maximum length 
of the element and the display length of the 
field to thirty. Also, the data in this element 
will be self-explanatory, so you will remove 
the field label.

NAD20 
element

Country Sub-Entity 
Identification

The standard allows a maximum length of nine 
characters, but you expect a string no longer 
than two characters from your partner. You 
will change the maximum length of the 
element and the display length of the field to 
two. Also, the data in this element will be self-
explanatory, so you will remove the field label.

(Continued on next page)

 (Contd)
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NAD21 
element

Postcode 
Identification

The data in this element will be self-
explanatory, so you will remove the field label.

PAT group Payment Terms Basis The standard allows this group to be used up to 
ten times in one purchase order, but you and 
your trading partner have decided to use this 
group only once. Therefore, you will change 
the maximum use of this group. Also, you will 
promote this group so that the fields in this 
group are placed on the same frame as the 
related header fields.

PAT01 
element

Payment Terms Type 
Qualifier

The qualifier from this element will be used to 
look up the description in a code list table, and 
the description will be printed in another field 
that you create. You will prevent the Payment 
Terms Type Qualifier field from being 
displayed on the printout, because the more 
meaningful description will be printed instead.

PAT02 
element

Terms of Payment 
Identification

This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

PAT05 
element

Terms of Payment The data in this element will be explained by 
the qualifier in the Terms of Payment 
Identification element, so you will remove the 
label from this field.

LIN group Line Item After you customize and format the fields in 
the LIN group, you will copy and paste the 
LIN group at the same level in the EDI file. 
The original LIN group will contain column 
headings for the line item detail, but you will 
prevent the column headings from being 
printed for all line items after the first. You will 
change the maximum use of the first LIN 
group to one so that the column headings are 
printed only once (for the first line item). You 
will change the maximum use of the second 
LIN group to 199,999. Up to two hundred 
thousand line items (one from the first LIN 
group and 199,999 from the second LIN 
group) can be printed on the printout (without 
printing the column headings for each line 
item).

(Continued on next page)

 (Contd)
Form 
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LIN01 
element

Line Item Number The standard allows a maximum length of six 
characters, but you expect a string no longer 
than five characters from your partner. You 
will change the maximum length of the 
element and the display length of the field to 
five. Also, you will change the field name to 
Line, which briefly describes the data in this 
field.

PIA segment 
(in LIN 
group)

Additional Product 
ID

The standard allows this segment to be used up 
to twenty-five times for each line item, but you 
and your trading partner have decided to use 
this segment only once. Therefore, you will 
change the maximum use of this segment to 
one.

PIA01 
element

Product ID Function 
Qualifier

You will change the field name to Code, which 
more briefly describes the data in this field for 
your company.

PIA02 
element

Item Number The standard allows a maximum length of 
thirty-five characters, but you expect a string 
no longer than six characters from your 
partner. You will change the maximum length 
of the element and the display length of the 
field to six. Also, you will change the field 
name to Prod ID, which briefly describes the 
data in this field.

IMD 
segment (in 
LIN group)

Item Description The standard allows this segment to be used up 
to ten times for each line item, but you and 
your trading partner have decided to use this 
segment only once. Therefore, you will change 
the maximum use of this segment to one.

IMD06 
element

Item Description The data in this element will be self-
explanatory, so you will remove the label from 
this field.

MEA 
segment (in 
LIN group)

Measurements The standard allows this conditional segment 
to be used up to five times for each line item, 
but you and your trading partner want to use 
this segment only once. You will change the 
maximum use of this segment to one. Also, to 
make this segment mandatory, you will change 
the minimum use of this segment to one.

(Continued on next page)
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MEA01 
element

Measurement 
Application Qualifier

This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

MEA05 
element

Measure Unit 
Qualifier

This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

MEA06 
element

Measurement Value The standard allows a maximum length of 
eighteen digits, but you expect a number no 
longer than two digits from your partner. You 
will change the maximum length of the 
element and the display length of the field to 
two. You will change the field name to Unit, 
which better describes the data in this field for 
your company. Also, the standard defines the 
data in this element as being formatted with an 
explicit decimal point and up to nine decimal 
places. You will not use decimal places for the 
data in this field, so you will format both the 
EDI data and the printed data without decimal 
places.

QTY 
segment (in 
LIN group)

Quantity The standard allows this segment to be used up 
to ten times for each line item, but you and 
your trading partner want to use this segment 
only once. You will change the maximum use 
of this segment to one. Also, to make this 
segment mandatory, you will change the 
minimum use of this segment to one.

QTY01 
element

Quantity Qualifier This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

(Continued on next page)
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QTY02 
element

Quantity The standard allows a maximum length of 
fifteen digits, but you expect a number no 
longer than six digits from your partner. You 
will change the maximum length of the 
element and the display length of the field to 
six. You will change the field name to Qty, 
which briefly describes the data in this field. 
Also, the standard defines the data in this 
element as being formatted with an explicit 
decimal point and up to nine decimal places. 
You will not use decimal places for the data in 
this field, so you will format both the EDI data 
and the printed data with an implicit decimal 
point and no decimal places.

DTM 
segment (in 
LIN group)

Date/Time/Period The standard allows the date/time/period to be 
used up to thirty-five times for each line item. 
You need two separate DTM segments: the 
required shipment date, and the last delivery 
date (in that order). You will promote this 
segment to cause another iteration of this 
segment to occur for each line item, and then 
change the maximum use to one because you 
need to use this segment only once per line 
item. Also, you know what types of dates you 
will receive (and in what order), so you will 
use the key field function to print the required 
shipment date in one DTM segment and the 
last delivery date in the other DTM segment.

DTM01 
element

Date/Time/Period 
Qualifier

This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

DTM02 
element

Date/Time/Period The standard allows a maximum length of 
thirty-five characters, but you expect a string 
no longer than eight characters from your 
partner. You will change the maximum length 
of the element and the display length of the 
field to eight. Also, you will change the field 
name to Requested (or Ship No for the DTM02 
element in the second iteration of the DTM 
segment), which briefly describes the data in 
this field.

(Continued on next page)
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MOA 
segment (in 
LIN group)

Monetary Amount The standard allows this segment to be used up 
to five times for each line item, but you and 
your trading partner have decided to use this 
segment only once. You will change the 
maximum use of this segment to one.

MOA01 
element

Monetary Amount 
Type Qualifier

This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

MOA02 
element

Monetary Amount The standard allows a maximum length of 
eighteen digits, but you expect a number no 
longer than eight digits from your partner. You 
will change the maximum length of the 
element and the display length of the field to 
eight. You will change the field name to Price, 
which better describes the data in this field for 
your company. Also, the standard defines the 
data in this element as being formatted with an 
explicit decimal point and up to nine decimal 
places. You need only two decimal places for 
the data in this field, so you will format the 
EDI data and the printed data with two decimal 
places.

UNS01 
element

Section Identification This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

CNT 
segment

Control Total 
Segment

You want this segment to print the total 
number of line items at the end of the printout. 
However, if the form were generated now, the 
total would be printed at the beginning of the 
printout (because the fields in the CNT 
segment would be displayed on the same frame 
as the fields in the BGM segment). You will 
change the arrangement of the form, while 
maintaining the integrity of the EDI data, so 
the total is printed at the end of the purchase 
order.

CNT01 
element

Control Qualifier This element is required in the purchase order, 
but is not meaningful for your purposes. You 
will prevent this field from being displayed on 
the printout.

(Continued on next page)
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CNT02 
element

Control Value The standard allows a maximum length of 
eighteen digits, but you expect a number no 
longer than six digits from your partner. You 
will change the maximum length of the 
element and the display length of the field to 
six. You will change the field name to Number 
of Line Items, which better describes the data 
in this field for your company. Also, the 
standard defines the data in this element as 
being formatted with an explicit decimal point 
and up to nine decimal places. You will not use 
decimal places for the data in this field, so you 
will format both the EDI data and the printed 
data with an implicit decimal point and no 
decimal places.

 (Contd)
Form 
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Design and Create the Form 0

Verifying the Global EDI Date Formats

Introduction Gentran:Server Forms Integration enables you to customize the global EDI date formats. 
You can specify the default EDI format of dates for both six-character dates and eight-
character dates. After you customize the global EDI date formats, the settings are valid for 
all forms created in the current session. You can override the default date formats for an 
individual element on the Field Properties dialog for that element.

You must verify that you are using the correct global date formats the first time you use 
Forms Integration. You can change the default date formats if they do not match the 
formats you intend to use.

Procedure Use this procedure to verify the global EDI date formats.

Step Action

1 Launch the Forms Integration subsystem. 

Reference
See How to Launch Forms Integration on page 1 - 10 for instructions. 

2 Select Preferences from the Options menu to display the Preferences 
dialog. 

Note
The Preferences dialog is a property sheet that enables you to set global 
defaults for Gentran:Server Forms Integration

3 Verify that the Standard Formats tab displays the default date formats that 
are used when elements are read from the standards database.

4 Verify that the Six-character dates list contains YYMMDD to define the 
format of the six-character EDI dates in your forms.

5 Verify that the Eight character dates list contains YYYYMMDD to 
define the format of the eight-character EDI dates in your forms.

6 Click OK to accept the default date formats for 6- and 8-character date 
fields and to exit the Preferences dialog.

Note
To change the order in which the date formats appear in the Six-character 
dates and Eight character dates lists or to add a new date format to the 
lists, select Date Formats from the Options menu.
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Defining the Type of Form

Overview The first task in creating a new form is to define the type of form and EDI standard, 
version, and message. In this tutorial, you are creating a print form so that you can print 
the purchase orders that your partner sends you. Instead of defining the ORDERS message 
to the system yourself, you want Gentran:Server to use the standards database on your 
system to build the purchase order according to the EDIFACT standard.

Before you begin Before you begin this procedure, verify that you have installed the Gentran Standards.

Reference
See How to Install Gentran Standards on page 1 - 11 for instructions. 

Procedure Use this procedure to create the new print form.

Step Action

1 Select New from the File menu to display the New Form Wizard. 

2 From the What kind of form are you creating list, select Print to indicate 
that the translation object you are creating is a print translation object.

3 In the What is the name of the form box, enter Print ORDERS Pet Zone. 
This description provides a brief explanation of the compiled translation. 

Example
Print ORDERS Pet Zone is the description of a print translation object for 
an EDIFACT 92.1 purchase order (ORDERS) for partner Pet Zone.

4 Verify that the name that appears in the What is your name box is 
accurate. 

5 Click Next to advance the wizard. 

6 Select Delimited EDI as the data format syntax that you want to use. 

7 Click Customize. 

System Response
The system displays the New Delimited EDI Wizard. 

8 Click Next to continue. 

9 From the Data Source list, select Gentran Standards ODBC data source 
that you wish to use.

10 Click Next to continue. 

(Continued on next page)
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11 From the Agency list in the Standards section, select [E] Edifact, which is 
the EDI standard you will use for this translation object.

12 From the Version list, select [092001] EDIFACT 1992 RELEASE 1, 
which is the version of the standard you will use for this translation object. 
The versions that are available depend on which standard you selected. 
The EDIFACT standard version 92.1 is listed as version 092001 in the 
Gentran:Server standards files.

13 From the Transaction list, select [ORDERS] PURCHASE ORDER 
MESSAGE, which is the message you will use for this translation object. 
The messages that are available depend on which standard and version 
you selected.

14 Click Next to continue. 

15 Click Finish. This may take a few seconds. 

System Response
The system displays the New Form Wizard dialog box.

16 Click Next to continue. 

17 Click Finish to create the EDI file. 

System Response
The form is displayed.

18 From the Edit menu, select Details. 

System Response
The Translation Object Details dialog box is displayed. 

(Continued on next page)

 (Contd)
Step Action
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19 Verify that Print is selected from the Translation Object Function list.

20 In the Major version box, enter 1 to designate the version number for this 
translation object.

21 In the Minor version box, accept the default value 0 that designates the 
release number for this translation object.

Recommendation
After you make a major change to this form, increase the version to the 
next higher sequential number (e.g., 2.0). If you make a minor change to 
the form, increase the release to the next higher sequential number (e.g., 
2.1).

22 The Input and Output boxes (Agency, Version, Transaction, Release, and 
F Group) contain information only if the Input and/or Output sides of the 
form are of EDI format. For this tutorial, do not change the information in 
these boxes.

Note
The system allows you to change the information in the Input and Output 
boxes, but modifying this information does not alter the content of the 
form. An example of when you might want to alter these boxes is when 
you want the form to reflect a standard version that is not loaded on your 
system. You can change the version on this dialog, and then physically 
alter the form to be compliant with that version.

23 Click OK to save your changes and to exit the Translation Object details 
dialog box. 

24 Select Save from the File menu. 

Recommendation
We recommend that you save the form as often as possible, to mitigate the 
possible loss of additions or modifications in the event of a hardware or 
system error.

Note
If you have performed any function that invalidates the current format of 
the translation object, the Save function is unavailable until you 
regenerate the layout (click Generate Layout on the Main Toolbar).

25 Verify that the Save in list reflects the drive\folder where Gentran:Server 
is installed. 

Default
The default drive\folder is GENSRVNT\Forms. 

(Continued on next page)

 (Contd)
Step Action
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26 In the File name box, enter peteordp.stp to replace the default file name. 
The file name should be unique. In our example, the name indicates an 
EDIFACT purchase order message (ORDERS) for partner Pet Zone.

Note
The default file extension for forms is .STP. The naming conventions in 
Gentran:Server – Forms Integration are as follows:

◗ The source form (form created in Gentran:Server) should be named 
using the file extension .STP (e.g., PETEORDP.STP).

◗ The compiled translation object (translation object that is the result of 
compiling the source form) should be named using the same file 
name that was allocated to the source form, but with the file extension 
.TPL (e.g., PETEORDP.TPL).

27 Click Save to save the form.

 (Contd)
Step Action
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Activating Groups, Segments, Composites, and Elements

Overview When Gentran:Server generates the form, the system includes all the groups, segments, 
composites, and elements that are defined by the standard agency (EDIFACT) for the 
version (92.1) of the message (ORDERS) you selected. The system activates all the 
groups, segments, composites, and elements that are defined as mandatory (must be 
present) by the standard. The system does not enable you to deactivate the mandatory 
groups, segments, composites, and elements.

Example In the example below, the BGM and DTM segments, C507 composite, and DTM01 
element are mandatory for the purchase order. You do not need to activate these 
components. The DTM02 and DTM03 elements are not mandatory, so they are dimmed 
on the form.

To view the segments, composites, and elements in a group, segment, or composite on 
your form, double-click the form component in the EDI File Format Window (left side of 
the Forms main window). To activate an inactive form component, click Activate on the 
Main Toolbar, then click the form component. The component is no longer dimmed.

You must activate the groups, segments, composites, and elements that are not defined as 
mandatory by the standard, but that you have determined that you need to use in the form.

Groups, segments,
composites,

elements used in
this tutorial

This table lists the groups, segments, composites and elements to be used in this tutorial.

Group Segment Composite Element

BGM
(already activated)

BGM05

BGM06

DTM
(already activated)

C507
(already activated)

DTM02

FTX C108

RFF RFF C506
(mandatory for RFF)

RFF02

(Continued on next page)
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NAD NAD C080

C059 NAD17

NAD19

NAD20

NAD21

PAT PAT C110 PAT05

LIN LIN LIN01

PIA C212
(mandatory for PIA)

PIA02

IMD:2 C273 IMD:206

MEA:3 C174 MEA:306

QTY:3

DTM:13 C507
(mandatory for DTM:13)

DTM:1302

MOA:5 C516
(mandatory for MOA:5)

MOA:502

CNT

 Segment Composite Element
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Procedure Use this procedure to activate the required groups, segments, composites, and elements.

CAUTION
YOU MUST ACTIVATE ALL REQUIRED GROUPS, SEGMENTS, 
COMPOSITES, AND ELEMENTS LISTED ON THE FOLLOWING 
TABLE. FAILURE TO DO SO WILL HINDER YOUR ABILITY TO 
PERFORM STEPS LATER IN THIS TUTORIAL.

Step Action

1 On the Petorp.stp form that you just created, double-click the groups, 
segments, and composites listed in the previous table to open them. 
Opening all the necessary groups, segments, and composites before you 
start to activate enables you to scroll down the form and activate the 
segments, composites, and elements sequentially.

Note
When you activate a conditional group, segment, or composite, the 
mandatory subordinate segments, composites, and elements are activated 
automatically.

2 Click the Activate button on the Main Toolbar.

3 Click each inactive group that you need to use. This will activate the 
groups.

Note
If you click a group, segment, composite, or element that you did not 
mean to activate, click the component with the right mouse button to 
access the shortcut menu then select Deactivate from the shortcut menu.

4 Click each inactive segment that you need to use. This activates the 
segments.

5 Click each inactive composite that you need to use. This activates the 
composites.

6 Click each inactive element that you need to use. This activates the 
elements. 

Note
When you activate an element in a print form, the tag Printed is displayed 
before that element’s description to indicate that this field will be printed. 
If you later prevent a field from being displayed on the printout, then the 
tag Not Printed is displayed before that element’s description.

(Continued on next page)
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7 Click the Activate button on the Main Toolbar to turn activation mode off.

Note
To hide the groups, segments, and elements that you are not using, select 
Show Active Only from the View menu.

8 From the File menu, select Save to save your form. 

 (Contd)
Step Action
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Verifying EDI Delimiters

Overview You are using an EDI standard that contains composite elements or subelements, so you 
must verify that Gentran:Server is specifying the correct delimiters. Delimiters are flags 
that you define to the system as separating specific EDI components. Delimiters are 
necessary for all variable field-length standards, because the data is compressed and the 
leading zeroes and trailing blanks are removed. The fields vary in length, so the system 
needs a flag to determine where one element ends and another begins. For example, an 
element delimiter marks the beginning of a new element.

EDI delimiters
table

This table lists the valid EDI delimiters.

Field
EDIFACT Default 

Character
EDIFACT Default 

Hex Value

Tag Delimiter + (plus sign)

Segment Delimiter ‘ (apostrophe) 0x27

Element Delimiter + (plus sign) 0x2B

Sub Element Delimiter : (colon) 0x3A

Decimal Separator . (period) 0x2E

Release Character ? (question mark) 0x3F
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Procedure Use this procedure to verify EDI delimiters.

Step Action

1 Click the ORDERS file icon with the right mouse button and select 
Properties from the shortcut menu to display the File Format Properties 
dialog.

System Response
The system displays the File Format Properties dialog box.

(Continued on next page)
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2 Click the Delimiters tab to access the Delimiters dialog box.

System Response
The system displays the Delimiters dialog box.

3 Verify that the correct delimiters are being used for the EDIFACT 
standard. If the delimiters differ from the default values listed in the 
previous table, you can enter either the character or the hexadecimal value 
in the correct box. 

Reference
See the EDI delimiters table on page 2 - 30 for a list of valid EDI 
Delimiters.

4 Click OK to save the delimiters and exit the Delimiters dialog.

 (Contd)
Step Action
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Modify Form Components 0

Promoting and Changing Segments and Groups

Introduction The Promote function extracts one iteration or instance of a group or repeating segment. 
Promote is a specialized function that preserves the integrity of the EDI structure.

By default, the fields corresponding to each group and repeating segment are displayed on 
a separate frame than the rest of the fields in the document. When you promote a group to 
the parent frame, the fields corresponding to the group are displayed on the frame to which 
the group is subordinate. If you do not promote a group to the parent frame, the fields 
corresponding to the group are displayed on their own frame.

Changing the
minimum use

Changing the minimum use of a segment or group from zero to one changes the status of 
the segment or group from conditional to mandatory. If EDI data is not present for a 
segment or group that has a minimum use of one or greater, a compliance error occurs 
during translation for that segment or group.

Changing the
maximum use

A segment or group with a maximum use greater than one repeats (loops) and is placed on 
a separate frame than the segment or group to which it is subordinate. A segment or group 
with a maximum use of one does not repeat and its fields are displayed on the same frame 
as the group or segment to which they are subordinate.
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Modifying the DTM Segment

Overview This section describes how to change the maximum use of the DTM segment.

How to change the
maximum use of

the DTM segment

The DTM segment contains Date/Time/Period header information (in this tutorial, the 
order date) used in the EDI data. The standard allows the DTM segment to be used up to 
35 times in one purchase order. In this tutorial, you expect the DTM segment only once 
from your trading partner, so you will change the maximum number of times this segment 
can be used to one.

Use this procedure to change the maximum use of the DTM segment.

Step Action

1 Click the DTM segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1 to indicate that this segment can be used 
only once.

4 Click OK to exit the Segment Properties dialog.
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Modifying the FTX Segment

Overview The FTX segment contains Free Text header details in the EDI data. The standard allows 
the FTX segment to be used up to five times in one purchase order. In this tutorial, you 
expect the FTX segment only once from your trading partner so you will change the 
maximum number of times this segment can be used to one.

Procedure Use this procedure to change the maximum use of the FTX segment.

Step Action

1 Click the FTX segment with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1. 

4 Click OK to exit the Segment Properties dialog.
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Modifying the RFF Group

Overview If the form were generated now, the fields associated with the RFF group would be 
displayed on a separate frame than the BGM header fields. The standard allows the RFF 
group to be used up to 10 times in one purchase order. In this tutorial, you expect the RFF 
group only once from your trading partner so you will change the maximum number of 
times the RFF group can be used to one. Also, you need to set the Promote flag on the 
group so that the RFF fields are placed on the same frame as the BGM fields. After you 
generate the form later in this tutorial, the RFF fields are displayed on the same frame as 
the BGM fields.

Procedure Use this procedure to change the maximum use of the RFF group and promote the RFF 
group to the parent frame.

Step Action

1 Click the RFF group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1.

4 Select the Print tab. 
(Continued on next page)
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5 Select the Promote group to parent frame check box to display the 
fields in the RFF group on the same frame as the fields in the parent 
group.

Note
If you change the maximum use of this group, but do not select the 
Promote group to parent frame check box, the fields in this group will not 
be displayed on the same frame in the Layout Window as the fields in the 
parent group.

6 Click OK to promote the group and to exit the Group Properties dialog.

 (Contd)
Step Action
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Modifying the PAT Group

Overview The standard allows the PAT group to be used up to 10 times in one purchase order. You 
expect the PAT group only once from your trading partner so you must change the 
maximum number of times the PAT group can be used to one. Also, you need to set the 
Promote flag on the group so that the PAT fields are placed on the same frame as the BGM 
fields. When you generate the form later in this tutorial, the PAT fields will be displayed 
on the same frame as the BGM fields.

Procedure Use this procedure to change the maximum use of the PAT group and promote the PAT 
group to the parent frame.

Step Action

1 Click the PAT group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1.

4 Select the Print tab. 

5 Select the Promote group to parent frame check box to display the fields 
in the PAT group on the same frame as the fields in the parent group.

6 Click OK to promote the group and exit the Group Properties dialog.
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Modifying the LIN Group

Overview This section describes how to:

◗ change the maximum use of the PIA segment
◗ change the maximum use of the IMD:2 segment
◗ change the minimum and maximum use of the MEA:3 segment
◗ change the minimum and maximum use of the QTY:3 segment
◗ promote the DTM:13 segment
◗ make the DTM:27 segment conditional
◗ change the maximum use of the DTM:13 segment
◗ change the maximum use of the MOA:5 segment

How to change the
maximum use of
the PIA segment

The PIA segment in the LIN group contains Line Item details used in the EDI data. The 
standard allows the PIA segment to be used up to 25 times for each line item. In this 
tutorial, you expect the PIA segment only once per line item from your trading partner so 
you will change the maximum number of times this segment can be used for each line 
item to one.

Use this procedure to change the PIA segment’s maximum use.

Step Action

1 Click the PIA segment with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

(Continued on next page)
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How to change the
maximum use of

the IMD:2 segment

The IMD:2 segment (in the LIN group) contains Item Description details used in the EDI 
data. The standard allows the IMD:2 segment to be used up to 10 times for each line item. 
You expect the IMD:2 segment only once per line item from your trading partner so you 
must change the maximum number of times this segment can be used for each line item to 
one.

Use this procedure to change the maximum use of the IMD:2 segment.

How to change the
minimum and

maximum use of
the MEA:3

segment

The MEA:3 segment in the LIN group contains Measurements details used in the EDI 
data. The standard allows the MEA:3 segment to be used up to five times for each line 
item. In this tutorial, you expect the MEA:3 segment only once per line item from your 
trading partner so you will change the maximum number of times this segment can be 
used for each line item to one. The standard also allows this segment to be conditional. 
You and your trading partner agree that the measurements contained in the MEA:3 
segment are important to the purchase order, so you will change the minimum use of this 
segment to one to make it mandatory.

Use this procedure to change the minimum use and maximum use of the MEA:3 segment.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

 Action

Step Action

1 Click the IMD:2 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

Step Action

1 Click the MEA:3 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

(Continued on next page)
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How to change the
minimum and

maximum use of
the QTY:3 segment

The QTY:3 segment (in the LIN group) contains Quantity details used in the EDI data. 
The standard allows the QTY:3 segment to be used up to 10 times for each line item. In 
this tutorial, you expect the QTY:3 segment only once per line item from your trading 
partner so you will change the maximum number of times this segment can be used for 
each line item to one. You and your trading partner agree that the quantities contained in 
the QTY:3 segment are important to the purchase order so you will change the minimum 
use of this segment to one.

Use this procedure to change the minimum use and maximum use of the QTY:3 segment.

How to promote
the DTM:13

segment

If the form were generated now, the date in the DTM:13 segment in the LIN group for the 
line item information would be printed on a separate frame than the rest of the line item 
fields. You want the date to be placed on the same frame as the rest of the line item 
information so you will promote the DTM:13 segment. Your trading partner sends you 
two sets of dates: the required shipment date and the last delivery date (in that order). The 
DTM:13 segment must occur twice in the form to accommodate both sets of dates from 
your trading partner in the particular order in which you expect them. To customize the 
DTM:13 segment while preserving the integrity of the EDI structure, you need to promote 
the DTM:13 segment, then change the maximum use of the original DTM:13 segment to 
one so that it is no longer a repeating segment.

(Continued on next page)

2 Select the Looping tab. 

3 In the Min Usage box, enter 1.

4 In the Max Usage box, enter 1.

5 Click OK to exit the Segment Properties dialog.

 Action

Step Action

1 Click the QTY:3 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Min Usage box, enter 1.

4 In the Max Usage box, enter 1.

5 Click OK to exit the Segment Properties dialog.
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Use this procedure to promote the DTM:13 segment.

How to make the
DTM:27 segment

conditional

Use this procedure to make the DTM:27 segment conditional.

Note
When you promote a segment, the new segment is defined as mandatory (with a minimum 
use of one). If you want to make the segment conditional, you must change the minimum 
use to zero.

How to change the
maximum use of

the DTM:13
segment

Use this procedure to change the DTM:13 segment’s maximum use.

Step Action

1 Click the DTM:13 segment with the right mouse button. 

2 Select Promote from the shortcut menu. 

3 Click Yes at the prompt to extract one iteration of the DTM:13 segment 
and place it directly above the DTM:13 segment that you selected to 
promote. 

System Response
The new iteration of the DTM:13 segment is named DTM:27.

Step Action

1 Click the DTM:27 segment with the right mouse button and select 
Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Min Usage box, enter 0 to make this segment conditional.

4 Click OK to exit the Segment Properties dialog.

Step Action

1 Click the DTM:13 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1. 

4 Click OK to exit the Segment Properties dialog.
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How to change the
maximum use of

the MOA:5
segment

The MOA:5 segment (in the LIN group) contains Monetary Amount details used in the 
EDI data. The standard allows the MOA:5 segment to be used up to five times for each 
line item. You expect the MOA:5 segment only once per line item from your trading 
partner so you need to change the maximum number of times this segment can be used for 
each line item to one.

Use this procedure to change the maximum use of the MOA:5 segment.

How to create a
CNT group

The CNT segment contains Control Total summary information for the purchase order. 
The standard allows the CNT segment to be used up to 10 times in a purchase order. You 
want to use CNT segment once per purchase order so you need to change the minimum 
and maximum use of the CNT segment to one. If the form were generated after changing 
the minimum and maximum use of the CNT segment, the total number of line items would 
be printed with the BGM fields at the beginning of the purchase order because the fields in 
the CNT segment would be displayed on the same frame as the fields in the BGM 
segment. 

For the CNT segment to print the total number of line items at the end of the purchase 
order and maintain the integrity of the purchase order, you must create a CNT group with 
a minimum use and a maximum use of one, then cut the CNT segment and paste it as a 
subordinate to the group you just created. After you move the CNT segment to the new 
CNT group that you create, the total number of line items is displayed on its own frame.

Use this procedure to create a CNT group.

Step Action

1 Click the MOA:5 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

Step Action

1 Select the CNT segment.

2 Select Insert from the Edit menu.
(Continued on next page)
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How to cut and
paste the CNT

segment

Use this procedure to cut and paste the CNT segment.

3 Select Group from the submenu. 

System Response
The Group Properties dialog is displayed.

4 In the Name box, enter CNT_Group as the loop identification code.

Important
Do not use spaces or hyphens ( - ) in the Name box. You can use the 
underscore ( _ ) to separate words.

5 In the Description box, enter CNT Group to provide a brief explanation 
of the loop.

6 Select the Looping tab. 

7 In the Min Usage box, enter 1 to make this group mandatory. 

8 Click OK to create the group. 

 (Contd)
Step Action

Step Action

1 Select the CNT segment.

2 Click the Cut icon on the Main Toolbar.
(Continued on next page)
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How to change the
maximum use of

the CNT segment

Use this procedure to change the maximum use of the CNT segment to one.

3 Click Yes at the prompt. 

4 Select the CNT group, which is the group to which you want to paste the 
CNT segment as a subordinate.

5 Click the Paste button on the Main Toolbar to paste the CNT segment. 

6 At the prompt, accept the default to paste the Clipboard contents as a child 
(subordinate) of the group and click OK to exit the dialog.

 Action

Step Action

1 Click the CNT segment with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab. 

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.
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Generating the Form

Overview Generating a form is different from compiling a form. When you generate a form, the 
fields of the form are displayed on a frame in the Layout Window (right side of Forms 
main window) based on the groups, segments, and elements that are activated. When you 
compile a form, the source form is translated into a compiled translation object.

Note
You should regenerate (or refresh) the form several times to ensure that you are viewing 
the most recent changes to the Layout Window.

Procedure Use this procedure to generate the print form based on the groups, segments, and elements 
you activated.

Step Action

1 Select the ORDERS file icon. Selecting the ORDERS file icon before you 
generate the layout enables you to view the beginning of the purchase 
order layout in the Layout Window after the layout is generated. This is 
not a required prerequisite to generating the layout.

2 Click the Generate Layout icon on the Main Toolbar. 

System Response
The layout of the print form is displayed in the Layout Window.
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After generating
the form

After you generate the form, the right side of your screen (Layout Window) will have one 
field for every activated element on the left side of your screen (EDI File Format 
Window). You can click either the field or its corresponding element to select it. To access 
the Field Properties dialog for a field/element, either double-click the element, or use the 
right mouse button to click the field or element, then select Properties from the shortcut 
menu.

Note
When you first generate the form, each field in the Layout Window is labeled with the 
same name as its corresponding element in the EDI File Format Window. As you 
customize the form, you change and remove some of the labels so not all of the fields are 
labeled the same as their corresponding elements. Though you change or remove some 
field labels, each field still corresponds to one element.

When the print form is generated, each group and repeating segment has a corresponding 
frame in the Layout Window that contains all the groups, segments, and elements at that 
level. Fields in segments that have a maximum use of only one are displayed on the frame 
corresponding to the group to which the segments are subordinate.

In print forms, the frames are not titled in the Layout Window. To identify the frame that 
currently is displayed, click one of the fields on the frame, then check the EDI File Format 
Window to determine in which segment or group the field is contained.
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Customize the EDI Data 0

Overview

Introduction You can customize the form, including the properties of each group, segment, and 
element.

Customizing the form is an iterative process. This tutorial guides you through all the steps 
involved in customizing the form, component by component. When you create print 
forms, you usually activate the form components you need to use, compile the form, test 
it, and print the EDI data using the compiled translation object. As you substantially 
customize the form, you usually compile and print the form several times to view your 
changes.

This section explains how to customize the form components for each sequential 
component.

How to set up the
document name

We recommend that you set up a Document Name for each form. The document name 
makes the identification of a message created by the form easier in Gentran:Server. Setting 
up the document name enables you to differentiate between messages in the document 
browsers. We strongly recommend that you select an element that occurs only once in the 
message and has a data type of string. For an EDIFACT 92.1 purchase order, the document 
name usually is the Document/Message Number.

(Continued on next page)
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Use this procedure to set up the document name.

Step Action

1 Double-click the BGM05 element. 

Recommendation
We recommend that you select this element because it is a non-recurring, 
mandatory element.

System Response
The Element Properties dialog is displayed. 

2 Select the Standard Rule tab. 

3 Select Update from the Please select a standard rule to use list. 

4 Click Yes at the prompt. 

5 From the Select the table (or group) to update list, select Document 
record to indicate that you are updating the document record.

(Continued on next page)
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6 From the Column (or field) to update list, select Document Name to 
indicate that you are updating the Name field in the document browsers 
with the contents of the BGM05 element.

System Response
The dialog now should look like this:

7 Click OK to set up the document name.

 (Contd)
Step Action
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Customizing the BGM Segment

Overview The BGM segment is the Beginning of Message segment for the purchase order. This 
segment contains information that is pertinent to the entire purchase order.

How to customize
the BGM05

element

The BGM05 element (Document/Message Number) is defined by the standard to be a 
string of thirty-five alphanumeric characters. You know that your trading partner’s 
purchase order number will be a 10-character string, so you will change the element and 
field lengths to accommodate the shorter purchase order number. In addition, you will 
rename the field label.

Use this procedure to change the field and element lengths and rename the field label for 
the Document/Message Number field.Customizing the BGM06 Element

Step Action

1 Double-click the BGM05 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Max box, enter 10 for the maximum number of characters allowed 
for this element.

(Continued on next page)
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Customizing the
BGM06 element

The BGM06 element (Message Function, Coded) contains the code from your partner’s 
EDI data representing the type of purchase order (e.g., new order) for this message. You 
want the meaningful description of the code to be printed on the printout instead of the 
code itself. You need to prevent the Message Function, Coded field from being displayed 
(hide it), but use the code from that element (BGM06) to look up the code description in 
the Message Function, Coded code list table. You then need to print that description in 
another field that you create. The description of the code is displayed in the new field on 
the printout.

Your trading partner has agreed to only send you two types of purchase orders: 

◗ Request (Message Function Code 13)
◗ Change (Message Function Code 4)

4 Select the Print tab.

System Response
The system displays the Print dialog box. 

5 In the Label box, enter Order Number: to replace the existing text.

6 In the Maximum number of characters to be printed box, enter 10 to 
display a 10-character purchase order number on the printout.

7 Click OK to exit the dialog.

 (Contd)
Step Action
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How to copy the
BGM06 element

The description of the EDI code in the BGM06 element is important, though you do not 
need to print the code itself. For example, the EDI code value 13 is not descriptive enough 
for users reading a printout of the purchase order. The description of code 13 (Request) is 
meaningful.

Before you can print the description of the EDI code value, you must create a new element 
in the BGM segment to store and print the description. The new BGM element is the 
element that displays the description of the Message Function, Coded. You use the Copy 
and Paste functions to move EDI information in the form. Copied form components retain 
all the information of the original form components.

Use this procedure to copy and paste the BGM06 element.

How to change the
BGM08 element

and field
properties

The system names the new element created from copying the BGM06 element 1225:2. 
You need to rename the new element to identify its purpose, which is to print the 
description of the code from the BGM06 element. 

Note
If a segment or element occurs more than once in a form, it is identified by its name <ID>. 
The second and subsequent occurrences are identified by <ID>:n, where n is the number 
of the occurrence in the form.

You will increase the element and field lengths of the BGM08 element to accommodate 
the longer description. Also, you will rename the field label for the newly created BGM08 
element to reflect the contents of the field (the description of the Message Function, 
Coded).

Use this procedure to change the element name and length, and change the field label and 
field length for the Message Function, Coded field.

Step Action

1 Select the BGM06 element.

2 Click the Copy button on the Main Toolbar.

3 Select the BGM07 element, which is the last element in the BGM 
segment. The BGM07 element is the element after which you want the 
BGM06 element to be pasted.

4 Click the Paste button on the Main Toolbar to paste the BGM06 element. 
A new element (BGM08) is created. The BGM08 element is an exact 
copy of the BGM06 element.

Step Action

1 Double-click the BGM08 element. 

System Response
The Element Properties dialog is displayed. 

(Continued on next page)
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How to hide the
BGM06 field and

load a code list
table from the

standard

Now that you have created an exact copy of the BGM06 element, you can hide the first 
Message Function, Coded field.

When you use code list tables, you load a code list table from the standard to tell the 
system which code list table to use in looking up EDI code values. You can load the 
specific code values you expect to receive in the EDI data, or you can load the entire code 
list table. For this tutorial, you know that your trading partner will send you only these two 
types of purchase orders:

◗ Request (Message Function Code 13)
◗ Change (Message Function Code 4)

You do not need to load the entire code list table, so you will load only codes 13 and 4 
from the code list table.

Use this procedure to hide the Message Function, Coded field and load the code list table 
from the standard.

2 In the Name box, enter 1225_DESC. 

3 Select the Validation tab. 

4 In the Minimum box, enter 0 for the minimum number of characters 
allowed for this element. 

5 In the Maximum box, enter 30 for the maximum number of characters 
allowed for this element.

6 Click the Print tab. 

7 In the Label box, enter Order Type:.

8 In the Maximum number of characters to print box, enter 30.

9 Click OK to save the new label and to exit the dialog. 

 Action

Step Action

1 Double-click the BGM06 element, which is the element for which you 
need to use a code list table. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include this field in the print check box to turn the option off. 
The Message Function, Coded field will not be displayed on the printout.

(Continued on next page)
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4 Select the Standard Rule tab.

5 Select Use Code from the Please select a standard rule to use list.

6 Click Yes at the prompt. 

7 Click Edit to access the Edit Code List dialog. 

System Response
The Edit Code List dialog is displayed.

The Table ID box contains 1225, the name of the element for which this 
code list table is used. The Desc box contains MESSAGE FUNCTION, 
CODED, the description of the element for which this code list table is 
used.

8 Click Load to access the Load Code List dialog. You are prompted to 
select an ODBC data source name. Select the appropriate DSN and click 
OK to access the Load Code List dialog. The Codes In Standard list 
contains the entire code list.

(Continued on next page)

 (Contd)
Step Action
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9 From the Codes In Standard list, highlight code 13.

10 Click Add to move it to the Codes Selected list.

11 From the Codes In Standard list, highlight code 4.

12 Click Add to move it to the Codes Selected list.

13 Click OK to load the code list table and exit the Load Code List dialog.

14 Click Close to exit the Edit Code List dialog.

15 From the Store Field list, select 1225_DESC MESSAGE FUNCTION, 
CODED to store the description in the BGM08 element you created.

The dialog should now should look like this: 

16 Click OK to exit the dialog.
(Continued on next page)

 (Contd)
Step Action
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17 Click the Generate Layout button on the Main Toolbar to refresh the 
display of the print form.

System Response
The header frame now should look like this:

 (Contd)
Step Action
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Customizing the DTM Segment

Overview The DTM segment (Date/Time/Period) is used to print the order date for the purchase 
order. The standard allows the DTM segment to be used up to 35 times in one purchase 
order. In this tutorial, you will use the DTM segment only once. You have already changed 
the maximum use of the DTM segment to obtain just one instance of the DTM segment 
and to place the order date on the same frame as the order number.

How to customize
the DTM01

element

The DTM01 element (Date/Time/Period Qualifier) is a mandatory element for the 
EDIFACT 92.1 purchase order (ORDERS). You do not need to print the qualifier on the 
printout so you will hide the Date/Time/Period Qualifier field.

Use this procedure to hide the Date/Time/Period Qualifier field.

How to customize
the DTM02

element

The DTM02 element (Date/Time/Period) contains the purchase order date. The standard 
allows this field to contain up to a 35-character string, but your trading partner sends you 
shorter dates. You need to change the element and field lengths to accommodate the 
shorter dates, and then rename the field label.

Use this procedure to change the element and field lengths and rename the field label for 
the Date/Time/Period field.

Step Action

1 Double-click the DTM01 element. 

System Response
The Element Properties dialog is displayed.

2 Click the Print tab. 

3 Clear the Include this field in the print check box to turn the option off. 

4 Click OK to exit the dialog.

Step Action

1 Double-click the DTM02 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 8 to allow the entire date, including separators 
(/), to be contained in this element.

(Continued on next page)
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Print Form Customizing the DTM Segment 2 - 59
4 Select the Print tab. 

5 In the Label box, enter Order Date: to replace the existing field label.

6 In the Maximum number of characters to be printed box, enter 8.

7 Click OK to exit the dialog.

8 Click the Generate Layout button on the Main Toolbar to refresh the 
print form display.

System Response
The header frame now should look like this: 

 (Contd)
Step Action
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Customizing the FTX Segment

Overview Your trading partner sends you messages or notes, so the FTX segment must be present to 
receive them. The standard allows the FTX segment to be used up to five times in one 
purchase order. In this tutorial, you will use the FTX segment only once. You have already 
changed the maximum use of the FTX segment to obtain just one instance of the FTX 
segment and to place the note or message on the same frame as the purchase order number 
and date.

How to customize
the FTX01 element

The FTX01 element (Text Subject Qualifier) is a mandatory element for the FTX segment. 
The FTX01 element contains the three-character qualifier from your partner’s EDI data to 
indicate what type of free text follows (in this tutorial, AAI for General Information). The 
system does not enable you to deactivate this element, because it is a mandatory element. 
Because you expect only one qualifier (General Information) in this element, you do not 
need to print the qualifier on the report. You will hide the Text Subject Qualifier field.

Use this procedure to hide the Text Subject Qualifier field.

How to customize
the FTX06 element

The FTX06 element (Free Text) is mandatory when the FTX segment is used. The EDI 
data in the FTX06 element contains the exact message that should be printed. The 
message is self-explanatory so you do not need to print the label for this field. You need to 
remove the field label from the form. You also know that your partner sends free text in 60 
characters or fewer (70 is the maximum length allowed by the standard for this field) so 
you need to change the element and field lengths for the Free Text field.

Use this procedure to remove the field label and change the element and field lengths for 
the Free Text field.

Step Action

1 Double-click the FTX01 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include this field in the print check box.

4 Click OK to exit the dialog.

Step Action

1 Double-click the FTX06 element. 

System Response
The Element Properties dialog is displayed. 

(Continued on next page)
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2 Select the Validation tab.

3 In the Maximum box, enter 60 to allow a 60-character string in this 
element.

4 Select the Print tab. 

5 In the Label box, delete the existing field label.

6 In the Maximum number of characters to be printed box, enter 60.

7 Click OK to exit the dialog.

8 Click Generate Layout on the Main Toolbar to refresh the print form 
display. 

System Response
The header frame now should look like this: 

 (Contd)
Step Action
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Customizing the RFF Group

Overview The RFF segment is a conditional group that specifies the Reference information for the 
purchase order. The standard allows this group to be used up to 10 times in one purchase 
order. You need to use this group only once in the header of the purchase order (for the 
contract number) so you have already changed the maximum use of this group to one. At 
the same time, you promoted this group to the parent frame so that the contract number is 
displayed on the same frame as the purchase order number and date. 

Customizing the
RFF segment

The RFF segment (Reference) contains reference information used in the EDI data. In this 
tutorial, you know that the only reference number your partner will send you in the RFF 
segment is a contract number that your trading partner uses for their records.

How to customize
the RFF01 element

The RFF01 element (Reference Qualifier) is a mandatory element for the RFF segment. 
The RFF01 element contains the three-character code from your partner’s EDI data to 
indicate what type of reference follows. For this tutorial, you know that your trading 
partner sends you only one type of reference—the contract number. The system does not 
enable you to deactivate this element, because it is a mandatory element. Since you expect 
only one qualifier in this element, you do not need to print the qualifier on the report. You 
will hide the Reference Qualifier field.

Use this procedure to hide the Reference Qualifier field.

Step Action

1 Double-click the RFF01 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include this field in the print check box.

4 Click OK to exit the dialog.
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How to customize
the RFF02 element

The RFF02 element contains the Reference Number. This element is defined by the 
standard to be a string of 35 alphanumeric characters. In this tutorial, you know that your 
trading partner’s reference number (the contract number) is a 12-character string so you 
need to change the field and element lengths to accommodate the reference number that is 
shorter than the standard expects. In addition, you need to rename the field label.

Use this procedure to change the element and field lengths and to rename the field label 
for the Reference Number field.

Step Action

1 Double-click the RFF02 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 12 to allow a 12-character string in this 
element.

4 Select the Print tab. 

5 In the Label box, enter Contract No. (note the period in the label) to 
replace the existing field label.

6 In the Maximum number of characters to be printed box, enter 12.

7 Click OK to exit the dialog.
(Continued on next page)
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8 Click Generate Layout on the Main Toolbar.

System Response
The header frame now should look like this: 

 (Contd)
Step Action
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Customizing the NAD Group

Overview The standard allows the NAD group (Name and Address) to be used up to 20 times. In the 
NAD group, you have already activated the NAD segment to contain the name and 
address of an entity or individual. Your trading partner uses the NAD group to send you 
these three types of addresses:

◗ Party to be billed (Party Qualifier AA)
◗ Buyer (Party Qualifier BY)
◗ Ship to (Party Qualifier ST)

Customizing the
NAD segment

The NAD segment identifies the Name and Address of an entity or individual. The 
NAD01 element is a mandatory element in the NAD segment and contains the three-
character qualifier identifying the type of party in the NAD segment. 

Customizing the
NAD01 element

The NAD01 element (Party Qualifier) identifies the type of party in the NAD segment. 
For this tutorial, you know that your trading partner sends only these three types of names/
addresses: Party to be billed, Buyer, and Ship to. You want the meaningful description of 
the qualifier on the printout instead of the qualifier itself.

To print the description of the EDI code value, you must copy the NAD01 element to 
another element in the NAD segment, then use the new NAD element to print the 
description of the Party Qualifier code.

How to copy the
NAD01 element

Use this procedure to copy and paste the NAD01 element.

Step Action

1 Select the NAD01 element.

2 Click Copy on the Main Toolbar.

3 Select the NAD22 element, which is the last element in the NAD segment.

4 Click Paste on the Main Toolbar to paste the new element.
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How to change the
NAD23 element

and field
properties

The system names the new element created from copying the NAD01 element 3035:3. 
You need to rename the new element to identify its purpose, which is to print the 
description of the qualifier from the NAD01 element. You need to remove the Mandatory 
status from the NAD23 element to make it a conditional element (meaning that the 
element will be used only if there is EDI data available for it) and increase the element and 
field lengths to accommodate the qualifier’s description.

Use this procedure to change the element name and length, make the element conditional 
instead of mandatory, and change the field label and field length for the Party Qualifier 
field.

Step Action

1 Double-click the NAD23 element. 

System Response
The Element Properties dialog is displayed. 

2 In the Name box, enter 3035_DESC.

3 Select the Validation tab. 

4 Clear the Mandatory check box to make the element conditional. 

Note
You will not receive an NAD23 element from your trading partner. If you 
leave the mandatory status checked, you will receive a compliance error.

5 In the Min box, enter 0 for the minimum number of characters allowed for 
this element.

6 In the Max box, enter 18 for the maximum number of characters allowed 
for this element.

7 Select the Print tab. 

8 In the Label box, delete the existing field label. 

9 In the Maximum number of characters to be printed box, enter 18.

10 Click OK to exit the dialog.
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How to hide the
NAD01 field and
loading the code

list table from the
standard

Now that you have created an exact copy of the NAD01 element, you can hide the first 
Party Qualifier field.

For this tutorial, you know that your trading partner will send you the following types of 
names and addresses:

◗ Party to be billed (Party Qualifier AA)
◗ Buyer (Party Qualifier BY)
◗ Ship to (Party Qualifier ST)

You do not need to load the entire code list table; you will load only codes AA, BY, and 
ST from the code list table.

Use this procedure to hide the first Party Qualifier field and load the codes from the 
standard.

Step Action

1 Double-click the NAD01 element, which is the element for which you 
need to use a code list table. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include fields in the print check box.

4 Select the Standard Rule tab. 

5 Select Use Code from the list.

6 Click Yes at the prompt. 
(Continued on next page)
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7 Click Edit to access the Edit Code List dialog. 

Note
The Table ID box contains 3035, the name of the element for which this 
code list table will be used. The Desc box contains PARTY QUALIFIER, 
the description of the element for which this code list table will be used.

8 Click Load to access the Load Code List dialog. You are prompted to 
select an ODBC data source name. Select the appropriate DSN and click 
OK to access the Load Code List dialog. The Codes In Standard list 
contains the entire code list. 

9 From the Codes In Standard list, highlight code AA.

10 Click Add to move it to the Codes Selected list.

11 From the Codes In Standard list, highlight code BY.

12 Click Add to move it to the Codes Selected list.
(Continued on next page)
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13 From the Codes In Standard list, highlight code ST.

Note
This code list table contains many codes. To access code ST quickly, press 
the letter s; the first code that begins with the letter s is highlighted. You 
need to scroll through only the list of codes beginning with s, instead of 
the entire code list, to access code ST.

14 Click Add to move it to the Codes Selected list.

15 Click OK to load the code list table and exit the Load Code List dialog.

16 Click Close to exit the Edit Code List dialog.

17 From the Store Field list, select 3035_DESC PARTY QUALIFIER to 
store the description in the NAD23 element you created.

System Response
The dialog should now should look like this: 

18 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the NAD10

element

The NAD10 element (Party Name) contains the exact name that should be printed in the 
purchase order. The name is explained by the description of the Party Qualifier so you do 
not need to print the label associated with the name. The only customizing that is 
necessary for the NAD10 element is to remove the field label on the printout.

Use this procedure to hide the Party Name field label.

How to customize
the NAD16

element

The NAD16 element contains the Street and Number/P.O. Box, which identifies the street 
name and number, suite number, or any other address information that your trading partner 
sends you. The NAD16 element contains the exact address information that should be 
printed. The address information corresponds to the name that is printed from the NAD10 
element. There is no need to print the label associated with the address so you need to 
remove the field label for the NAD16 element.

Use this procedure to hide the field label for the first Street and Number/P.O. Box field.

Step Action

1 Double-click the NAD10 element. 

System Response 
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 In the Label box, delete the existing text. The party name is explained by 
the description in the Party Qualifier field (NAD23).

4 Click OK to exit the dialog.

Step Action

1 Double-click the NAD16 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 In the Label box, delete the existing text.

4 Click OK to exit the dialog.
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How to customize
the NAD17

element

The NAD17 element contains the second Street and Number/P.O. Box line, which (like 
the NAD16 element) identifies the street name and number, suite number, or any other 
address information that your trading partner sends you. The NAD17 element contains the 
exact address information that should be printed. The address information corresponds to 
the name that is printed from the NAD10 element. There is no need to print the label 
associated with the address, so you need to remove the field label for the NAD17 element.

Use this procedure to remove the field label for the second Street and Number/P.O. Box 
field.

How to customize
the NAD19

element

The NAD19 element contains the City Name. There is no need to print the field label 
associated with this element, because it will be evident on the printout that all the name 
and address information are associated. Therefore, you will remove the field label for the 
NAD19 element. Also, you must change the element and field lengths because you do not 
need the City Name field to be longer than 30 characters.

Use this procedure to change the element and field lengths and remove the City Name 
field label.

Step Action

1 Double-click the NAD17 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label box, delete the existing text.

4 Click OK to exit the dialog.

Step Action

1 Double-click the NAD19 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 30 to allow a 30-character string in this 
element.

4 Select the Print tab. 

5 In the Label box, delete the existing text. 

6 In the Maximum number of characters to be printed box, enter 30 to 
display a 30-character city name on the printout.

7 Click OK to exit the dialog.
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How to customize
the NAD20

element

The NAD20 element contains the Country Sub-Entity Identification. You do not need to 
print the field label associated with this element, because it is evident on the printout that 
all the name and address information are associated. You must remove the field label for 
the NAD20 element and change the element and field lengths because your partner sends 
a Country Sub-Entity Identification that is abbreviated to no more than two characters.

Use this procedure to change the element and field lengths and remove the Country Sub-
Entity Identification field label.

How to customize
the NAD21

element

The NAD21 element contains the Postcode Identification. You do not need to print the 
field label associated with this element, because it is evident on the printout that all the 
name and address information are associated. You need to remove the field label for the 
NAD21 element.

Use this procedure to remove the Postcode Identification field label.

Step Action

1 Double-click the NAD20 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 2 to allow a two-character string in this 
element.

4 Select the Print tab. 

5 In the Label box, delete the existing text.

6 In the Maximum number of characters to be printed box, enter 2.

7 Click OK to exit the dialog.

Step Action

1 Double-click the NAD21 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 In the Label box, delete the existing text.

4 Click OK to exit the dialog.
(Continued on next page)
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5 Click Generate Layout on the Main Toolbar to refresh the print form 
display. 

System Response
The Name and Address (NAD) frame now should look like this:

 Action
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Customizing the PAT Group

Overview The PAT group is a conditional group that specifies the Payment Terms for the purchase 
order. The standard allows this group to be used up to 10 times in one purchase order. You 
need to use this group only once in the header of the purchase order so you changed the 
maximum use of this group to one. At the same time, you promoted this group to the 
parent frame so that the payment terms are displayed on the same frame as the purchase 
order number and date (the header frame). 

Customizing the
PAT segment

The PAT segment is a conditional segment in the PAT group that specifies the Payment 
Terms Basis for the purchase order.You have already activated the PAT05 element for the 
Terms of Payment. The mandatory elements PAT01 (Payment Terms Type Qualifier) and 
PAT02 (Terms of Payment Identification) also are activated.

Customizing the
PAT01 element

The PAT01 element is a mandatory element that contains the Payment Terms Type 
Qualifier, a three-character code that identifies the terms under which this purchase order 
is valid. You need to hide the PAT01 element and print the more meaningful description of 
the code in a new element that you create.

You know that your trading partner only sends you purchase orders with these terms:

◗ Previously Agreed Upon (Payment Terms Type Qualifier 18)
◗ Instant (Payment Terms Type Qualifier 10)

To print the description of an EDI code value, you must copy the PAT01 element to a new 
element in the PAT segment, then use the new PAT element to print the description of the 
Payment Terms Type Qualifier.

How to copy the
PAT01 element

Use this procedure to copy and paste the PAT01 element.

Step Action

1 Select the PAT01 element.

2 Click Copy on the Main Toolbar.

3 Select the PAT06 element, which is the last element in the C110 
composite in the PAT segment.

4 Click Paste on the Main Toolbar to paste the new element. A new element 
(PAT07) is created, which is an exact copy of the PAT01 element.
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How to change the
PAT07 element

and field
properties

The system names the new element created from copying the PAT07 element 4279:2. You 
need to rename the new element to identify its purpose, which is to print the description of 
the code from the PAT01 element. Also, you need to increase the element and field lengths 
to accommodate the longer description.

Use this procedure to change the element name and length and to change the field label 
and length for the Payment Terms Type Qualifier field.

How to hide the
PAT01 field and

load the code list
table from the

standard

Now that you have created an exact copy of the PAT01 element, you can hide the first 
Payment Terms Type Qualifier field.

You know that your trading partner only sends purchase orders with these two term types:

◗ Previously agreed upon (Payment Terms Type Qualifier 18)
◗ Instant (Payment Terms Type Qualifier 10)

You do not need to load the entire code list table so load only codes 18 and 10 from the 
code list table.

(Continued on next page)

Step Action

1 Double-click the PAT07 element. 

System Response
The Element Properties dialog is displayed. 

2 In the Name box, enter 4279_DESC to give the name a more descriptive 
identifier than its current name.

3 Select the Validation tab. 

4 Clear the Mandatory check box to make the element conditional.

5 In the Minimum box, enter 0.

6 In the Maximum box, enter 30.

7 Select the Print tab. 

8 In the Label box, delete the existing text.

9 In the Maximum number of characters to be printed box, enter 30.

10 Click OK to exit the dialog.
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Use this procedure to hide the first Terms Type Code field and load the codes from the 
standard.

Step Action

1 Double-click the PAT01 element, which is the element for which you 
need to use a code list table. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include this field in the print check box.

4 Select Standard Rule tab.

5 Select Use Code option.

6 Click Yes at the prompt. 

7 Click Edit to access the Edit Code List dialog. 

System Response
The Edit Code List dialog is displayed.

Note
The Table ID box contains 4279, the name of the element for which this 
code list table is used. The Desc box contains PAYMENT TERMS TYPE 
QUALIFIER, the description of the element for which this code list table 
is used.

(Continued on next page)
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8 Click Load to access the Load Code List dialog. 

System Response
You are prompted to select an ODBC data source name. Select the 
appropriate DSN and click OK to access the Load Code List dialog. The 
Codes In Standard list contains the entire code list. 

9 From the Codes In Standard list, highlight code 10.

10 Click Add to move it to the Codes Selected list.

11 From the Codes In Standard list, highlight code 18.

12 Click Add to move it to the Codes Selected list.

13 Click OK to load the code list table and exit the Load Code List dialog.

14 Click Close to exit the Edit Code List dialog.
(Continued on next page)

 (Contd)
Step Action
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How to customize
the PAT02 element

The PAT02 element (Terms of Payment Identification) is a mandatory element for the PAT 
segment. You do not need to print the identification on the printout so you will hide the 
Terms of Payment Identification field. 

Use this procedure to hide the Terms of Payment Identification field.

15 From the Store Field list, select 4279_DESC PAYMENT TERMS TYPE 
QUALIFIER to store the code in the PAT07 element you created. 

System Response
The dialog should now should look like this: 

16 Click OK to exit the dialog.

 (Contd)
Step Action

Step Action

1 Double-click the PAT02 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 Clear the Include fields in the print check box.

4 Click OK to exit the dialog.
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How to customize
the PAT05 element

The PAT05 element contains the exact terms of payment for the purchase order. The terms 
are explained by the description of the Payment Terms Type Qualifier so there is no need 
to print the label associated with the terms of payment. You need remove the field label for 
the PAT05 element on the printout.

Use this procedure to remove the Terms of Payment field label.

Step Action

1 Double-click the PAT05 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 In the Label box, delete the existing field label. 

4 Click OK to exit the dialog.

5 Click Generate Layout on the Main Toolbar to refresh the print form 
display. 

System Response
The header frame now should look like this: 
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Customizing the LIN Group

Overview The standard allows the LIN group to be used up to 200,000 times, containing up to 
200,000 line items in one purchase order. You have already activated these segments in the 
LIN group: LIN, PIA, IMD:2, MEA:3, QTY:3, DTM:13, and MOA:5. Also, you have 
already promoted the DTM:13 segment in the LIN group to create the DTM:27 segment.

Before and after
examples

These examples describe how your form looks before and after the customization process.

Example 1: Before Customization
Before you customize the segments and elements in the LIN group, the fields in the form 
are arranged with one field on a line, like the following: 

If the frame were not customized and formatted differently, each set of fields would be 
repeated for each item ordered. A more efficient and traditional way of listing items on a 
purchase order is to arrange the related information in columns so all the related 
information for one item is listed on one or two lines. The column headings are printed 
only once.

Example 2: After Customization
The following figure shows how you ultimately want the fields in the LIN group to be 
arranged (after customizing and then formatting the fields). 
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Customizing the
LIN segment

The LIN segment (in the LIN group) contains the Line Item details for the items on the 
purchase order. Information in the LIN segment pertains to each line item on the purchase 
order and not to the entire purchase order.

How to customize
the LIN01 element

The LIN01 element contains the Line Item Number for one item on the purchase order. 
You need to rename the field label to reflect the new label that you and your trading 
partner have agreed to use. You and your trading partner have agreed that the line items 
per purchase order will not exceed 99,999. Since each line item is numbered sequentially, 
starting with one, you need a maximum length of only five digits for this field. Therefore, 
you need to change the maximum length for this field.

Use this procedure to change the element and field lengths and rename the field label for 
the Line Item Number field.

Step Action

1 Double-click the LIN01 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 5.

4 Select the Print tab. 

5 In the Label box, enter Line to replace the existing field label. 

Note
The label for the Line Item Number field ultimately will form the column 
heading Line No. To make the width of the column heading as narrow as 
possible, you will place Line on one line and No. below. The Label field 
does not enable you to enter a label on more than one line, so you will 
enter Line in the Label box, then add No. by adding static text later in this 
tutorial. (Static text is text that is always printed or displayed when the 
form is used, and that is not defined in the field properties of the element.)

6 In the Maximum number of characters to be printed box, enter 5.

7 Click OK to exit the dialog.
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Customizing the
PIA segment

The PIA segment in the LIN group contains the Additional Product ID details for the 
items on the purchase order. Information in the PIA segment pertains to each line item on 
the purchase order and not to the entire purchase order. The standard allows the PIA 
segment to be used up to 25 times for each line item, but you need the PIA segment to be 
used only once for each line item. You have already changed the maximum use of the PIA 
segment to one.

How to customize
the PIA01 element

The PIA01 element is a mandatory element that contains the Product ID Function 
Qualifier for each item on the purchase order. For brevity on the printout, you will rename 
the field label.

Use this procedure to rename the field label for the Product ID Function Qualifier field.

How to customize
the PIA02 element

The PIA02 element contains the Item Number for one item on the purchase order. You 
need to rename the field label to more accurately identify this field for you and your 
trading partner. The standard allows up to a 35-character string in this field. Your trading 
partner uses product identification numbers that are no longer than 10 characters so you 
need to change the maximum length for this field to ten.

Use this procedure to change the element and field lengths and rename the field label for 
the Item Number field.

Step Action

1 Double-click the PIA01 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 In the Label box, enter Code to replace the existing field label. 

Note
The label for the Product ID Function Qualifier field ultimately will form 
the column heading Code Type. To make the width of the column heading 
as narrow as possible, you will place Code on one line and Type below. 
The Label field does not enable you to enter a label on more than one line, 
so you will enter Code in the Label box, then add Type by adding static 
text later in this tutorial.

4 Click OK to exit the dialog.

Step Action

1 Double-click the PIA02 element. 

System Response
The Element Properties dialog is displayed. 

(Continued on next page)
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Customizing the
IMD:2 segment

The IMD:2 segment (in the LIN group) contains the Item Description for the items on the 
purchase order. Information in the IMD:2 segment pertains to each line item on the 
purchase order and not to the entire purchase order. The standard allows the IMD:2 
segment to be used up to 10 times for each line item, but you need the IMD:2 segment to 
be used only once for each line item. You have already changed the maximum use of the 
IMD:2 segment to one.

How to customize
the IMD:206

element

The IMD:206 element contains the Item Description for the purchase order item. The 
description is self-explanatory so there is no need to print the field label associated with 
the description.

Use this procedure to remove the Item Description field label.

2 Select the Validation tab. 

3 In the Maximum box, enter 10 to allow a 10-character string for the 
product identification number in this element.

4 Select the Print tab. 

5 In the Label box, enter Prod ID to replace the existing field label.

6 In the Maximum number of characters to be printed box, enter 10.

7 Click OK to exit the dialog.

 Action

Step Action

1 Double-click the IMD:206 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 In the Label box, delete the existing field label.

4 Click OK to exit the dialog.
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Customizing the
MEA:3 segment

The MEA:3 segment (in the LIN group) contains the Measurements for the items on the 
purchase order. Information in the MEA:3 segment pertains to each line item on the 
purchase order and not to the entire purchase order. The standard allows the MEA:3 
segment to be used up to five times for each line item, but you need the MEA:3 segment to 
be used only once for each line item. You have already changed the maximum use of the 
MEA:3 segment to one.

How to customize
the MEA:301

element

The MEA:301 element is a mandatory element that contains the Measurement Application 
Qualifier for each item on the purchase order. This element must be present in the 
purchase order, but you do not need this qualifier to be printed.

Use this procedure to hide the Measurement Application Qualifier field.

How to customize
the MEA:305

element

The MEA:305 element is a mandatory element that contains the Measure Unit Qualifier 
for each item on the purchase order. This element must be present in the purchase order. 
You do not need this qualifier to be printed on the printout so you need to prevent this field 
from being displayed on the printout.

Use this procedure to hide the Measure Unit Qualifier field.

Step Action

1 Double-click the MEA:301 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include field in the print check box. 

4 Click OK to exit the dialog.

Step Action

1 Double-click the MEA:305 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include field in the print check box. 

4 Click OK to exit the Display Properties dialog.
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How to customize
the MEA:306

element

The MEA:306 element contains the Measurement Value for each item on the purchase 
order. For brevity, you will rename the field label. The standard allows up to an 18-digit 
number in this field. You expect a number no longer than two digits from your trading 
partner so you need to change the maximum length for this field accordingly. Also, the 
screen format and EDI format of the data currently use the number format R9, which 
indicates a number with an explicit decimal point and up to nine decimal places. You do 
not expect any decimal places from your partner’s data, so you need to change the screen 
format and EDI format to R0, which indicates a number with an explicit decimal point and 
no decimal places.

Use this procedure to rename the field label, change the screen and EDI formats, and 
change the element and field lengths for the Measurement Value field.

Step Action

1 Double-click the MEA:306 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 2 to allow a two-digit number in this element.

4 From the Format of the data in the form list, select R0 to allow a number 
with an explicit decimal point and no decimal places to be displayed on 
the printout.

5 Click Yes at the prompt.

6 From the Format of the data of the file list, select R0 to indicate that you 
expect a number with an explicit decimal point and no decimal places.

7 Click Yes at the prompt.

8 Select the Print tab. 

9 In the Label box, enter Unit to replace the existing field label.

10 In the Maximum number of characters to be printed box, enter 2.

11 Click OK to exit the dialog.
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Customizing the
QTY:3 segment

The QTY:3 segment in the LIN group contains the Quantity details for the items on the 
purchase order. Information in the QTY:3 segment pertains to each line item on the 
purchase order and not to the entire purchase order. The standard allows the QTY:3 
segment to be used up to 10 times for each line item but you need the QTY:3 segment to 
be used only once for each line item. You have already changed the maximum use of the 
QTY:3 segment to one.

How to customize
the QTY:301

element

The QTY:301 element is a mandatory element that contains the Quantity Qualifier for 
each item on the purchase order. This element must be present in the purchase order, but 
you do not need this qualifier to be printed so you need to prevent this field from being 
displayed on the printout.

Use this procedure to hide the Quantity Qualifier field.

How to customize
the QTY:302

element

The QTY:302 element contains the Quantity for one item on the purchase order. You need 
to abbreviate the field label on the printout. The standard allows up to a 15-digit number in 
this field. You know that your trading partner will order no more than 99,999 (a five-digit 
number) of any one item so you need to change the maximum length to six for this field 
(to accommodate a five-digit number and a place separator) and change the value in the 
Screen Format and EDI Format lists to N0, which indicates a number with an implied 
decimal point and no decimal places.

Use this procedure to change the element and field lengths, rename the field label, and 
change the screen and EDI formats for the Quantity field.

Step Action

1 Double-click the QTY:301 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include fields in the the print check box. 

4 Click OK to exit the dialog.

Step Action

1 Double-click the QTY:302 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 6 to allow a five-digit number with a place 
separator in this element.

(Continued on next page)
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Customizing the
DTM:27 segment

The DTM:27 segment (in the LIN group) is used to print the required shipment date. To 
ensure that Gentran:Server prints the correct date in the Date/Time/Period field, you must 
use the key field function. The key field function enables you to specify a second 
qualification in selecting a segment (the segment name is the first qualification). Data 
must be provided in the order designated through the use of key fields. For example, for 
this tutorial, you expect the required shipment date (DTM:27) first, and then the last 
delivery date (DTM:13).

Note
The dates printed in the DTM:27 and DTM:13 segments can be set up using key fields 
because you expect the dates in a particular order. If the dates were sent in a different 
order, only one date would be printed. If you were not sure of the order in which your 
partner will send the dates, you could not use key fields. You would need to use three 
DTM segments (using the promote function), and two of those DTM segments would 
need to be identical.

When the Date/Time/Period Qualifier field contains the value 10 (required shipment date), 
the date is printed in the Date/Time/Period field of the DTM:27 segment. If the Date/
Time/Period Qualifier field contains the value 128 (last delivery date), then the date is 
printed in the Date/Time/Period field of the DTM:13 segment.

4 From the Format of the data in the form list, select N0 to allow a number 
with an implicit decimal point and no decimal places to be displayed on 
the printout.

5 From the Format of the data of the file list, select N0 to indicate that you 
expect a number with an implicit decimal point and no decimal places.

6 Select the Print tab. 

7 In the Label box, enter Qty.

8 In the Maximum number of characters to be printed box, enter 6.

9 Click OK to exit the dialog.

 Action
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How to use a key
field for the

DTM:27 segment

Use this procedure to use a key field for the DTM:27 segment.

Step Action

1 Click the DTM:27 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed. 

2 Select the Key Field tab. 

3 From the Field list, select 2005:3 DATE/TIME/PERIOD QUALIFIER.

4 Click Edit to access the Map Constants dialog. 

System Response
The Map Constants dialog is displayed. 

5 Click New to display the Edit Constant dialog. 

System Response
The Edit Constant dialog is displayed. 

(Continued on next page)
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How to customize
the DTM:2701

element

The DTM:2701 element (in the DTM:27 segment) contains the Date/Time/Period 
Qualifier for the date in the DTM:2702 element. Your trading partner sends two types of 
dates: the required shipment date and the last delivery date (in that order). You used the 
key field function for the DTM:27 segment to indicate to Gentran:Server that only the 
required shipment date are printed in the Date/Time/Period field (DTM:2702) so you can 
prevent the qualifier (DTM:2701) from being printed. The last delivery date is printed in 
the Date/Time/Period field for the DTM:13 segment.

Use this procedure to hide the Date/Time/Period Qualifier field.

6 In the ID box, enter Shipment date/time, req to identify the unique literal 
constant.

7 From the Type list, select String.

8 In the Value box, enter 10 to identify the actual value of the constant.

9 Click OK to exit the Edit Constant dialog.

10 Click Close to exit the Map Constants dialog.

11 From the Use constant list, select 10 to indicate to the system that this date 
is the required shipment date.

12 Click OK to exit the dialog.

 (Contd)
Step Action

Step Action

1 Double-click the DTM:2701 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Include field in the print check box. 

4 Click OK to exit the dialog.
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How to customize
the DTM:2702

element

The DTM:2702 element contains the Date/Time/Period corresponding to the date qualifier 
in the DTM:2701 element. The DTM:2702 element is used to designate when the 
shipment is required.

In this section of the tutorial, you need to rename the label for this field (the new label is 
named Requested). You need to add the words Ship Date using static text. Static text is 
text that is always printed when the form is used. It is not defined in the field properties of 
the element so that Ship Date is displayed on the line below Requested. The full field label 
is Requested Ship Date.

Use this procedure to change the element and field lengths and rename the field label for 
the first Date/Time/Period field.

Step Action

1 Double-click the DTM:2702 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab. 

3 In the Maximum box, enter 8 to allow the entire date, including separators 
(/), in this element.

4 Select the Print tab. 

5 In the Label box, enter Requested to replace the existing field label. 

Note
You will enter Ship Date on a separate line later in this tutorial.

6 In the Maximum number of characters to be printed box, enter 8.

7 Click OK to exit the dialog.
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Customizing the
DTM:13 segment

The DTM:13 segment (in the LIN group) is used to print the last delivery date (the latest 
date the order may be delivered). To ensure that Gentran:Server prints the correct date in 
the Date/Time/Period field, you must use the key field function. The key field function 
enables you to specify a second qualification in selecting a segment. The segment name is 
the first qualification. Data must be provided in the order designated through the use of 
key fields. For example, for this tutorial, you expect the required shipment date (DTM:27) 
first, and then the last delivery date (DTM:13).

For this tutorial, if the Date/Time/Period Qualifier field contains the value 10 (required 
shipment date), then the date is printed in the Date/Time/Period field of the DTM:27 
segment. If the Date/Time/Period Qualifier field contains the value 128 (last delivery 
date), then the date is printed in the Date/Time/Period field of the DTM:13 segment.

How to use a Key
Field for the

DTM:13 segment

Use this procedure to use a key field for the DTM:13 segment.

Step Action

1 Click the DTM:13 segment with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed. 

2 Select the Key Field tab. 

3 From the Field list, select 2005 DATE/TIME/PERIOD QUALIFIER.

4 Verify that the Use constant option is selected.

5 Click Edit to display the Map Constants dialog. 

System Response
The Map Constants Properties dialog is displayed.

6 Click New to display the Edit Constant dialog.

7 In the ID box, enter Delivery date/time, last.

8 From the Type list, select String.

9 In the Value box, enter 128 to identify the actual value of the constant.

10 Click OK to exit the Edit Constant dialog.

11 Click Close to exit the Map Constants dialog.

12 From the Use constant list, select 128 to indicate to the system that this 
date is the last delivery date.

13 Click OK to exit the Key Field dialog.
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Customizing the LIN Group Creating a Print Form2 - 92
How to customize
the DTM:1301

element

The DTM:1301 element (in the DTM:13 segment) contains the Date/Time/Period 
Qualifier for the date in the DTM:1302 element. Your trading partner sends you two types 
of dates: the required shipment date and the last delivery date (in that order). You used the 
key field function for the DTM:13 segment to indicate to Gentran:Server that the last 
delivery date is printed in the Date/Time/Period field (DTM:1302). The DTM:1301 
element must be present, but you can prevent this field from being displayed, since the 
meaningful information for a printout is the date itself.

Use this procedure to hide the second Date/Time/Period Qualifier field.

How to customize
the DTM:1302

element

The DTM:1302 element contains the Date/Time/Period corresponding to the date qualifier 
in the DTM:1301 element.The DTM:1302 element is used to designate the last delivery 
date that shipments can be shipped.

You need to rename the label for this field (the new label will be named Ship No). You 
need to add Later further in this tutorial using static text so that Later is displayed on the 
line below Ship No. The full field label will be Ship No Later.

Use this procedure to change the field and element lengths and rename the field label for 
the second Date/Time/Period field.

Step Action

1 Double-click the DTM:1301 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab. 

3 Clear the Include fields in the print check box. 

4 Click OK to exit the dialog.

Step Action

1 Double-click the DTM:1302 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab.

3 In the Maximum box, enter 8 to allow the entire date, including separators 
(/), in this element.

4 Select the Print tab.
(Continued on next page)
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Customizing the
MOA:5 segment

The MOA:5 segment contains the Monetary Amount for the items on the purchase order. 
Information in the MOA:5 segment pertains to each line item on the purchase order, and 
not to the entire purchase order. The standard allows the MOA:5 segment to be used up to 
five times for each line item but you need the MOA:5 segment to be used only once for 
each line item. You have already changed the maximum use of the MOA:5 segment to 
one.

How to customize
the MOA:501

element

The MOA:501 element is a mandatory element that contains the Monetary Amount Type 
Qualifier for the purchase order. This element must be present in the purchase order when 
the MOA:5 segment is activated. You do not need this qualifier to be printed on the 
printout. You must prevent this field from being displayed on the printout.

Use this procedure to hide the Monetary Amount Type Qualifier field.

5 In the Label box, enter Ship No to replace the existing field label. 

Note 
You will enter Ship No on a separate line later in this tutorial.

6 In the Maximum number of characters to be printed box, enter 8.

7 Click OK to exit the dialog.

 Action

Step Action

1 Double-click the MOA:501 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 Clear the Include fields in the print check box.

4 Click OK to exit the dialog.
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How to customize
the MOA:502

element

The MOA:502 element contains the Monetary Amount for the purchase order. You need to 
rename the field label on the printout. The standard allows up to 18 digits in this field. You 
know that your trading partner orders items totaling no more than $999,999 (a six-digit 
number), so you need to change the maximum length to eight for this field (to 
accommodate a six-digit number, a place separator, and a plus or minus sign) and change 
the value in the Screen Format and EDI Format lists to R2, which indicates a number with 
an explicit decimal point and two decimal places.

Use this procedure to change the element and field lengths, rename the field label, and 
change the screen and EDI formats for the Monetary Amount field.

Step Action

1 Double-click the MOA:502 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Maximum box, enter 8.

4 From the Format of the data in the form list, select R2.

5 From the Format of the data in the file list, select R2 to indicate that you 
expect a number with an explicit decimal point and up to two decimal 
places.

6 Select the Print tab.

7 In the Label box, enter Price.

8 In the Maximum number of characters to be printed box, enter 8.

9 Click OK to exit the dialog.

(Continued on next page)
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10 Click Generate Layout on the Main Toolbar to refresh the print form 
display. 

System Response
The Line Item (LIN) frame now should look like this: 

 (Contd)
Step Action
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Customizing the UNS Segment

Overview The UNS segment is a mandatory segment that contains the Section Control summary 
information for the purchase order. This segment identifies summary information that is 
pertinent to the entire purchase order.

How to customize
the UNS01 element

The UNS01 element is a mandatory element that contains the Section Identification for 
the purchase order. This element must be present in the purchase order, but you do not 
need this field to be printed on the printout. 

Use this procedure to hide the Section Identification field.

Step Action

1 Double-click the UNS01 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 Clear the Include fields in the print check box. 

4 Click OK to exit the dialog.

5 Click Generate Layout on the Main Toolbar. 

System Response
The header frame now should look like this: 
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Print Form Customizing the CNT Segment 2 - 97
Customizing the CNT Segment

Overview The CNT segment (in the CNT group) contains the Control Total summary information 
for the purchase order. This segment identifies summary information that is pertinent to 
the entire purchase order. You expect to use this segment only once, so you have already 
changed the maximum use of the CNT segment to one.

How to customize
the CNT01

element

The CNT01 element is a mandatory element that contains the Control Qualifier for the 
purchase order. This element must be present in the purchase order when the CNT 
segment is used.You do not need this qualifier to be printed so you need to prevent this 
field from being displayed on the printout.

Use this procedure to hide the Control Qualifier field.

How to customize
the CNT02

element

The CNT02 element contains the Control Value (the total number of line items) for the 
purchase order. You need to rename the field label on the printout to more clearly identify 
the contents of the field. The standard allows up to an 18-digit number in this field. You 
know that your trading partner will order no more than 99,999 (a five-digit number) items 
so you will change the maximum length to six for this field. You also need to change the 
value in the Screen Format and EDI Format lists to N0, which indicates a number with an 
implicit decimal point and no decimal places.

Use this procedure to change the element and field lengths, rename the field label, and 
change the screen and EDI formats for the Control Value field.

Step Action

1 Double-click the CNT01 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Print tab.

3 Clear the Include this field in the print check box.

4 Click OK to exit the dialog.

Step Action

1 Double-click the CNT02 element. 

System Response
The Element Properties dialog is displayed. 

2 Select the Validation tab.
(Continued on next page)
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Now you are ready to format the fields and their labels to make the fields on the purchase 
order more consistent and visually attractive.

3 In the Maximum box, enter 6 for the maximum number of digits allowed 
for this element.

4 From the Format of the data in the form list, select N0. 

5 From the Format of the data in the file list, select N0. 

6 Select the Print tab.

7 In the Label box, enter Number of Line Items.

8 In the Maximum number of characters to be printed box, enter 6 to allow 
five digits and a place separator on the printout.

9 Click OK to exit the dialog.

10 Click Generate Layout on the Main Toolbar. 

System Response
The Control Total (CNT) frame now should look like this:

11 Click Save from the File menu to save the form.

 (Contd)
Step Action
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Format the Print Form 0

Overview

Introduction In the previous section of this tutorial, you customized the print form for an EDIFACT 
92.1 purchase order (ORDERS) that you will use to print the data you receive from Pet 
Zone. After successfully customizing the fields and elements of the print form, you are 
ready to format the layout of the form.

One form can consist of several frames. Each group and repeating segment has a 
corresponding frame that contains all the groups, segments, and elements at that level. 
When the form is printed, the frames are printed consecutively, in the order in which they 
occur in the form. Each frame is not printed on a separate page.

This section explains how to format the form, field by field.
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Resizing the Header Frame

Overview When a printout is produced based on the customized print form, the information is 
arranged according to how the frames and the fields contained on them were arranged 
when the form was compiled. You should eliminate unnecessary space as you arrange the 
fields on each frame.

Procedure Use this procedure to resize the header frame (containing fields from the BGM, DTM, and 
FTX segments, and the RFF and PAT groups).

Step Action

1 Click the BGM segment to display the Beginning of Message (header) 
frame in the Layout Window.

2 To display more of the form on your screen, click and drag the center bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want to view. 

Note
You should be able to view the entire width of the frame. If the right side 
of the header frame and the vertical scroll bar for the frame are not visible 
in the Layout Window, move the center bar between the EDI File Format 
Window and the Layout Window farther to the left so the entire frame is 
displayed. Alternatively, you can use the horizontal scroll bar at the 
bottom of the Forms main window to bring the right side of the header 
frame into view.

3 To resize the header frame, click and drag the right side of the frame 
approximately to the 20 cm. mark on the horizontal ruler (a form with a 
width of 20 cm. can be printed on an 8 1/2 x 11 sheet of paper). 

Note
Use the horizontal ruler at the top of the frame to help you resize the 
frame. The instructions in this tutorial are given in centimeters. You can 
toggle from inches to centimeters by double-clicking the yellow square 
where the vertical and horizontal rulers meet.
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Adding a Title to the Form

Overview You want the form to have a title designating the standard agency (EDIFACT), the version 
(92.1), the type of message (purchase order), and the trading partner (Pet Zone) for which 
this form is used. You need to add a title to the print form by adding static text.

Procedure Use this procedure to add and position the title for the form.

Step Action

1 Select all the fields and field labels on the frame. 

Note
To select more than one field or field label, click and drag the mouse 
diagonally across all the fields and field labels you want to select. When 
you release the mouse button, all the fields and field labels completely 
included within the dragged-across area have handles, indicating that they 
were selected.

2 Click and drag your selection approximately two or three centimeters 
lower on the frame to make room at the top of the frame for the title.

3 Click Add Text on the Main Toolbar. 

System Response
A text box is added to the current frame, displayed in the upper left corner 
of the frame.

Note
If the template is larger than the frame (there is a scroll bar on the right 
side of the frame), the static text is displayed in the upper left corner of the 
part of the template that is displayed, not at the top of the template.

4 In the new text box, enter EDIFACT 92.1 Purchase Order.

5 Click OK.

6 Click Add Text on the Main Toolbar. 

7 In the new text box, enter Pet Zone.

8 The static text you added is displayed in the upper left corner of the frame.
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Centering the Text

Overview This section describes how to center text on a form.

Procedure Use this procedure to center the static text at the top of the purchase order form.

Step Action

1 Click and drag the first line of static text (EDIFACT 92.1 Purchase 
Order) so that the text is centered on the first line of the frame.

2 Click and drag the second line of static text (Pet Zone) so that the text is 
centered on the second line of the frame. 

System Response
The header frame now should look like this: 
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Arranging the Header Fields

Overview By default, each field and its associated label are printed on their own line. It is common 
for purchase orders and forms to arrange some fields in columns of information. The first 
fields you rearrange are the header fields, which are the fields associated with the BGM, 
DTM, and FTX segments, and the RFF and PAT groups.

By removing the field label in the Label field of the Display Properties dialog, you 
prevented some of the field labels from being printed. The fields are displayed on your 
print form but their associated labels are not printed. 

Note
If you forget which unlabeled field contains what data, you can click the field. Its 
associated element is highlighted in the EDI File Format Window, providing you with a 
description of the field.
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Resizing the Header Fields

Overview When you customized the element properties in the previous section of this chapter, you 
changed the display lengths (on the Display Properties dialog) for some of the fields on 
the header frame. The fields that are displayed in the Layout Window currently reflect the 
default display lengths for the fields. To reflect the new sizes of the fields in the Layout 
Window, you must select the fields for which you changed the display lengths, then resize 
the fields.

Note
If a field and its corresponding field label move together, the Lock Labels to Fields option 
is turned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels 
option.

Procedure Use this procedure to resize the fields on the header frame.

Step Action

1 Select all the fields on the header frame (Order Number, Order Date, Free 
Text, Contract No., Terms of Payment, Order Type, and Payment Terms 
Type Qualifier).

Note
To select a group of fields, click and drag the mouse diagonally across all 
the fields you want to select.

2 Select Size to Length from the Display menu. All selected fields are 
resized to the lengths specified in the Maximum number of characters to 
be printed field of the Display Properties dialog for each field.

Note
If you format a form component in a way you did not intend, select Undo 
from the Display menu to undo your last formatting action.
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Moving and Aligning the Header Fields and Field Labels

Overview This section describes how to move and align header fields and field labels.

Procedure Use this procedure to move and align the fields and field labels on the header frame.

Note
If a field is not in the part of the frame that currently is displayed, use the scroll bar to 
scroll down the frame until you locate the hidden field(s).

Step Action

1 Select each field individually and drag it closer to its respective field label. 

CAUTION
DO NOT MOVE FIELDS THAT ARE NOT LABELED.

2 Select the Order Date label and field and drag them to the right of the 
Order Number label and field (at approximately 11.5 cm. on the horizontal 
ruler).

3 Select the Order Type label and field and drag them below the Order 
Number label and field.

4 Select the Contract No. label and field and drag them below the Order 
Date label and field.

5 Select the Free Text field and drag it below the Order Type label and 
field.

6 Select the Payment Terms Type Qualifier field and drag it below the 
Free Text field.

7 Select the Terms of Payment field and drag it to the right of the Payment 
Terms Type Qualifier field.

8 Select the following items:

◗ Order Number field label
◗ Order Type field label 
◗ Free Text field 
◗ Payment Terms Type Qualifier field.

Note
To select more than one item on a frame, click the first item, then press 
CTRL and click the second item.

(Continued on next page)
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9 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

System Response
The left margins of the selected labels and fields are aligned.

10 Select the Order Type and Order Number fields (in that order).

11 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the Order Type and Order 
Number fields are aligned.

12 Select the Order Date and Contract No. field labels.

13 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

System Response
The left margins of the Contract No. and Order Date field labels are 
aligned.

14 Select the Order Date and Contract No. fields (in that order).

15 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. .

System Response
The left margins of the Contract No. and Order Date fields are aligned.

16 Select the Order Number and Order Date labels and fields.

17 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected fields and field labels 
are aligned.

18 Select the Order Type and Contract No. labels and fields.

19 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. 

System Response
The tops of the selected fields and field labels are aligned.

20 Select the Payment Terms Type Qualifier and Terms of Payment fields.

21 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. 

System Response
The tops of the selected fields are aligned.

(Continued on next page)

 (Contd)
Step Action
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9 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

System Response
The left margins of the selected labels and fields are aligned.

10 Select the Order Type and Order Number fields (in that order).

11 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the Order Type and Order 
Number fields are aligned.

12 Select the Order Date and Contract No. field labels.

13 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

System Response
The left margins of the Contract No. and Order Date field labels are 
aligned.

14 Select the Order Date and Contract No. fields (in that order).

15 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. .

System Response
The left margins of the Contract No. and Order Date fields are aligned.

16 Select the Order Number and Order Date labels and fields.

17 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected fields and field labels 
are aligned.

18 Select the Order Type and Contract No. labels and fields.

19 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. 

System Response
The tops of the selected fields and field labels are aligned.

20 Select the Payment Terms Type Qualifier and Terms of Payment fields.

21 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. 

System Response
The tops of the selected fields are aligned.

(Continued on next page)

 (Contd)
Step Action
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22 To resize the frame, click and drag the bottom of the frame to just below 
the Payment Terms Type Qualifier and Terms of Payment fields.

System Response
The header frame now should look like this: 

 (Contd)
Step Action
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Arranging the Name and Address (NAD) Fields

Overview The fields that contain information about the names and addresses (NAD group) for the 
purchase order are contained on a separate frame than the rest of the header information. 
When you print the purchase order form, the fields on the Name and Address frame will 
be printed after the fields on the header frame (the fields in the BGM, DTM, and FTX 
segments, and the RFF and PAT groups).

You prevented all the labels for the name and address fields from being printed, so you 
will see the fields in your print form, but not their associated labels.

In arranging the Name and Address (NAD) frame, first you will resize the frame to give it 
the same width as the header frame, then you will move and resize the fields.

How to resize the
name and address

(NAD) frame

Use this procedure to resize the Name and Address (NAD) frame.

How to resize the
name and address

fields

Use this procedure to resize the fields on the Name and Address (NAD) frame.

Step Action

1 Click the NAD group to display the Name and Address frame in the 
Layout Window.

2 Click and drag the right side of the frame to the 20 cm. mark on the 
horizontal ruler (a form with a width of 20 cm. can be printed on an 
8 1/2 x 11 piece of paper).

Step Action

1 Select all the fields on the Name and Address frame (Party Qualifier field, 
Party Name field, both Street and Number/P.O. Box fields, City Name 
field, Country Sub-Entity Identification field, and Postcode Identification 
field).

2 Select Size to Length from the Display menu. All selected fields will be 
resized to the lengths specified in the Maximum number of characters to 
be printed box of the Display Properties dialog for each field.
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How to arrange
the name and
address fields

Use this procedure to arrange the fields on the Name and Address frame.

Step Action

1 Select the Party Qualifier field (3035_DESC) and drag it to the upper left 
corner on the frame.

2 Select the Party Name field and drag it to the right of the Party Qualifier 
field (on the same line).

3 Select both Street and Number/P.O. Box fields and drag them below the 
Party Name field.

4 Select the City Name field and drag it below the second Street and 
Number/P.O. Box field.

5 Select the Country Sub-Entity Identification field and drag it to the 
right of the City Name field (on the same line).

6 Select the Postcode Identification field and drag it to the right of the 
Country Sub-Entity Identification field (on the same line).

7 Select the Party Qualifier and Party Name fields.

8 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected fields will be aligned.

9 Select the City Name, Country Sub-Entity Identification, and Postcode 
Identification fields.

10 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected fields will be aligned.

11 Select the following fields:

◗ Party Name 
◗ Street and Number/P.O. Box (both fields) 
◗ City Name

12 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

(Continued on next page)
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Print Form Arranging the Name and Address (NAD) Fields 2 - 111
Arranging the line
item (LIN) fields

The fields that contain information about each line item for the purchase order are 
contained on a separate frame. To access this frame, select the LIN group.

You prevented some of the field labels from being displayed, so you see the fields in the 
layout of your print form, but not their associated labels. In case you have forgotten which 
unlabeled field contains what data, you can click the field. The name of the element will 
be highlighted in the EDI File Format Window.

Before you arrange the line item fields and their frame, you need to resize the frame to 
give it the same width as the other frames. Then move and resize the fields and field 
labels, as well as add static text to the form.

How to resize the
line item (LIN)

frame

Use this procedure to resize the Line Item (LIN) frame.

13 To resize the frame, click and drag the bottom of the frame to just below 
the City Name, Country Sub-Entity Identification, and Postcode 
Identification fields. 

System Response
The Name and Address (NAD) frame now should look like this:

 (Contd)
Step Action

Step Action

1 Click the LIN group to display the Line Item frame in the Layout 
Window.

2 Click and drag the right side of the frame to the 20 cm. mark on the 
horizontal ruler (a form with a width of 20 cm. can be printed on an 8 1/2 
x 11 piece of paper).
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How to resize the
line item fields

Use this procedure to resize the line item fields.

Adding column
headings

You can add column headings (using static text) to the frame to change the way the field 
labels are displayed in the form. Currently, each field label in this form consists of one line 
of text.

You need all the horizontal space that is available in order to arrange the line item fields 
horizontally. By adding a second line of text to some of the longer field labels (these field 
labels will be identified in the steps that follow), more horizontal space will be available 
on the frame.

You will add the following lines of static text to the form:

(Continued on next page)

Step Action

1 Select the following fields:

◗ Line
◗ Prod ID
◗ Unit 
◗ Qty
◗ Requested
◗ Ship No
◗ Price

2 Select Size to Length from the Display menu. All selected fields are 
resized to the lengths specified in the Maximum number of characters to 
be printed box of the Display Properties dialog for each field.

Static Text Placement on Form

No. Below the Line field label

Type Below the Code field label

Ord Below the Qty field label

Each Below the Price field label

Ship Date Below the Requested field label

Later Below the Ship No field label
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You need to add all of the static text (column headings and separating lines), then move 
each line of static text into its proper location, later in this section.

When you finish adding the static text and moving each line of static text to its proper 
location, the Line Item (LIN) frame should look like this: 

How to add
column headings

Use this procedure to add and position static text.

Step Action

1 Select all the fields and field labels on the frame.

2 Click and drag them to the bottom portion of the frame. You are arranging 
the fields at the top of the frame so moving the fields and field labels out 
of the way initially gives you room at the top of the frame.

3 Click the Add Text button on the Main Toolbar. 

System Response
A text box is added to the current frame in the upper left corner.

4 Select the new text box and enter No. (note the period included in the 
text). The Text Properties dialog is displayed as you are typing. Click OK 
to add the text.

5 Click the Add Text button on the Main Toolbar. 

6 Select the new text box and enter Type. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

7 Click the Add Text button on the Main Toolbar.

8 Select the new text box and enter Ord. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

9 Click the Add Text button on the Main Toolbar.

10 Select the new text box and enter Each. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

11 Click the Add Text button on the Main Toolbar. 

12 Select the new text box and enter Ship Date. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

(Continued on next page)
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Adding lines
separating column

headings and fields

In this print form, rectangular boxes are used to designate fields. The boxes make it easy 
to distinguish fields from field labels and static text. On the printout, there are no 
rectangular boxes surrounding the data in the fields. The printed field data and the field 
labels tend to look the same on the printout (same typeface, same size text, no boldface or 
italic type). You can make the field labels and static text stand out from the fields 
containing the actual data by adding lines separating the labels from the fields. You need 
to add static text to the form to add the separating lines.7

Add the following lines of static text (hyphens) to the form.

When you finish adding the static text and moving each line of static text to its proper 
location, the Line Item (LIN) frame should look like this: 

Add all of the static text, then move each static text to its proper location.

13 Click the Add Text button on the Main Toolbar.

14 Select the new text box and enter Later. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text. 

Note
The column headings (static text) you added are displayed in the upper 
left corner of the frame.

15 Select all the static text you added and drag it to the bottom of the frame. 

 (Contd)
Step Action

Static Text
Number of 
Hyphens Placement on Form

------ Six Below the No. static text

------------ Twelve Below the Prod ID field label

---- Four Below the Type static text

-------- Eight Below the Ord static text

---- Four Below the Unit field label

----------- Eleven Below the Each static text

---------- Ten Below the Ship Date static text

---------- Ten Below the Later static text
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How to add lines
separating column

headings and fields

Use this procedure to add and position separating lines (------) in the form.

Step Action

1 Click Add Text on the Main Toolbar.

2 Select the new text box and enter ------ (six hyphens). This series of 
hyphens forms a separating line between the words Line No. and the field 
below. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

3 Click Add Text on the Main Toolbar and a new text box is added to the 
current frame in the upper left corner.

4 Select the new text box and enter ------------ (12 hyphens). This series of 
hyphens forms a separating line between the words Prod ID and the field 
below. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

5 Click Add Text on the Main Toolbar and a new text box is added to the 
current frame in the upper left corner.

6 Select the new text box and enter ---- (four hyphens). This series of 
hyphens forms a separating line between the words Code Type and the 
field below. The Text Properties dialog is displayed as you are typing. 
Click OK to add the text.

7 Click Add Text on the Main Toolbar and a new text box added to the 
current frame in the upper left corner.

8 Select the new text box and enter -------- (eight hyphens). This series of 
hyphens forms a separating line between the words Qty Ord and the field 
below. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

9 Click Add Text on the Main Toolbar and a new text box is added to the 
current frame in the upper left corner.

10 Select the new text box and enter ---- (four hyphens). This series of 
hyphens forms a separating line between the word Unit and the field 
below. The Text Properties dialog is displayed as you are typing. Click 
OK to add the text.

11 Click Add Text on the Main Toolbar and a new text box is added to the 
current frame in the upper left corner.

12 Select the new text box and enter ----------- (11 hyphens). This series of 
hyphens forms a separating line between the words Price Each and the 
field below. The Text Properties dialog is displayed as you are typing. 
Click OK to add the text.

(Continued on next page)
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How to move the
line item fields,

column headings,
and separating

lines

The Line Item (LIN) frame now contains all of the fields, column headings, and separating 
lines that will be arranged on the form to create columns of information. You are ready to 
move the fields, labels, and static text (column headings, and separating lines) to their 
proper locations on the frame.

Use this procedure to arrange the Line Item (LIN) frame.

13 Click Add Text on the Main Toolbar and a new text box is added to the 
current frame in the upper left corner.

14 Select the new text box and enter ---------- (10 hyphens). This series of 
hyphens forms a separating line between the words Requested Ship Date 
and the field below. The Text Properties dialog is displayed as you are 
typing. Click OK to add the text.

15 Click Add Text on the Main Toolbar and a new text box is added to the 
current frame in the upper left corner.

16 Select the new text box and enter ---------- (ten hyphens). This series of 
hyphens forms a separating line between the words Ship No Later and the 
field below. The Text Properties dialog is displayed as you are typing. 
Click OK to add the text. 

Note
The separating lines you added are displayed in the upper left corner of 
the frame.

17 Select all the static text you added and drag it to the bottom of the frame. 
Moving the static text out of the way will give you more room at the top of 
the frame.

 (Contd)
Step Action

Step Action

1 Select the Line field label and drag it to the upper left corner on the frame.

2 Select the No. static text and drag it below the Line field label.

3 Select the first separating line you added (six hyphens) and drag it below 
the No. static text.

4 Select the Line field and drag it below the separating line you just moved.

5 Select the Prod ID field label and drag it to the right of the No. static text.

6 Select the second separating line you added (12 hyphens) and drag it 
below the Prod ID field label.

(Continued on next page)
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7 Select the Prod ID field and drag it below the separating line you just 
moved.

8 Select the Code field label and drag it to the right of the Prod ID field 
label (but in the same row as the Line field label).

9 Select the Type static text and drag it below the Code field label.

10 Select the third separating line you added (four hyphens) and drag it 
below the Code field label.

11 Select the Code field and drag it below the separating line you just moved.

12 Select the Qty field label and drag it to the right of the Code field label.

13 Select the Ord static text and drag it below the Qty field label.

14 Select the fourth separating line you added (eight hyphens) and drag it 
below the Ord static text.

15 Select the Qty field and drag it below the separating line you just moved.

16 Select the Unit field label and drag it to the right of the Ord static text.

17 Select the fifth separating line you added (four hyphens) and drag it below 
the Unit field label.

18 Select the Unit field and drag it below the separating line you just moved.

19 Select the Price field label and drag it to the right of the Unit field label 
(but in the same row as the Qty field label).

20 Select the Each static text and drag it below the Price field label.

21 Select the sixth separating line you added (11 hyphens) and drag it below 
the Each static text.

22 Select the Price field and drag it below the separating line you just moved.

23 Select the Requested field label and drag it to the right of the Price field 
label.

24 Select the Ship Date static text and drag it below the Requested field 
label.

25 Select the seventh separating line you added (ten hyphens) and drag it 
below the Ship Date static text.

26 Select the Requested field and drag it below the separating line you just 
moved.

(Continued on next page)

 (Contd)
Step Action
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How to align rows One of the remaining tasks in formatting the Line Item frame is to align the fields, field 
labels, and static text. You will first align the items in rows to give the form a consistent 
appearance. You will align the items in columns later in this tutorial.

Use this procedure to align the fields, field labels, and static text by row (horizontally).

27 Select the Ship No field label and drag it to the right of the Requested 
field label.

28 Select the Later static text and drag it below the Ship No field label.

29 Select the eighth separating line you added (ten hyphens) and drag it 
below the Later static text.

30 Select the Ship No field and drag it below the separating line you just 
moved.

31 The Item Description field will not be placed in a column. Rather, this 
field will be placed below the other fields on the Line Item (LIN) frame.

32 To move the Item Description field, click and drag it below the row of 
fields.

33 You should resize the Line Item (LIN) frame to eliminate unnecessary 
space resulting from arranging the fields on the frame. To resize the 
frame, click and drag the bottom of the frame to just below the Item 
Description field.

System Response
The Line Item (LIN) frame now should look similar to this:

 (Contd)
Step Action

Step Action

1 Select the following field labels and static text:

◗ Line
◗ Code
◗ Qty
◗ Price
◗ Requested
◗ Ship No

(Continued on next page)
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2 Select Align Controls from the Display menu. Select Top from the Align 
Controls submenu. The tops of all selected field labels and static text are 
aligned in a row.

3 Select the following field labels and static text:

◗ No.
◗ Prod ID
◗ Type
◗ Ord
◗ Unit
◗ Each
◗ Ship Date
◗ Later

4 Select Align Controls from the Display menu. Select Top from the Align 
Controls submenu.

5 Select all the separating lines between column headings and fields.

6 Select Align Controls from the Display menu. Select Top from the Align 
Controls submenu. 

7 Select the following fields:

◗ Line No.
◗ Prod ID
◗ Code
◗ Type
◗ Qty Ord
◗ Unit 
◗ Price Each
◗ Requested Ship Date
◗ Ship No Later

8 Select Align Controls from the Display menu. Select Top from the Align 
Controls submenu. 

 (Contd)
Step Action
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How to align
columns

You need to align the fields, field labels, and static text in columns to help give the form a 
consistent appearance.

Use this procedure to align the fields, field labels, and static text in columns.

Step Action

1 Select the Line No. column heading, its separating line, the Line No. field, 
and the Item Description field.

2 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The selected items are left-aligned in a column.

3 Select the Prod ID column heading, its separating line, and the Prod ID 
field.

4 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu.

5 Select the Code Type column heading, its separating line, and the Code 
Type field.

6 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu.

7 Select the Qty Ord column heading, its separating line, and the Qty Ord 
field.

8 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

9 Select the Unit column heading, its separating line, and the Unit field.

10 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu.

11 Select the Price Each column heading, its separating line, and the Price 
Each field.

12 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

13 Select the Requested Ship Date column heading, its separating line, and 
the Requested Ship Date field.

14 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu.

15 Select the Ship No Later column heading, its separating line, and the 
Ship No Later field.

(Continued on next page)
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Creating the line
item frame without

column headings

You have completed formatting the Line Item (LIN) frame so that the line item 
information is displayed in columns and rows. If you were to register the translation object 
now and run EDI data through the translation object, then you would see that the column 
headings are repeated for every line item. 

The column headings need to be printed on the printout only once so you need to copy and 
paste the LIN group to create a second LIN group (named LIN:2). The formatting in the 
LIN group is retained in the LIN:2 group. Change the maximum use of the first LIN group 
to one so that the column headings are printed only once. You need to remove the column 
headings in the LIN:2 group from the area that will be printed, leaving only the fields for 
printing the information on the printout.

You need change the maximum use of the LIN:2 group to 199999. Your partner can send 
you up to200,000 line items, so the total maximum use of both LIN groups does not need 
to exceed 200000. The LIN group retains its maximum use of one, and the maximum use 
of the LIN:2 group changes to 199999.

How to copy and
paste the LIN

group

Use this procedure to copy and paste the LIN group:

16 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. 

System Response
The Line Item (LIN) frame now should look like this: 

 (Contd)
Step Action

Step Action

1 Select the LIN group.

2 Click Copy on the Main Toolbar.

3 Select Paste on the Main Toolbar to paste the LIN group after the existing 
LIN group. Gentran:Server prompts you to specify whether you want the 
contents of the clipboard pasted as a child (subordinate) of the selected 
group, or at the same level as the group.

4 Click the Paste after selected item (at the same level) option to paste the 
Clipboard contents after the original LIN group.

5 Click OK to exit the dialog. The pasted group is named LIN:2.
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How to change the
maximum use of

the LIN group

Use this procedure to change the maximum use of the LIN group.

How to change the
maximum use of
the LIN:2 group

Use this procedure to change the maximum use of the LIN:2 group.

How to move the
LIN:2 column

headings below the
print area

Use this procedure to move the column headings on the second Line Item (LIN:2) frame 
below the print area so the headings do not print.

Step Action

1 Click the original LIN group with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The Group Properties dialog is displayed. 

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Group Properties dialog.

Step Action

1 Click the LIN:2 group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed. 

2 Select the Looping tab.

3 In the Max Usage box, enter 199999 to indicate that this group can be 
used up to 199,999 times in each purchase order.

4 Click OK to exit the Group Properties dialog.

Step Action

1 Click Generate Layout on the Main Toolbar to refresh the print form 
display.

2 Select the LIN:2 group. Its corresponding frame is displayed in the 
Layout Window.

3 Select all of the column headings and separating lines on the frame and 
drag them below the bottom of the frame so they are not displayed.

4 Select all of the fields on the frame and drag them to the top of the frame.
(Continued on next page)
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Arranging the
control total
(CNT) field

The Number of Line Items field (CNT group) for the purchase order is contained on a 
separate frame than the rest of the purchase order information because this field contains 
summary information that you want to be printed at the bottom of the translation object.

You need to resize the Control Total (CNT) frame to give it the same width as the Header, 
Name and Address, and Line Item frames.

How to resize the
control total

(CNT) frame

Use this procedure to resize the Control Total (CNT) frame.

How to resize and
move the control
total (CNT) field

Use this procedure to resize and move the Number of Line Items field on the Control Total 
(CNT) frame.

5 To resize the frame, click and drag the bottom of the frame to just below 
the Item Description field. 

System Response
The second Line Item (LIN:2) frame now should look like this: 

 Action

Step Action

1 Click the CNT group to display the Control Total frame in the Layout 
Window.

2 Click and drag the right side of the frame to the 20 cm. mark on the 
horizontal ruler (a form with a width of 20 cm. can be printed on an 
8 1/2 x 11 piece of paper).

Step Action

1 Select the Number of Line Items field.

2 Select Size to Length from the Display menu. The Number of Line Items 
field is resized to the length specified in the Maximum number of 
characters to be printed box of the Display Properties dialog.

3 Select the Number of Line Items field label and drag it to the upper left 
corner on the frame.

4 Select the Number of Line Items field and drag it to the right of its field 
label.

(Continued on next page)
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You have completed your Purchase Order from and are ready to compile the form.

5 To resize the Control Total (CNT) frame, click and drag the bottom of 
the frame to just below the Number of Line Items label and field.

6 Select Save from the File menu to save the form.

System Response
The Control Total (CNT) frame now should look like this: 

 Action
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Finalize the Form 0

Overview

Introduction Now that you have created and customized the print form, you are ready to compile the 
form to generate the translation object (*.TPL) that Gentran:Server uses before you print 
the report and test the compiled translation object.
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Compiling the Form

Overview The Compile function generates a translation object. The form that you created is a source 
map. When that source form is compiled the result is a compiled translation object.

Note
After you save the translation object, you must register it with Gentran:Server before you 
can use it. 

Procedure Use this procedure to compile the form.

Step Action

1 Select Compile from the File menu to display the Run-Time Translation 
Object Name dialog. 

CAUTION
DO NOT TO OVERLAY THE SOURCE FORM WITH THE 
COMPILED TRANSLATION OBJECT. USE THE .TPL 
FILE EXTENSION TO DISTINGUISH THE COMPILED 
TRANSLATION OBJECT.

(Continued on next page)
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2 Click Save to accept the translation object name (peteordp.tpl) in the File 
name box.

Note
This name for the compiled translation object (.TPL file) is the same file 
name as the source form (.STP file). Preserving the same file name (with 
different file extensions) ensures that the relationship between the source 
form and the compiled translation object remains evident.

System Response
The system compiles the form and generate an error report. The error 
report is displayed in the Compile Errors dialog. 

3 Click OK to exit the Compile Errors dialog.

Note
If the Compile Errors dialog contains errors, you must fix the problem(s) 
by redoing the appropriate section of the tutorial. Recompile the form 
after you correct the error(s) and save the form.

4 Select Save from the File menu to save the form. 

5 Select Details from the Edit menu to access the Translation Object Details 
dialog. The date on which you compiled the form is loaded automatically 
into the Compiled on box.

6 Click Cancel to exit the dialog.

 (Contd)
Step Action
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Printing the Report

Overview The Gentran:Server report enables you to validate and review the translation object, and 
make modifications as needed. If you review the report and determine that the translation 
object is incorrect, you should reiterate the form creation process as many times as 
necessary (make the modifications, save the form, recompile the form, and print the report 
again).

Procedure Use this procedure to print the Gentran:Server report.

Step Action

1 Select Print from the File menu to access the Print Options dialog.

System Response
The Print Options dialog is displayed.

2 Click OK to accept the defaults on this dialog (all options selected), so the 
report includes all sections and only the activated form components. 

System Response
The Print dialog is displayed.

3 Do you need to change setup options (to select a specific printer, paper 
orientation, or size and source of paper) ? 

◗ If yes, click Properties. Set the appropriate options. Click OK to 
begin the print process.

◗ If no, click OK to begin the print process.
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Testing the Translation Object

Overview Before you can use the EDIFACT ORDERS Pet Zone print translation object, you must 
test the translation object to verify that there are no errors in it. To test the translation 
object, you must have a file containing test data. For this tutorial, you will use the 
PETTSTE2.INT test file.

Testing stages This table lists the stages required for testing the print translation object you just created.

Stage Description

1 Register the PETEORDP.TPL translation object with Gentran:Server. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on registering a translation object.

2 Import the PETZONE2.PAR partner relationship into Gentran:Server. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on importing a partner. 

The default path for the partner is: 
C:\GENSRVNT\TUTORIAL\PETZONE2.PAR

3 Verify (in Partner Editor) that the ORDERS Pet Zone print translation 
object is selected for the Inbound Relationship. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on selecting inbound translation objects.

4 Use the Process File option in Gentran:Server to process the data file 
(PETTSTE2.INT) through the translation object. The data file is located 
in the TUTORIAL subfolder under the folder where Gentran:Server is 
installed. 

The default path for the data file is: 
C:\GENSRVNT\TUTORIAL\PETTSTE2.INT.

5 After the message is translated, it is located in the In Documents in 
Gentran:Server. Print the message to ensure that the message was 
translated correctly and that the printout looks the way you want it to look. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on printing messages.
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Overview 0

Introduction

In this chapter This tutorial defines the tasks necessary to create a screen entry form. A screen entry form 
is a predesigned layout that, when compiled into a translation object, enables users in your 
company to easily enter the data necessary to create a business message. 

This chapter includes the following topics associated with creating a screen entry form:

◗ Form analysis
◗ Creating, saving, and setting up a new form
◗ Customizing the form, including the groups, segments, and elements
◗ Formatting the form, including fields and field labels
◗ Finalizing the form

Purpose of this
tutorial

This tutorial explains how to customize and format a form before it is compiled into a 
translation object. The form that you create is a source form. When that source form is 
compiled, the result is a compiled translation object. You must register the translation 
object with Gentran:Server to be able to use the translation object (to enter EDI data in 
messages of that type).

Form criteria Gentran:Server generates a basic form based on the following criteria that you specify:

◗ Type of form (screen entry or print)
◗ Standard agency (e.g., EDIFACT, ANSI X12)
◗ Standard version (e.g., 92.1, 003040)
◗ Message type (e.g., INVOIC, 810 Invoice)

Mandatory
components

All mandatory groups, segments, composites, and elements for the standard, version, and 
message you specify are available for use (activated) when Gentran:Server creates a form. 
Only these mandatory form components (groups, segments, composites, and elements) are 
activated automatically. You must activate additional form components that you want to 
be displayed in the screen entry form, and then customize and format the form so that it is 
appropriate and useful for your company’s needs.
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Before you begin Before you begin to customize a screen entry form, you should be familiar with the 
following elements of form design:

◗ EDI standards (how EDI standards work and how the information your users need is 
translated to and from the standards)

◗ Your users (the individuals who use the screen entry translation objects to enter EDI 
data)

◗ Your trading partners (the organizations receiving the EDI data that your users enter 
in the screen entry translation object)

You can create a different screen entry form for each combination of message, trading 
partner, and standard version. The number of screen entry forms that you create is not 
limited and does not affect the number of print forms you create.

Recommendation
We recommend that you mock up a layout of the screen entry form the way you ultimately 
want it to look. As you are designing the layout, you should consider the people who use 
the translation object. Make sure that the form makes sense to the people who use it. By 
analyzing your company’s needs before you actually create the screen entry form, you 
reduce the amount of time spent later on redesigning or reformatting the form.
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Phases of Designing a Form

Design phases This table lists the phases of form design.

Phase Description

1 Analyze the EDI file.

2 Design and create the form.

3 Modify form components.

4 Customize the EDI data.

5 Format the screen entry form.

6 Finalize the form.
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Getting Started

Overview This tutorial is meant to be completed in its entirety. We strongly recommend that you 
complete each task sequentially. The purpose of completing each task in this tutorial in 
sequential order, as if it were your own scenario, is not only to teach you how to perform 
the individual tasks, but also to teach you a logical approach and methods that should be 
used when you create your own form.

This section guides you in completing the steps in the first phase of form design. In this 
section, you will create a new screen entry form based on a scenario we have defined for 
you. This section includes the basics of creating the form, such as defining the scenario 
and analyzing the purpose of the form, creating and saving the form, and setting up the 
form. You can find techniques for customizing the segments, elements, and groups in the 
form, as well as for formatting the organization and appearance of the form, later in this 
chapter.

Screen entry form
scenario

You will create a screen entry form for the INVOIC message (invoice), using the 
EDIFACT 92.1 standard. The steps involved in creating this form are broken down into 
manageable pieces so that you can learn the tasks and procedures involved in creating a 
screen entry form. You can apply the knowledge gained from using this tutorial to create 
your screen entry forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a wide 
variety of pet supplies for pet stores. One of your trading partners, Pet Zone (a large pet 
supply retailer), orders products from your company. Your company then invoices Pet 
Zone for those products. You will create a form that your data entry users will use to enter 
EDI data for the invoice that you will send to Pet Zone. From discussions with Pet Zone, 
you know the requirements for the invoices that they receive from you.
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Analyze the EDI File 0

Basic Tasks

Introduction To analyze the EDI file, you must first determine what data you need to send your trading 
partner and what data your trading partner expects to receive. It is important to analyze the 
data in this way so that the invoice contains all the information and so that your company 
can bill your partner correctly for the order you shipped to them. You and your partner 
must agree on which standard, version, and message you will use. In this tutorial, you are 
using an EDIFACT version 92.1 INVOIC invoice. It is important to know the format of 
the information your partner expects you to send in the invoice and what type of data will 
be contained in each element.

After you discuss with your trading partner what you will send, determine which segments 
and elements your partner requires, and review the EDI standard, you can list the items 
that you need to use. 

Form analysis The first step in creating a form is to analyze your form requirements. If the analysis you 
perform is complete, you will have all the information you need to create the form in an 
efficient and logical manner. If you omit this critical step and proceed directly to creating 
the form, it is likely that creating the form will be a much longer and more arduous task 
and the form may not work the way you need it to, due to oversights and omissions.

Creating a screen entry form for the EDIFACT INVOIC message requires several steps. 
Some steps are performed at the message level (such as activating form components) and 
others are iterative steps that are performed for each group, segment, or element in the 
form. In this analysis phase, you must determine what EDI data you will send Pet Zone, as 
well as what information Pet Zone requires to process the invoice. The fields on the form 
must account for all information that you expect to send to Pet Zone.
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Basic Tasks Creating a Screen Entry Form3 - 8
Mandatory
components

This table lists the groups, segments, composites, and elements that have been defined as 
mandatory by the standards committee for an EDIFACT invoice (INVOIC). 

Required
components

This table lists the form components for this tutorial that are required (need to be 
activated) and are not mandatory for the standard.

Note
When you activate a conditional group, segment, or composite, the mandatory subordinate 
segments, composites, and elements are activated automatically. A conditional group, 
segment, or composite is used only if there is EDI data available for an element contained 
in it.

Group Segment Composite Element Description

BGM Beginning of Message

DTM Date/Time/Period

C507

DTM01 Date/Time/Period Qualifier

UNS Section Control

UNS01 Section Identification

MOA Monetary Amount

Element Description
Data
Type Length

Constant, Code Value, or 
Format to Be Assigned

Beginning of Message (BGM Segment) (Already Activated)

BGM05 Document/Message 
Number

String 35

Date/Time/Period (DTM Segment) (Already Activated)

DTM01 Date/Time/Period Qualifier String 3 3 (Invoice Date/Time)

DTM02 Date/Time/Period String 35

Reference (RFF Group)

Reference (RFF Segment in RFF Group)

RFF01 Reference Qualifier String 3 ◗ CT (Contract Number)
◗ ON (Order Number 

(Purchase))

RFF02 Reference Number String 35

(Continued on next page)
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Basic Tasks 3 - 9
Date/Time/Period (DTM:2 Segment in RFF Group)

DTM:201 Date/Time/Period Qualifier String 3 ◗ 92 (Contract Effective 
Date)

◗ 4 (Order Date/Time)

DTM:202 Date/Time/Period String 35

Name and Address (NAD Group)

Name and Address (NAD Segment in NAD Group)

NAD01 Party Qualifier String 3 ◗ ST (Ship To)
◗ RE (Party To Receive 

Commercial Invoice 
Remittance)

NAD10 Party Name String 35

NAD16 Street and Number/P.O. 
Box

String 35

NAD17 Street and Number/P.O. 
Box

String 35

NAD19 City Name String 35

NAD20 Country Sub-Entity 
Identification

String 9

NAD21 Postcode Identification String 9

Payment Terms (PAT Group)

Payment Terms Basis (PAT Segment in PAT Group)

PAT01 Payment Terms Type 
Qualifier

String 3 Any valid code

Line Item (LIN Group)

Line Item (LIN Segment in LIN Group)

LIN01 Line Item Number Number 6

Additional Product ID (PIA Segment in LIN Group)

PIA01 Product ID Function 
Qualifier

String 3 5 (Product Identification)

(Continued on next page)

Element Description
Data
Type Length

Constant, Code Value, or 
Format to Be Assigned
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PIA02 Item Number String 35

PIA03 Item Number Type, Coded String 3 UP (UPC (Universal Product 
Code))

Item Description (IMD:2 Segment in LIN Group)

IMD:201 Item Description Type, 
Coded

String 3 F (Free Form)

IMD:206 Item Description String 35

Measurements (MEA:2 Segment in LIN Group)

MEA:201 Measurement Application 
Qualifier

String 3 AAE (Measurement)

MEA:202 Measurement Dimension, 
Coded

String 3

Quantity (QTY:2 Segment in LIN Group)

QTY:201 Quantity Qualifier String 3 47 (Invoiced Quantity)

QTY:202 Quantity Number 15 Format = R0

Date/Time/Period (DTM:11 Segment in LIN Group)

DTM:1101 Date/Time/Period Qualifier String 3 186 (Departure Date/Time, 
Actual)

DTM:1102 Date/Time/Period String 35

Monetary Amount (MOA Group in LIN Group)

Monetary Amount (MOA:5 Segment in MOA Group in LIN Group)

MOA:501 Monetary Amount Type 
Qualifier

String 3 146 (Unit Price)

MOA:502 Monetary Amount Number 18 Format = R2

Details of Transport (TDT Group in LIN Group)

Details of Transport (TDT:2 Segment in TDT Group in LIN Group)

TDT:201 Transport Stage Qualifier String 3 20 (Main-Carriage 
Transport)

(Continued on next page)

Element Description
Data
Type Length

Constant, Code Value, or 
Format to Be Assigned
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Basic Tasks 3 - 11
Segment analysis For each segment activated (either mandatory or optional), you must ask the following 
questions:

◗ Will the segment have a maximum use greater than one?
◗ What composites and elements need to be activated for the segment?

This table describes the segment components used in this tutorial.

TDT:205 Type of Means of Transport 
Identification

String 8 Any valid code

TDT:207 Carrier Identification String 17

Section Control (UNS Segment)

UNS01 Section Identification String 1 S (Summary)

Control Total (CNT Segment)

CNT01 Control Qualifier String 3 2 (Number of Line Items)

CNT02 Control Value Number 8 Format = N0

Monetary Amount (MOA Group) (Already Activated)

Monetary Amount (MOA:10 Segment in MOA Group)

MOA:1001 Monetary Amount Type 
Qualifier

String 3 77 (Invoice Amount)

MOA:1002 Monetary Amount Number 18 Format = R2

Element Description
Data
Type Length

Constant, Code Value, or 
Format to Be Assigned

Component Description

Group Contains related segments and/or groups that repeat in sequence 
until either the group data ends or the maximum number of times 
that the loop is allowed to repeat is exhausted.

Repeating segment Consists of elements that repeat in sequence until either the 
segment data ends or the maximum number of times the segment 
is allowed to repeat is exhausted.

Composite Contains two or more component data elements or subelements. 
Composites are defined by the EDI standards that use them 
(EDIFACT, TRADACOMS, and certain ANSI X12 standards).

(Continued on next page)
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Customization
tasks

Gentran:Server generates a form based on the groups, segments, composites, and elements 
you activate. At this point, the form is compliant with the standard and it contains all the 
necessary components based on the data you send Pet Zone. You need to customize the 
form components to produce a form that is easy to use to enter data in a logical manner.

This table lists the customization tasks described in this tutorial.

Maximum use Refers to the number of times it can be used within the structure 
in which the segment is defined. For example, if a segment can be 
used only once within a group but the group can be used multiple 
times, the segment still has a maximum use of one within each 
occurrence of the group. The standard defines the maximum 
number of times a segment can be used. You must determine how 
many times a segment is used based on what you send your 
trading partner.

Elements Each segment contains elements. Some elements are mandatory 
and others are optional to the standard but necessary for your 
needs. You must define all the elements that you send Pet Zone 
for each segment.

 (Contd)
Component Description

Form 
Component Description Customization Task

BGM05 
element

Document/
Message 
Number

You will set up the document name (which enables you 
to differentiate between messages in the document 
browsers in Gentran:Server) in this element. Also, your 
users will enter no longer than an eight-character string 
in this element, so you will change the maximum length 
for this element to eight. In addition, you will change 
the field label to Invoice No., which better describes the 
data your users will enter.

DTM segment Date/Time/
Period

You and your trading partner will use this segment only 
once, so you will change the maximum use of this 
segment to one.

DTM01 
element

Date/Time/
Period Qualifier

Your users will enter only the invoice date in this 
segment, so you do not need to load the entire code list 
table. You will define a constant value in this element 
for the invoice date. Then, you will prevent this field 
from being displayed in the screen entry form, because 
the value for this field will be entered automatically.

(Continued on next page)
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DTM02 
element

Date/Time/
Period

Your users will enter a string no longer than eight 
characters in this element, so you will change the 
maximum length for this element to eight. Also, you 
will change the field label to Invoice Date.

RFF group Reference You and your trading partner will use this group only 
once, so you will change the maximum use of this group 
to one. You will promote this group so that the fields in 
this group are placed on the main Invoice Message 
frame. Also, you need two iterations of this group: one 
for the contract number, and one for the purchase order 
number. You will copy this segment so that you will 
have the two iterations of this group you need.

RFF01 element Reference 
Qualifier

Your users will enter only the contract number in this 
segment, so you do not need to load the entire code list 
table. You will define a constant value in this field for 
the contract number. Then, you will prevent this field 
from being displayed in the screen entry form, because 
the value for this field will be entered automatically. 
You will perform the same task (with a different 
constant value) for the Reference Qualifier field in the 
new RFF group that you created by copying the original 
RFF group.

RFF02 element Reference 
Number

Your users will enter a string no longer than ten 
characters in this element, so you will change the 
maximum length for this element to ten. Also, you will 
change the field label to P.O. No. (“Contract No.” for 
the Reference Number field in the second iteration of 
the RFF segment).

DTM:2 
segment

Date/Time/
Period

You and your trading partner will use this segment only 
once, so you will change the maximum use of this 
segment to one.

DTM:201 
element

Date/Time/
Period Qualifier

Your users will enter only the contract date in this 
segment, so you do not need to load the entire code list 
table. You will define a constant value in this field for 
the contract date. Then, you will prevent this field from 
being displayed in the screen entry form, because the 
value for this field will be entered automatically. You 
will perform the same task (with a different constant 
value) for the Date/Time/Period Qualifier field in the 
new RFF group that you created by copying the original 
RFF group.

(Continued on next page)

 (Contd)
Form 

Component Description Customization Task
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DTM:202 
element

Date/Time/
Period

Your users will enter a string no longer than eight 
characters in this element, so you will change the 
maximum length for this element to eight. Also, you 
will change the field label to P.O. Date (“Contract Date” 
for the Date/Time/Period field in the second iteration of 
the RFF segment).

NAD group Name and 
Address

You and your trading partner have decided to use this 
group only once, so you will change the maximum use 
of this group to one. You will promote this group so that 
the fields in this group are placed on the main Invoice 
Message frame. Also, you need two iterations of this 
group: one for the Ship To name and address, and one 
for the Remit To name and address. You will copy this 
segment so that you will have the two iterations of this 
group you need.

NAD01 
element

Party Qualifier Your users will enter only the Ship To name and address 
in this group, so you do not need to load the entire code 
list table. You will define a constant value in this 
element for the contract number. Then, you will prevent 
this field from being displayed in the screen entry form, 
because the value for this field will be entered 
automatically. You will perform the same task (with a 
different constant value) for the Party Qualifier field in 
the new NAD group that you created by copying the 
original NAD group.

NAD10 
element

Party Name You will change the field label for this element to Ship 
To (“Remit To” for the Party Name field in the new 
NAD group).

NAD16 
element

Street and 
Number/P.O. 
Box

The data in this element will be self-explanatory, so you 
will remove the label from this field.

NAD17 
element

Street and 
Number/P.O. 
Box

The data in this element will be self-explanatory, so you 
will remove the label from this field.

NAD19 
element

City Name The data in this element will be self-explanatory, so you 
will remove the label from this field. Also, your users 
will enter no longer than a thirty-character string in this 
element, so you will change the maximum length for 
this element to thirty.

(Continued on next page)
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NAD20 
element

Country Sub-
Entity 
Identification

The data in this element will be self-explanatory, so you 
will remove the label from this field. Also, your users 
will enter no longer than a two-character string in this 
element, so you will change the maximum length for 
this element to two.

NAD21 
element

Postcode 
Identification

The data in this element will be self-explanatory, so you 
will remove the label from this field.

PAT group Payment Terms You and your trading partner will use this group only 
once, so you will change the maximum use of this group 
to one. You will promote this group so that the fields in 
this group are placed on the main Invoice Message 
frame.

PAT01 element Payment Terms 
Type Qualifier

Your users can enter any of the payment terms type 
codes that the standard designates as valid codes. You 
will load the entire code list for this element, which will 
create a list containing valid codes from which users can 
select. Also, you will change the field label to Payment 
Terms Code.

LIN group Line Item You will add the more descriptive title, Line Items, to 
the group description to label the fields contained on the 
LIN frame.

LIN01 element Line Item 
Number

You will use an accumulator for this element to count 
line items in the invoice. This accumulator will be used 
in the Control Value field (CNT02) to calculate the total 
number of line items in the invoice. You will instruct the 
system to display the value in this field in the first 
column in the Line Items list on the Invoice Message 
frame. Also, the line item number will be no longer than 
five digits, so you will change the maximum length for 
this element to five. In addition, you will change the 
field label to Item No.

PIA segment in 
the LIN group

Additional 
Product ID

You and your trading partner will use this segment only 
once per line item, so you will change the maximum use 
of this segment to one.

(Continued on next page)
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PIA01 element Product ID 
Function 
Qualifier

Your users will enter only the item number in this 
segment, so you do not need to load the entire code list 
table. You will define a constant value in this element 
for the item number. Then, you will prevent this field 
from being displayed in the screen entry form, because 
the value for this field will be entered automatically.

PIA02 element Item Number Your users will enter a string no longer than ten 
characters in this segment, so you will change the 
maximum length for this element to ten. Also, you will 
change the field name to Product Code. In addition, you 
will instruct the system to display the value in this field 
in the second column in the Line Items list on the 
Invoice Message frame.

PIA03 element Item Number 
Type, Coded

Your users will enter only the product identification in 
this segment, so you do not need to load the entire code 
list table. You will define a constant value in this 
element for the product identification. Then, you will 
prevent this field from being displayed in the screen 
entry form, because the value for this field will be 
entered automatically. Also, the constant you defined 
for this element is only two characters long, so you will 
change the maximum length of this element to two.

IMD:2 
segment in the 
LIN group

Item Description You and your trading partner have decided to use this 
segment only once per line item, so you will change the 
maximum use of this segment to one.

IMD:201 
element

Item Description 
Type, Coded

Your users will enter only the free-form description in 
this segment, so you do not need to load the entire code 
list table. You will define a constant value in this field 
for the free-form description. Then, you will prevent 
this field from being displayed in the screen entry form, 
because the value for this field will be entered 
automatically.

MEA:2 
segment in the 
LIN group

Measurements You and your trading partner have decided to use this 
segment only once per line item, so you will change the 
maximum use of this segment to one.

(Continued on next page)

 (Contd)
Form 

Component Description Customization Task
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Basic Tasks 3 - 17
MEA:201 
element

Measurement 
Application 
Qualifier

Your users will enter only the measurement dimension 
in this element, so you do not need to load the entire 
code list table. You will define a constant value in this 
element for the measurement dimension. Then, you will 
prevent this field from being displayed in the screen 
entry form, because the value for this field will be 
entered automatically.

MEA:202 
element

Measurement 
Dimension, 
Coded

Your users can enter any of the measurement dimension 
codes that the standard designates as valid codes. You 
will load the entire code list for this element, which will 
create a list containing valid codes from which users can 
select. Also, you will change the field label to UOM 
(indicating “Unit of Measure”).

QTY:2 
segment in the 
LIN group

Quantity You and your trading partner will use this segment only 
once, so you will change the maximum use of this 
segment to one.

QTY:201 
element

Quantity 
Qualifier

Your users will enter only the invoiced quantity in this 
segment, so you do not need to load the entire code list 
table. You will define a constant value in this element 
for the invoiced quantity. Then, you will prevent this 
field from being displayed in the screen entry form, 
because the value for this field will be entered 
automatically.

QTY:202 
element

Quantity You will use an accumulator for this element to generate 
a running total of the invoice amount. This accumulator 
will be used in the Monetary Amount field (MOA:1002) 
to identify the total dollar amount invoiced. You will 
instruct the system to display the value in this field in 
the third column in the Line Items list on the Invoice 
Message frame. Also, your users will enter a number no 
longer than five digits in this element, so you will 
change the maximum length for this element to five. In 
addition, Your users will not use decimal places for the 
data in this field, so you will format the data with an 
explicit decimal point and no decimal places.

DTM:11 
segment in the 
LIN group

Date/Time/
Period

You and your trading partner will use this segment only 
once per line item, so you will change the maximum use 
of this segment to one.

(Continued on next page)
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DTM:1101 
element

Date/Time/
Period Qualifier

Your users will enter only the actual departure date in 
this segment, so you do not need to load the entire code 
list table. You will define a constant value in this 
element for the actual departure date. Then, you will 
prevent this field from being displayed in the screen 
entry form, because the value for this field will be 
entered automatically.

DTM:1102 
element

Date/Time/
Period

Your users will enter a string no longer than eight 
characters in this element, so you will change the 
maximum length for this element to eight. Also, you 
will change the field label to Date Shipped.

MOA group in 
the LIN group

Monetary 
Amount

You and your trading partner will use this group only 
once per line item, so you will change the maximum use 
of this group to one. You will promote this group so that 
the fields in this group are placed on the main Invoice 
Message frame.

MOA:501 
element

Monetary 
Amount Type 
Qualifier

Your users will enter only the unit price in this segment, 
so you do not need to load the entire code list table. You 
will define a constant value in this element for the unit 
price. Then, you will prevent this field from being 
displayed in the screen entry form, because the value for 
this field will be entered automatically.

MOA:502 
element

Monetary 
Amount

You will use an accumulator for this element to generate 
the total dollar amount of the invoice amount. This 
accumulator will be used in the Monetary Amount field 
(MOA:1002) to identify the total dollar amount 
invoiced. You will instruct the system to display the 
value in this field in the fourth column in the Line Items 
list on the Invoice Message frame. Also, your users will 
enter a number no longer than eight digits in this 
element, so you will change the maximum length for 
this element to eight. In addition, your users will enter 
prices with two decimal points in this field, so you will 
format the data with an explicit decimal point and two 
decimal places. Finally, you will change the field label 
to Price.

TDT group in 
the LIN group

Details of 
Transport

You and your trading partner have decided to use this 
group only once per line item, so you will change the 
maximum use of this group to one. You will promote 
this group so that the fields in this group are placed on 
the main Invoice Message frame.

(Continued on next page)
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TDT:201 
element

Transport Stage 
Qualifier

Your users will enter only the main-carriage transport in 
this segment, so you do not need to load the entire code 
list table. You will define a constant value in this field 
for the transport stage. Then, you will prevent this field 
from being displayed in the screen entry form, because 
the value for this field will be entered automatically.

TDT:205 
element

Type of Means 
of Transport 
Identification

Your users can enter any of the type of means of 
transport identification codes that the standard 
designates as valid codes. You will load the entire code 
list for this element, which will create a list containing 
valid codes from which users can select. Also, you will 
change the field label to Transport Method. In 
addition, your users will enter a string no longer than 
two characters in this element, so you will change the 
maximum length for this element to two.

TDT:207 
element

Carrier 
Identification

Your users will enter a string no longer than twelve 
characters in this element, so you will change the 
maximum length for this element to twelve. Also, you 
will change the field name to Carrier Code.

UNS01 
element

Section 
Identification

The only type of section identification used in this 
segment is summary, so you do not need to load the 
entire code list table. You will define a constant value in 
this element for the summary. Then, you will prevent 
this field from being displayed in the screen entry form, 
because the value for this field will be entered 
automatically.

CNT segment Control Total You and your trading partner have decided to use this 
segment only once, so you will change the maximum 
use of this segment to one.

CNT01 
element

Control 
Qualifier

The only type of control used in this segment is the 
number of line items, so you do not need to load the 
entire code list table. You will define a constant value in 
this element for the number of line items. Then, you 
will prevent this field from being displayed in the screen 
entry form, because the value for this field will be 
entered automatically.

(Continued on next page)
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CNT02 
element

Control Value You will use an accumulator for this element to generate 
a total of the number of line items in the invoice. You 
will make this field display-only, so that users cannot 
change the value in this field. Also, the total in this field 
will be no longer than a six-character string, so you will 
change the maximum length for this element to six. You 
will change the field label to Number of Line Items. In 
addition, the value in this field always will be a whole 
number, so you will format the data with an explicit 
decimal point and no decimal places.

MOA group Monetary 
Amount

You and your partner will use this group only once, so 
you will change the maximum use of this group to one. 
You will promote this group so that the fields in this 
group are placed on the main Invoice Message frame.

MOA:1001 
element

Monetary 
Amount Type 
Qualifier

The only type of monetary amount used in this segment 
is the invoice amount, so you do not need to load the 
entire code list table. You will define a constant value in 
this field for the invoice amount. Then, you will prevent 
this field from being displayed in the screen entry form, 
because the value for this field will be entered 
automatically.

MOA:1002 
element

Monetary 
Amount

You will use an accumulator for this element to generate 
a running total of price (the quantity invoiced for each 
line item multiplied by the unit price). You will make 
this field display-only, so that users cannot change the 
value in this field. Also, the total in this field will be no 
longer than a ten-character string, so you will change 
the maximum length for this element to ten. You will 
change the field label to Total Invoice Amount. 
Finally, the value in this field will be a price with two 
decimal places, so you will format the data with an 
explicit decimal point and two decimal places.

 (Contd)
Form 

Component Description Customization Task
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Design and Create the Form 0

Verifying the Global EDI Date Formats

Introduction Gentran:Server Forms Integration enables you to customize the global EDI date formats 
for all forms. You can specify the default EDI format of dates for both six-character dates 
and eight-character dates. When you customize the global EDI date formats, the settings 
are valid for all forms created in the current session of Gentran:Server. You can override 
the default date formats for an individual element on the Field Properties dialog for that 
element.

You must verify that you are using the correct global date formats the first time you use 
Forms Integration. You can change the default date formats if they do not match the 
formats you intend to use.

Procedure Use this procedure to verify the global EDI date formats. 

Step Action

1 Launch the Forms Integration subsystem. 

Reference
See How to Launch Forms Integration on page 1 - 10 for instructions. 

2 Select Preferences from the Options menu to display the Preferences 
dialog. The Preferences dialog is a property sheet that enables you to set 
global defaults for Gentran:Server.

3 Verify that the Standard Formats tab displays the default date formats that 
are used when elements are read from the standards database.

4 Verify that the Six-character dates list contains YYMMDD to define the 
format of the six-character EDI dates in your forms.

5 Verify that the Eight character dates list contains YYYYMMDD to 
define the format of the eight-character EDI dates in your forms.

6 Click OK to accept the default date formats for 6- and 8-character date 
fields and exit the Preferences dialog.

Note
To change the order in which the date formats appear in the Six-character 
dates and Eight character dates lists or to add a new date format to the 
lists, select Date Formats from the Options menu.
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Defining the Type of Form

Overview The first task in creating a new form is to define the type of form and EDI standard, 
version, and message. In this tutorial, you are creating a screen entry form so that your 
data entry users can enter EDI data in an invoice translation object in Document Editor. 
Instead of defining the INVOIC (invoice) message to the system yourself, you want 
Gentran:Server to use the standards database on your system to build the invoice 
according to the EDIFACT 92.1 standard.

Before you begin Before you begin this procedure, verify that you have installed the Gentran Standards.

Reference
See How to Install Gentran Standards on page 1 - 11 for instructions. 

Procedure Use this procedure to create the new screen entry form.

Step Action

1 Select New from the File menu to display the New Form Wizard.

2 From the What kind of form are you creating list, select Screen Entry to 
indicate that the translation object that your are creating is a Screen Entry 
translation object. 

3 In the What is the name of the form box, enter Screen Invoic Pet Zone. 
This description provides a brief explanation of the compiled translation 
object that enables you to differentiate it from similar translation objects 
in Gentran:Server.

Example
Screen INVOIC Pet Zone is the description that indicates an EDIFACT 
92.1 Invoice (INVOIC) for partner Pet Zone.

4 Verify that the name that is displayed in the What is your name box is 
accurate. 

5 Click Next to continue. 

6 Select Delimited EDI as the data format syntax that you want to use. 

7 Click Customize. 

8 Click Next to continue. 

9 From the Data Source list, select Gentran Standards as the ODBC data 
source that you wish to use.

10 Click Next to continue. 
(Continued on next page)
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11 From the Agency list, select [E] Edifact, which is the EDI standard you 
will use for this translation object.

12 From the Version list, select [092001] EDIFACT 1992 RELEASE 1, 
which is the version of the standard you will use for this translation object. 
The versions that are available depend on which standard you selected. 
The EDIFACT standard version 92.1 is listed as version 092001 in the 
Gentran:Server standards files.

13 From the Transaction list, select [INVOIC] INVOICE MESSAGE, 
which is the transaction set (message) you will use for this translation 
object. The documents that are available depend on which standard and 
version you selected.

14 Click Next to continue. 

15 Click Finish to create the EDI file. This may take a few seconds.

System Response
The form is displayed.

16 From the Edit menu, select Details. 

17 Verify that Screen Entry is selected in the Translation Object Function 
list. 

18 In the Major version box, enter 1 to designate the version number for this 
translation object.

(Continued on next page)
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19 In the Minor version box, accept the default value 0 that designates the 
release number for this translation object.

Recommendation
After you make a major change to this form, increase the version to the 
next higher sequential number (e.g., 2.0). If you make a minor change to 
the form, increase the release to the next higher sequential number (e.g., 
2.1).

20 The Input and Output boxes (Agency, Version, Transaction, Release, and 
F Group) contain information only if the Input and/or Output sides of the 
form are of EDI format. For this tutorial, do not change the information in 
these boxes.

Note
The system allows you to change the information in the Input and Output 
boxes, but modifying this information does not alter the content of the 
form. An example of when you might want to alter these boxes is when 
you want the form to reflect a standard version that is not loaded on your 
system. You can change the version on this dialog, and then physically 
alter the form to be compliant with that version.

21 Click OK to save the translation object details and access the Save As 
dialog.

22 Select Save from the File menu.

System Response
The Translation Object Details dialog is displayed.

Note
If you have performed any function that invalidates the current format of 
the translation object, the Save function is unavailable (dimmed) until you 
regenerate the layout (click Generate Layout on the Main Toolbar).

23 Verify that the Save in list reflects the drive\folder where Gentran:Server 
is installed. 

The default is GENSRVNT\Forms.
(Continued on next page)
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24 In the File name field, enter peteinvs.stp to replace the default file name. 
The file name must be unique. In our example, the name indicates an 
EDIFACT invoice message (INVOIC) for partner Pet Zone.

Note
The default file extension for forms is .STP. The naming conventions in 
the Gentran:Server Forms Integration subsystem are as follows:

◗ The source form (form created in Gentran:Server) should be named 
using the file extension .STP (e.g., PETEINVS.STP).

◗ The compiled translation object (translation object that is the result of 
compiling the source form) should be named using the same file 
name that was allocated to the source form, but with the file extension 
.TPL (e.g., PETEINVS.TPL).

25  Click Save to save the form.

 (Contd)
Step Action
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Activating Groups, Segments, Composites, and Elements

Overview When Gentran:Server generates the form, it includes all groups, segments, composites, 
and elements that are defined by the standard agency (EDIFACT) for the version (92.1) of 
the message (INVOIC) you selected. The system activates all the groups, segments, 
composites, and elements that are defined as mandatory (must be present) by the standard. 
The system does not enable you to deactivate the mandatory groups, segments, and 
elements.

Example In the example below, the INVOIC file icon, BGM and DTM segments, C507 composite, 
and DTM01 element are mandatory for the invoice. You do not need to activate these 
components. The DTM02 and DTM03 elements are not mandatory, so they are dimmed 
on the form.

To view the segments, composites, and elements in a group, segment, or composite on 
your form, double-click the form component in the EDI File Format Window (left side of 
the Forms main window). To activate an inactive form component, click Activate on the 
Main Toolbar, then click the form component. The component is no longer dimmed.

When translating data, the system does not process groups, segments, composites, and 
elements that are not activated. You must activate the groups, segments, composites, and 
elements that are not defined as mandatory by the standard, but that you have determined 
that you need to use in the form.

Groups, segments,
composites,

elements used in
this tutorial

This table lists the groups, segments, composites, and elements to be used in this tutorial.

Group Group Segment Composite Element

BGM 
(already 
activated)

BGM05

DTM 
(already 
activated)

C507 (already activated) DTM02

(Continued on next page)
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RFF RFF C506

(mandatory for RFF)

RFF02

DTM:2 C507

(mandatory for DTM:2)

DTM:202

NAD NAD C080

C059 NAD17

NAD19

NAD20

NAD21

PAT PAT

LIN LIN LIN01

PIA C212

(mandatory for PIA)

PIA02

PIA03

IMD:2 IMD:201

C273 IMD:206

MEA:2 C502 MEA:202

QTY:2

DTM:11 C507

(mandatory for DTM:11)

DTM:1102

MOA MOA:5 C516

(mandatory for MOA:5)

MOA:502

TDT TDT:2 C228 TDT:205

C040 TDT:207

CNT

MOA 
(already 
activated)

MOA:10 C516

(mandatory for MOA:10)

MOA:1002

 (Contd)
Group Group Segment Composite Element
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Procedure Use this procedure to activate groups, segments, composites, and elements.

CAUTION
YOU MUST ACTIVATE ALL REQUIRED GROUPS, SEGMENTS, 
COMPOSITES, AND ELEMENTS LISTED ON THE FOLLOWING 
TABLE. FAILURE TO DO SO WILL HINDER YOUR ABILITY TO 
PERFORM STEPS LATER IN THIS TUTORIAL.

Step Action

1 Double-click the groups, segments, and composites listed in the previous 
table to open them. Opening all the necessary groups, segments, and 
composites before you start to activate enables you to scroll down the 
form and activate the segments, composites, and elements sequentially. 

Note
When you activate a conditional group, segment, or composite, the 
mandatory subordinate segments, composites, and elements are activated 
automatically.

2 Click Activate on the Main Toolbar.

3 Click each inactive group that you need to use. This activates the groups.

Note
If you click a group, segment, element, or composite that you did not 
mean to activate, click the group with the right mouse button to access the 
shortcut menu. Select Deactivate from the shortcut menu.

4 Click each inactive segment that you need to use. This activates the 
segments.

5 Click each inactive composite that you need to use. This activates the 
composites.

6 Click each inactive element that you need to use. This activates the 
elements. 

Note
When you activate an element in a screen entry form, either the tag Edit 
Box or the tag Drop Down is displayed before that element’s description. 
Edit Box indicates that the element is formatted as a field. Drop Down 
indicates that the element is formatted as a list because you applied a 
standard rule that allows a selection of multiple items.

7 Click Activate on the Main Toolbar to turn activation mode off.

Note
To hide the groups, segments, and elements that you are not using, select 
Show Active Only from the View menu. 

8 From the File menu, select Save to save your form.
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Adding Frame Help Text

Overview You need to add frame Help text so that your end users can access online Help for the 
Invoice Details frame.

Procedure Use this procedure to add frame Help text.

Step Action

1 Click the INVOIC file icon (at the top of your form) with the right mouse 
button and select Properties from the shortcut menu.

System Response
The system displays the File Format Properties dialog.

2 Click the Display tab.

3 In the Frame Help Text box, enter the following text (press Enter at the 
end of each line of text below): 

This frame contains header information
pertaining to the entire invoice message
(INVOIC). For online Help on an individual
field on this frame, select the field and
press F1.

Note
Pressing Enter creates line breaks for the online Help that the screen entry 
translation object users in Gentran:Server view when they press F1. If you 
do not create line breaks, the online Help will be displayed on one line of 
text in the online Help pop-up window, and text that extends beyond the 
width of the user’s monitor will not be displayed.

When you generate the form (display the fields in the Layout Window), 
there is one frame in the Layout Window (right side of Forms main 
window) for every group and repeating segment in the EDI File Format 
Window (left side of Forms main window). Entering frame Help text for 
the group or segment corresponding to each frame enables screen entry 
translation object users to access context-sensitive Help text for the frame.

4 Click OK to save your changes and to exit the dialog. 
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Setting EDI Delimiters

Overview You are using an EDI standard that contains composite elements or subelements, so you 
must define the EDI delimiters. Delimiters are flags that separate specific EDI 
components. Delimiters are necessary for all variable field-length standards, because the 
data is compressed and the leading zeroes and trailing blanks are removed. The fields vary 
in length so the system needs a flag to determine where one element ends and another 
begins. For example, an element delimiter marks the beginning of a new element.

EDI delimiters
table

This table lists the valid EDI delimiters.

Procedure Use this procedure to set EDI delimiters.

Field
EDIFACT Default 

Character
EDIFACT Default Hex 

Value

Tag Delimiter + (plus sign)

Segment Delimiter ‘ (apostrophe) 0x27

Element Delimiter + (plus sign) 0x2B

Sub Element Delimiter : (colon) 0x3A

Decimal Separator . (period) 0x2E

Release Character ? (question mark) 0x3F

Step Action

1 Click the INVOIC file icon with the right mouse button and select 
Properties from the shortcut menu.

System Response
The system displays the File Format Properties dialog.

2 Select the Delimiters tab to access the Delimeters dialog. 

(Continued on next page)
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3 Verify that the correct delimiters are being used for the EDIFACT 92.1 
standard. If the delimiters differ from the default values listed in the 
previous table, you can enter either the character or the hexadecimal 
value.

Note
If you use the default hex value, the value must begin with “0x” (the 
number zero and the letter “x”).

Note
The Stream segments check box on the Delimiters dialog currently is not 
selected. For this tutorial, leave it cleared so that the translator will 
continue to insert a carriage return after every segment.

4 Click OK to save the delimiters and exit the Delimiters dialog.

 (Contd)
Step Action
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Modify Form Components 0

Promoting, Splitting, and Changing Segments and Groups

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment. 
Promote is a specialized function that preserves the integrity of the EDI structure.

The Split function enables you to split (break) a group or repeating segment into two 
loops. This function is useful when you need more than one instance of the same form 
component that occurs multiple times. When you split a group, the Promote flag is not set. 
If you want the split group to be displayed on the parent frame, you must set the Promote 
flag after you split the group.

A segment or group with a maximum use greater than one repeats (loops) and is placed on 
a separate frame than the segment or group to which it is subordinate. A segment or group 
with a maximum use of one does not repeat and its fields are displayed on the same frame 
as the group or segment to which they are subordinate.

You must promote, split, and change the maximum use of the groups and segments before 
you generate the form (display the fields in the Layout Window). By customizing the 
group and segment properties first, all fields are placed on their appropriate frames the 
first time you generate the form. If you promote, split, and change the maximum use of the 
groups and segments after you generate the form, the fields will be placed on several more 
frames than will be present ultimately in the form. Changing the group and segment 
properties before you first generate the form enables the fields to be placed on as few 
frames as necessary.
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Modifying the DTM Segment

Overview This section describes how to:

◗ change the maximum use of the DTM segment
◗ change the maximum use of the DTM:2 segment

How to change the
maximum use of

the DTM segment

The DTM segment contains the Date/Time Reference Numbers for the invoice. The DTM 
segment is used for the invoice date associated with the invoice number (in the BGM 
segment). The standard allows the DTM segment to be used up to 35 times in one invoice. 
You will use the DTM segment only once (for the invoice date). You will change the 
maximum use of the DTM segment to one, which will place the associated fields on the 
main Invoice Message frame with the majority of the invoice fields.

Use this procedure to change the maximum use of the DTM segment.

Step Action

1 Click the DTM segment with the right mouse button to access the shortcut 
menu.

2 Select Properties from the shortcut menu.

System Response
The system displays the Segment Properties dialog.

3 Select the Looping tab.
(Continued on next page)
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How to change the
maximum use of

the DTM:2
segment

The DTM:2 segment (in the RFF group) contains the Date/Time Reference information 
for the reference. In this tutorial, the DTM:2 segment is used for the purchase order date 
associated with the purchase order number (in the RFF segment). The standard allows the 
DTM:2 segment to be used up to five times each time the RFF group is used. You need use 
the DTM:2 segment once (for the purchase order date). You will change the maximum use 
of the DTM:2 segment to one, which will place the associated fields on the main Invoice 
Message frame with the majority of the invoice fields.

Use this procedure to change the maximum use of the DTM:2 segment.

4 In the Max Usage box, enter 1 to designate that this segment can be used 
only once per invoice.

5 Click OK to exit the Segment Properties dialog.

 (Contd)
Step Action

Step Action

1 Click the DTM:2 segment (in the RFF group) with the right mouse button 
and select Properties from the shortcut menu.

System Response
The system displays the Segment Properties dialog.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click Yes at the prompt.

5 Click OK to exit the Segment Properties dialog.
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Modifying the RFF Group

Overview This section describes how to:

◗ split the RFF group
◗ promote the RFF:2 group to the parent frame, and
◗ change the maximum use of the RFF group

How to split the
RFF group

The standard allows the RFF group (Reference) to be used up to 10 times in one invoice. If 
the invoice were generated now, the fields associated with the RFF group would be 
displayed on a separate frame than the majority of the invoice fields. You need two 
iterations of the RFF group, each with a maximum use of one. You will enter the purchase 
order number and date in the first RFF group and the contract number and date in the 
second RFF group.

You need to split the RFF group to obtain a second iteration of the RFF group (the new 
RFF group will be named RFF:2), then you need to change the maximum use of the 
original group (RFF).

Use this procedure to split the RFF group.

Step Action

1 Click the RFF group with the right mouse button and select Split from 
the shortcut menu. 

2 Click Yes at the prompt. 

System Response
The system displays the Split dialog.

3 In the First Loop Entries box, enter 1 to indicate that you want the RFF 
group to be split after the first iteration. The resulting split will generate 
one RFF group (RFF:2) that has a maximum use of one, and will retain 
the original RFF group (with a maximum use of nine).

4 Click OK to exit the Split dialog.
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How to promote
the RFF:2 group to

the parent frame

Use this procedure to promote the RFF:2 group to the parent frame.

Step Action

1 Click the RFF:2 group with the right mouse button and select Properties 
from the shortcut menu.

System Response
The system displays the Group Properties dialog.

2 Select the Display tab.

3 Select the Promote group to parent frame check box to display the 
fields in this group on the same frame as the fields in the parent group.

Note
Although this group has a maximum use of one, if you do not check the 
Promote group to parent frame check box, then the fields in this group are 
not displayed on the same frame in the Layout Window as the fields in the 
parent group.

4 Click OK to exit the Group Properties dialog.
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How to change the
maximum use of

the RFF group

Use this procedure to change the maximum use of the RFF group.

Step Action

1 Click the RFF group with the right mouse button and select Properties 
from the shortcut menu.

System Response
The system displays the Group Properties dialog.

2 Select the Looping tab.

3 In the Max Usage box, enter 1 to designate that this group can be used 
only once per invoice.

4 Select the Display tab.

5 Select the Promote group to parent frame check box to display the 
fields in this group on the same frame as the fields in the parent group.

Note
If you change the maximum usage of this group, but do not select the 
Promote group to parent frame check box, then the fields in this group will 
not be displayed on the same frame in the Layout Window as the fields in 
the parent group.

6 Click OK to exit the Group Properties dialog.
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Modifying the NAD Group

Overview This section describes how to:

◗ copy and change the maximum use of the NAD group
◗ copy and paste the NAD group

How to copy and
change the

maximum use of
the NAD group

The standard allows the NAD group (Name and Address) to be used up to 20 times in one 
invoice. If the invoice were generated now, the fields associated with the NAD group 
would be displayed on a separate frame than the majority of the invoice fields. You know 
that your users complete the fields in this iteration of the NAD group only once per 
invoice. You need to change the maximum use of the NAD group to one, which moves the 
Name and Address fields to the parent frame (the main Invoice Message frame).

After you change the maximum use of the NAD group, you need to copy the NAD group 
and paste the copy at the same level as the original group to create a second iteration of the 
NAD group. Users will enter the Ship To name and address in the first iteration of the 
NAD group, and they will enter the Remit To name and address in the second iteration of 
the NAD group (NAD:2).

Use this procedure to change the maximum use of the NAD group

Step Action

1 Click the NAD group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box to display the 
fields in this group on the same frame as the fields in the parent group.

6 Click OK to exit the Group Properties dialog.
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How to copy and
paste the NAD

group

Use this procedure to copy and paste the NAD group.

Step Action

1 Verify that the NAD group is selected.

2 Click Copy on the Main Toolbar.

3 Click Paste on the Main Toolbar to paste the NAD group after the existing 
NAD group. 

System Response
Gentran:Server prompts you to specify whether you want the contents of 
the clipboard pasted as a child (subordinate) of the selected group, or at 
the same level as the group.

4 Click the Paste after selected item (at the same level) option to paste the 
Clipboard contents after the original NAD group. The pasted NAD group 
is named NAD:2.

5 Click OK to exit the dialog.
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Modifying the PAT Group

Overview This section describes how to change the maximum use of the PAT group.

How to change the
maximum use of

the PAT group

The standard allows the PAT group (Payment Terms) to be used up to 10 times in one 
invoice. If the invoice were generated now, the fields associated with the PAT group would 
be displayed on a separate frame than the majority of the invoice fields. For this tutorial, 
you know that your users complete the fields in the PAT group only once per invoice. You 
need to change the maximum use of the PAT group to one, which moves the Payment 
Terms fields to the main Invoice Message frame.

Use this procedure to change the maximum use of the PAT group.

Step Action

1 Click the PAT group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box.

6 Click OK to exit the dialog. 
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Modifying the LIN Group

Overview This section describes how to:

◗ change the maximum use of the PIA segment
◗ change the maximum use of the IMD:2 segment
◗ change the maximum use of the MEA:2 segment
◗ change the maximum use of the QTY:2 segment
◗ change the maximum use of the DTM:11 segment
◗ change the maximum use of the MOA group 
◗ change the maximum use of the TDT group

How to change the
maximum use of
the PIA segment

The PIA segment (in the LIN group) contains the Additional Product ID for each line 
item. The standard allows the PIA segment to be used up to 25 times per line item. Your 
users use the PIA segment only once per line item (for the product code). You need to 
change the maximum use of the PIA segment to one, which places the associated fields on 
the frame containing other line item fields.

Use this procedure to change the maximum use of the PIA segment.

Step Action

1 Click the PIA segment (in the LIN group) with the right mouse and select 
Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

(Continued on next page)
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How to change the
maximum use of

the IMD:2 segment

The IMD:2 segment (in the LIN group) contains the Item Description for each line item. 
The standard allows the IMD:2 segment to be used up to 10 times per line item. Your users 
use the IMD:2 segment only once per line item (for the free-form description). You need 
to change the maximum use of the IMD:2 segment to one, which places the associated 
fields on the frame containing other line item fields.

Use this procedure to change the maximum use of the IMD:2 segment.

How to change the
maximum use of

the MEA:2
segment

The MEA:2 segment (in the LIN group) contains the Measurements for each line item. 
The standard allows the MEA:2 segment to be used up to five times per line item. Your 
users use the MEA:2 segment only once per line item (for the unit of measure). You need 
to change the maximum use of the MEA:2 segment to one, which places the associated 
fields on the frame containing other line item fields.

Use this procedure to change the maximum use of the MEA:2 segment.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

 (Contd)
Step Action

Step Action

1 Click the IMD:2 segment (in the LIN group) with the right mouse button 
and select Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

Step Action

1 Click the MEA:2 segment (in the LIN group) with the right mouse button 
and select Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab.
(Continued on next page)
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How to change the
maximum use of

the QTY:2 segment

The QTY:2 segment (in the LIN group) contains the Quantity for each line item. The 
standard allows the QTY:2 segment to be used up to five times per line item. Your users 
use the QTY:2 segment only once per line item (for the invoiced quantity). You need to 
change the maximum use of the QTY:2 segment to one, which places the associated fields 
on the frame containing other line item fields.

Use this procedure to change the maximum use of the QTY:2 segment. 

How to change the
maximum use of

the DTM:11
segment

The DTM:11 segment (in the LIN group) contains the Date/Time/Period for each line 
item. The standard allows the DTM:11 segment to be used up to 35 times per line item. 
Your users use the DTM:11 segment only once per line item (for the date shipped). You 
need to change the maximum use of the DTM:11 segment to one, which places the 
associated fields on the frame containing other line item fields.

Use this procedure to change the maximum use of the DTM:11 segment.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

 (Contd)
Step Action

Step Action

1 Click the QTY:2 segment (in the LIN group) with the right mouse button 
and select Properties from the shortcut menu. 

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

Step Action

1 Click the DTM:11 segment (in the LIN group) with the right mouse 
button and select Properties from the shortcut menu.

System Response
The Segment Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.
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How to change the
maximum use of

the MOA group in
the LIN group

The standard allows the MOA group (Monetary Amount) in the LIN group to be used up 
to five times per line item. If the invoice were generated now, the fields associated with 
the MOA group would be displayed on a separate frame than the majority of the line item 
fields. For this tutorial, you know that your users will complete the fields in the MOA 
group only once per line item. You will change the maximum use of the MOA group to 
one, which will place the Monetary Amount fields on the frame containing other line item 
fields.

Use this procedure to change the maximum use of the MOA group.

How to change the
maximum use of

the TDT group

The standard allows the TDT group (Details of Transport) in the LIN group to be used up 
to five times per line item. If the invoice were generated now, the fields associated with 
the TDT group would be displayed on a separate frame than the majority of the line item 
fields. For this tutorial, you know that your users will complete the fields in the TDT 
group only once per line item. You will change the maximum use of the TDT group to 
one, which will place the Details of Transport fields on the frame containing other line 
item fields.

Use this procedure to change the maximum use of the TDT group.

Step Action

1 Click the MOA group (in the LIN group) with the right mouse button and 
select Properties from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box.

6 Click OK to exit the Group Properties dialog.

Step Action

1 Click the TDT group (in the LIN group) with the right mouse button and 
select Properties from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.
(Continued on next page)
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How to change the
maximum use of

the CNT segment

The CNT segment contains the Control Totals for each line item. The standard allows the 
CNT segment to be used up to 10 times per line item. Your users use the CNT segment 
only once per line item (for the total number of line items). You need to change the 
maximum use of the CNT segment to one, which moves the Control Total fields to the 
main Invoice Message frame.

Use this procedure to change the maximum use of the CNT segment.

How to change the
maximum use of
the MOA group

The standard allows the MOA group (Monetary Amount), in the summary section, to be 
used up to one hundred times per invoice. If the invoice were generated now, the fields 
associated with the MOA group would be displayed on a separate frame than many of the 
invoice fields.You know that your users complete the fields in the MOA group only once 
per invoice. You need to change the maximum use of the MOA group to one, which places 
the Monetary Amount fields on the main Invoice Message frame.

Use this procedure to change the maximum use of the MOA group.

4 Select the Display tab.

5 Select the Promote group to parent frame check box. 

6 Click OK to exit the Group Properties dialog.

 (Contd)
Step Action

Step Action

1 Click the CNT segment with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The system displays the Segment Properties dialog.

2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Click OK to exit the Segment Properties dialog.

Step Action

1 Click the MOA group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

(Continued on next page)
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2 Select the Looping tab.

3 In the Max Usage box, enter 1.

4 Select the Display tab.

5 Select the Promote group to parent frame check box.

6 Click OK to exit the Group Properties dialog.

 (Contd)
Step Action
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Generating the Form

Overview Generating a form is different from compiling a form. When you generate a form, the 
fields of the form are displayed on a frame in the Layout Window (right side of the Forms 
main window) based on the groups, segments, and elements that are activated. When you 
compile a form, the source form is translated into a compiled translation object. 

Note
You should regenerate your form several times to ensure that you are viewing the most 
recent changes to the Layout Window.

Procedure Use this procedure to generate the screen entry form based on the groups, segments, and 
elements you activated.

Step Action

1 Select the INVOIC file icon. Selecting the INVOIC file icon before you 
generate the layout enables you to view the beginning of the invoice 
layout in the Layout Window after the layout is generated. This is not a 
required prerequisite to generating the layout.

2 Click Generate Layout on the Main Toolbar.

System Response
The screen entry form layout is displayed in the Layout Window.
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After generating
the form

When you generate the form, there is one field on the right side of your screen (Layout 
Window) for every activated element on the left side of your screen (EDI File Format 
Window). 

Note
As you customize the form, you will change some of the labels and remove others so all 
the fields will not be labeled the same as their corresponding elements. Even though you 
will change or remove some field labels, each field still corresponds to one element.

When the screen entry form is generated, the fields associated with each non-repeating 
segment or group are displayed on a frame in the Layout Window. If a segment or group is 
defined as repeating, a list is displayed on the parent frame, and the fields for that 
repeating segment or group are displayed on a separate frame.

All frames in a screen entry form are titled. The default title for each frame is its message, 
group, or segment name, but you can change the default titles to better identify the 
information that will be entered.
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Customize the EDI Data 0

Overview

Introduction You can customize the form, including the properties of each type of form component 
(group, segment, and element).

Customizing the form is an iterative process. This tutorial guides you through all the steps 
involved in customizing the form, component by component. When you create forms, you 
usually activate the form components you need to use, customize and format the form 
components, then compile the form and test the translation object (and print a report, if 
necessary). As you substantially customize the form, you usually compile the form and 
test the translation object several times to view your changes before the form truly is 
finalized.

This section explains how to customize the form components for each sequential 
component in this tutorial.

How to set up the
document name

We recommend that you set up a Document Name for each form. The document name 
makes the identification of a document created by the form easier in Gentran:Server. 
Setting up the document name enables you to differentiate between documents in the 
document browsers in Gentran:Server. We strongly recommend that you select an element 
that occurs only once in the message and has a data type of string. For an EDIFACT 92.1 
invoice, the document name is usually the Document/Message Number.

(Continued on next page)
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Use this procedure to set up the document name.

Step Action

1 Double-click the BGM05 element.

Recommendation
We recommend that you select this element because it is a non-recurring 
and mandatory element, and it will help identify this message 
meaningfully in Gentran:Server.

System Response
The Element Properties dialog is displayed.

2 Select Standard Rule tab.

3 Select Update from the list.

4 Click Yes at the prompt. 

5 From the Table (or group) to update list, select Document Record to 
indicate that you are updating the document record in Gentran:Server.

(Continued on next page)
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6 From the Field list, select Document Name to indicate that you are 
updating the Name field (in the Gentran:Server document browsers that 
contain this message) with the contents of the BGM05 element.

System Response
The dialog now should look like this:

7 Click OK to set up the document name.

 (Contd)
Step Action
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Customizing the BGM Segment

Overview The BGM segment contains the Beginning of Message for the invoice. This mandatory 
segment contains information that is pertinent to the entire invoice.

How to customize
the BGM05

element

The BGM05 element contains the Document/Message Number. This element is defined 
by the standard to be a string of 35 alphanumeric characters. You know that the invoice 
number your users enter is always an eight-character alphanumeric string so you need to 
change the element and field lengths to accommodate the shorter invoice number. You 
also need to rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add 
Help text to the Document/Message Number field.

Step Action

1 Double-click the BGM05 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 for the maximum number of characters allowed 
for this element.

(Continued on next page)
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4 Select the Display tab.

System Response
The system displays the Display Properties dialog box.

5 In the Label box, enter Invoice No. to replace the existing text.

6 In the Maximum number of characters to be printed box, enter 8 to allow 
eight characters to be entered in this field.

7 Select the Help tab.

8 In the Help Text box, enter the following text: 

Enter the invoice number. The invoice number cannot
exceed 8 alphanumeric characters.

9 Click OK to exit the dialog.

 (Contd)
Step Action
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Customizing the DTM Segment

Overview The DTM segment (Date/Time/Period) is used to enter the invoice date. The standard 
allows the DTM segment to be used up to 35 times per invoice. You will use the DTM 
segment only once per invoice. You have already changed the maximum use of the DTM 
segment to obtain just one instance of the DTM segment and to place the invoice date on 
the same frame as the invoice number.

How to customize
the DTM01

element

The DTM01 element contains the Date/Time/Period Qualifier, a mandatory three-
character code that qualifies the date that follows (in the DTM02 element). You know that 
the only type of date your users enter in the Date/Time/Period element (DTM02) is an 
invoice number so you need to define a constant value for the Date/Time/Period Qualifier 
field, designating that the constant 3 (Invoice Date/Time) always qualifies the date in the 
Date/Time/Period field. You need to hide the qualifier field because it does not need to be 
displayed in the translation object.

When a user enters the invoice date in the Date/Time/Period field, the system 
automatically assigns the code 3 to the Date/Time/Period Qualifier field.

Use this procedure to define a constant value in the Date/Time/Period Qualifier field and 
hide the field.

Step Action

1 Double-click the DTM01 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Invoice Date/Time to identify the constant.

7 From the Type list, select String to indicate that the literal constant will be 
formatted as a string data type.

(Continued on next page)
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8 In the Value box, enter 3 to indicate that the Date/Time/Period Qualifier 
field must contain the invoice date. This value is the actual value of the 
literal constant.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select 3 to identify the constant that will be used 
for this element.

12 From the Qualifies list, select 2380 DATE/TIME/PERIOD, which is the 
element that the Date/Time/Period Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Click the This field should not appear on the form option to prevent the 
field from being displayed in the translation object.

15 Click OK to exit the Display Properties dialog.

 (Contd)
Step Action
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How to customize
the DTM02

element

The DTM02 element (Date/Time/Period) contains the invoice date. The standard allows 
this field to contain up to a 35 character string but your users enter shorter dates. You need 
to change the element and field lengths to accommodate the shorter dates and then rename 
the field label.

Use this procedure to change the element and field lengths, rename the field label, and add 
Help text to the Date/Time/Period field.

Step Action

1 Double-click the DTM02 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 Select the Display tab.

5 In the Label box, enter Invoice Date.

6 In the Maximum number of characters to be printed box, enter 8.

7 Select the Help tab.

8 In the Help Text box, enter the following text: 

Enter the invoice date. Use the format MM/DD/YY.

9 Click OK to exit the dialog.
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Customizing the RFF:2 Group

Overview The RFF:2 group (Reference) is used to enter the purchase order number (RFF:11 
segment) and date (DTM:22 segment). You have already promoted the RFF:2 group to 
place the purchase order number and date on the main Invoice Message frame.
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Customizing the RFF:11 Segment Creating a Screen Entry Form3 - 58
Customizing the RFF:11 Segment

Overview The RFF:11 segment (Reference) is used to enter the purchase order number. Your users 
enter the purchase order number in the Reference Number element (RFF:1102). You need 
to set a constant in the Reference Qualifier element so that the constant value is entered 
automatically when a user enters the purchase order number.

How to customize
the RFF:1101

element

The RFF:1101 element contains the Reference Qualifier, a mandatory three-character 
code that identifies the type of reference that follows (in the RFF:1102 element). You 
know that the only type of reference your users enter in the Reference Number element is 
the purchase order number so you need to define a constant value for the Reference 
Qualifier field, designating that the constant “ON” (Order Number (Purchase)) always 
qualifies the reference in the Reference Number field. You must also hide the qualifier 
field because it does not need to be displayed in the translation object.

When a user enters the purchase order number in the Reference Number field, the system 
automatically assigns the code ON to the Reference Qualifier field.

Use this procedure to define a constant value in the first Reference Qualifier field and hide 
the field.

Step Action

1 Double-click the RFF:1101 element (in the RFF:2 group). 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Order Number to identify the constant.

7 From the Type list, select String.

8 In the Value box, enter ON.
(Continued on next page)
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9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select ON.

12 From the Qualifies list, select 1154 REFERENCE NUMBER, which is 
the element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Click the This field should not appear on the form option to prevent the 
field from being displayed in the translation object.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the RFF:1102

element

The RFF:1102 element contains the Reference Number. This element is defined by the 
standard to be a string of 35 alphanumeric characters. You know that the reference number 
(the purchase order number) is a 10-character alphanumeric string, so you need to change 
the element and field lengths to accommodate the shorter reference number. In addition, 
you must rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add 
Help text to the first Reference Number field.

Step Action

1 Double-click the RFF:1102 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10.

4 Select the Display tab.

5 In the Label box, enter P.O. No. (note the period included in the label) to 
replace the existing field label.

6 In the Maximum number of characters to be printed box, enter 10.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the purchase order number. The purchase order
number cannot exceed 10 alphanumeric characters.

9 Click OK to exit the s dialog.
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Customizing the DTM:22 Segment

Overview The DTM:22 segment (Date/Time/Period) is used to enter the purchase order date. The 
standard allows the DTM:22 segment to be used up to five times per invoice. You use the 
DTM:22 segment only once per invoice. You have already changed the maximum use of 
the DTM:22 segment to obtain just one instance of the segment and to place the purchase 
order date on the same frame as the invoice date and number.

How to customize
the DTM:2201

element

The DTM:2201 element contains the Date/Time/Period Qualifier, a mandatory three-
character code that identifies the type of date that follows. The only type of date your users 
enter in the Date/Time/Period element (DTM:2202) that follows is the purchase order date 
so you need to define a constant value for the Date/Time/Period Qualifier field, 
designating that the constant 4 (Order Date/Time) always qualifies the date in the Date/
Time/Period field. Then you need to hide the qualifier field because it does not need to be 
displayed in the translation object.

When a user enters the purchase order date in the Date/Time/Period field, the system 
automatically assigns the code 4 to the Date/Time/Period Qualifier field.

Use this procedure to define a constant value in the first Date/Time/Period Qualifier field 
and hide the field.

Step Action

1 Double-click the DTM:2201 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Order Date/Time to identify the constant.

7 From the Type list, select String.

(Continued on next page)
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How to customize
the DTM:2202

element

The DTM:2202 element (Date/Time/Period) contains the purchase order date. The 
standard allows this field to contain up to a 35 character string but your users enter shorter 
dates. You need to change the element and field lengths to accommodate the shorter dates, 
rename the field label and add Help text.

Use this procedure to change the element and field lengths, rename the field label, and add 
Help text to the first Date/Time/Period field.

8 In the Value box, enter 4 to indicate that the Date/Time/Period Qualifier 
field must contain the purchase order date.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select 4 to identify the constant that will be used 
for this element.

12 From the Qualifies list, select 2380 DATE/TIME/PERIOD, which is the 
element that the Date/Time/Period Qualifier field qualifies.

13 Select the Display tab. 

14 Click the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action

Step Action

1 Double-click the DTM:2202 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8.

4 Select the DIsplay tab.

5 In the Label box, enter P.O. Date.

6 In the Maximum number of characters to be printed box, enter 8.

7 Select the Help tab.
(Continued on next page)
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8 In the Help Text box, enter the following text:

Enter the purchase order date. Use the format MM/DD/YY.

9 Click OK to exit the dialog.

Step Action
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Customizing the RFF Group

Overview The RFF group (Reference) is used to enter the contract number (RFF segment) and date 
(DTM:2 segment).
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Customizing the RFF Segment

Overview The RFF segment (Reference) is used to enter the contract number. Your users enter the 
contract number in the Reference Number element, and you will set a constant in the 
Reference Qualifier element so that the constant value is entered automatically when the 
users enter the contract number.

How to customize
the RFF01 element

The RFF01 element contains the Reference Qualifier, a mandatory three-character code 
that identifies the type of reference that follows. You know that the only type of reference 
your users enter in the Reference Number element (RFF02) is the contract number, so you 
need to define a constant value for the Reference Qualifier field, designating that the 
constant CT (Contract Number) always qualifies the reference in the Reference Number 
field. You need to hide the qualifier field because it does not need to be displayed in the 
translation object.

When a user enters the contract number in the Reference Number field, the system 
automatically assigns the code CT to the Reference Qualifier field.

Use this procedure to define a constant value in the second Reference Qualifier field and 
hide the field.

Step Action

1 Double-click the RFF01 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Contract Number to identify the constant.

7 From the Type list, select String.

8 In the Value box, enter CT to indicate that the Reference Qualifier field 
must contain the contract number.

(Continued on next page)
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Customizing the RFF Segment Creating a Screen Entry Form3 - 66
9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select CT to identify the constant that will be 
used for this element.

12 From the Qualifies list, select 1154 REFERENCE NUMBER, which is 
the element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the RFF02 element

The RFF02 element contains the Reference Number. This element is defined by the 
standard to be a string of 35 alphanumeric characters. You know that the reference number 
(the contract number) is always an eight-character alphanumeric string, so you need to 
change the element and field lengths to accommodate the shorter reference number. You 
need to rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add 
Help text to the second Reference Number field.

Step Action

1 Double-click the RFF02 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8.

4 Select the Display tab.

5 In the Label box, enter Contract No. (note the period included in the 
label) to replace the existing field label.

6 In the Maximum number of characters to be printed box, enter 8.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the contract number. The contract number cannot 
exceed 8 alphanumeric characters.

9 Click OK to exit the dialog.
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Customizing the DTM:2 Segment

Overview The DTM:2 segment (Date/Time/Period) is used to enter the contract date. The standard 
allows the DTM:2 segment to be used up to five times per invoice. You use this segment 
only once per invoice. You have already changed the maximum use of the DTM:2 
segment to obtain just one instance of this segment, and to place the contract date on the 
same frame as the invoice date and number.

How to customize
the DTM:201

element

The DTM:201 element contains the Date/Time/Period Qualifier, a mandatory three-
character code that identifies the type of date that follows. You know that the only type of 
date your users enter in the Date/Time/Period element (DTM:202) is the contract date so 
you need to define a constant value for the Date/Time/Period Qualifier field, designating 
that the constant “92” (Contract Effective Date) always qualifies the date in the Date/
Time/Period field. Then, you need to hide the qualifier field because it does not need to be 
displayed in the translation object.

When a user enters the contract date in the Date/Time/Period field, the system 
automatically assigns the code 92 to the Date/Time/Period Qualifier field.

Use this procedure to define a constant value in the second Date/Time/Period Qualifier 
field and hide the field.

Step Action

1 Double-click the DTM:201 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Contract Effective Date.

7 From the Type option, select String.
(Continued on next page)
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8 In the Value box, enter 92 to indicate that the Date/Time/Period Qualifier 
field must contain the contract date.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants option, select 92 to identify the constant that is used 
for this element.

12 From the Qualifies option, select 2380 DATE/TIME/PERIOD, which is 
the element that the Date/Time/Period Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the DTM:202

element

The DTM:202 element (Date/Time/Period) contains the contract date. The standard allows 
this field to contain up to a 35 character string but your users enter shorter dates. You need 
to change the element and field lengths to accommodate the shorter dates. In addition, you 
need to rename the field label and add Help text.

Use this procedure to change the element and field lengths, rename the field label, and add 
Help text to the second Date/Time/Period field.

Step Action

1 Double-click the DTM:202 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8.

4 Select the Display tab.

5 In the Label box, enter Contract Date

6 In the Maximum number of characters to be printed box, enter 8.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the contract date. Use the format MM/DD/YY.

9 Click OK to exit the dialog.
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Customizing the NAD Group

Overview You have already changed the maximum use and promoted the NAD group, then copied 
the NAD group to create a second iteration of this group (NAD:2). Your users enter the 
ship to name and address in the first iteration of the NAD group, and the remit to name and 
address in the second iteration of the group (NAD:2). By promoting the NAD group to the 
parent frame before copying the group, you cause all the Ship To and Remit To fields to be 
placed on the main Invoice Message frame.
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Customizing the NAD Segment

Overview The NAD segment (in the NAD group) identifies the Name and Address of an entity or 
individual. In this iteration of the NAD segment, users enter the Ship To name and address 
for the invoice. 

How to customize
the NAD01

element

The NAD01 element (in the NAD segment) contains the Party Qualifier, which is used to 
identify whether the name and address information that follows pertains to the Ship To or 
Remit To name. Your users enter only the Ship To name and address in the segment 
associated with the first NAD group. You need to define the constant value “ST” in the 
Party Qualifier element, indicating that this group (NAD) contains only Ship To 
information. You need to hide the Party Qualifier field because it does not need to be 
displayed on the translation object.

Use this procedure to define a constant value for the Party Qualifier field and hide the 
field.

Step Action

1 Double-click the NAD01 element (in the NAD group). 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Ship To to identify the constant.

7 From the Type option, select String.

8 In the Value box, enter ST to indicate that the Entity Identifier Code field 
must contain the Ship To name and address.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

(Continued on next page)
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How to customize
the NAD10

element

The NAD10 element (Party Name) contains the name of the entity or individual to whom 
the order will be shipped. Your users are familiar with the standard address format (the 
name on the first line; the address on the next line(s); the city, state (or province or 
country), and postal code on the last line). For this reason, you do not need to label the 
fields containing the address, city, state, and postal code. You need to rename the field 
label (so that your users know that the fields that follow contain the Ship To information) 
and add Help text to the field.

(Continued on next page)

11 From the Constants option, select ST.

12 From the Qualifies option, select 3036 PARTY NAME, which is the 
element that the Entity Identifier Code field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the dialog.

 (Contd)
Step Action
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Use this procedure to rename the field label and add Help text to the first Party Name 
field.

How to customize
the NAD16

element

The address information in the NAD16 element (in the NAD segment) corresponds to the 
name in the NAD10 element so there is no need to display the label associated with the 
address. For the NAD16 element, you need to remove the field label and add Help text.

Use this procedure to remove the field label and add Help text to the first Street and 
Number/P.O. Box field of the Ship To address.

Step Action

1 Double-click the NAD10 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, enter Ship To to replace the existing field label. This 
label is the heading for the Ship To name and address information.

4 Select the Help tab.

5 In the Help text box, enter the following text:

Enter the name of the person or organization to whom the
order will be shipped. The name cannot exceed 35
alphanumeric characters.

6 Click OK to exit the dialog.

Step Action

1 Double-click the NAD16 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing text.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Enter the first line of the address. This address line cannot exceed 35 
alphanumeric characters.

6 Click OK to exit the dialog.
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How to customize
the NAD17

element

Use this procedure to remove the field label and add Help text to the second Street and 
Number/P.O. Box field of the Ship To address.

How to customize
the NAD19

element

The NAD19 element contains the City Name of the Ship To address. You will remove the 
field label for this element, because it will be evident to your users that they should enter 
the city name associated with the name and street address they have entered already. Also, 
you will change the element and field lengths, because the City Name field does not need 
to be longer than thirty characters.

Use this procedure to remove the field label, change the element and field lengths, and add 
Help text to the City Name field of the Ship To address.

Step Action

1 Double-click the NAD17 element (in the NAD group). 

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing text.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Enter the second line of the address. This address line cannot exceed 
35 alphanumeric characters.

6 Click OK to exit the dialog.

Step Action

1 Double-click the NAD19 element (in the NAD group). 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 30 for the maximum number of characters allowed 
for this element.

4 Select the Display tab.

5 In the Label box, delete the existing text.

6 In the Maximum number of characters to be printed box, enter 30.

7 Select the Help tab.
(Continued on next page)
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How to customize
the NAD20

element

The NAD20 element contains the Country Sub-Entity Identification. You need to remove 
the field label for this element, because it is evident to your users that they should enter the 
country sub-entity identification (e.g., state) associated with the name and street address 
they have entered already. Also, you need to change the field and element lengths because 
this field does not need to be longer than two characters.

Use this procedure to remove the field label, change the element and field lengths, and add 
Help text to the Country Sub-Entity Identification field of the Ship To address.

8 In the Help Text box, enter the following text:

Enter the city name. The city cannot exceed 30
alphanumeric characters.

9 Click OK to exit the dialog.

Step Action

Step Action

1 Double-click the NAD20 element (in the NAD group). 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 2.

4 Select the Display tab.

5 In the Label box, delete the existing text.

6 In the Maximum number of characters to be printed box, enter 2.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the country sub-entity identification. The code cannot exceed 2 
alphanumeric characters.

9 Click OK to exit the dialog.
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How to customize
the NAD21

element

Use this procedure to remove the field label and add Help text to the Postcode 
Identification field.

Step Action

1 Double-click the NAD21 element (in the NAD group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing text.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Enter the postal code. The postal code cannot exceed 9 alphanumeric 
characters. Do not enter a hyphen (-) before the 4-character postal 
code extension (if used).

6 Click OK to exit the dialog.
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Customizing the NAD:2 Group

Overview The NAD:2 group was created when you copied the NAD group to create a second 
iteration of that group. Your users enter the Remit To name and address in the NAD:2 
group.
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Customizing the NAD:3 Segment

Overview The NAD:3 segment (in the NAD:2 group) identifies the Name and Address of an entity 
or individual. In the NAD:3 segment, your users enter the Remit To name and address for 
the invoice. 

How to customize
the NAD:301

element

The NAD:301 element (in the NAD:2) group contains the Party Qualifier, which is used to 
identify whether the name and address information that follows pertains to the Ship To or 
Remit To name. Your users enter only the Remit To name and address in the fields 
associated with the NAD:2 group. You need to define the constant value “RE” in the Party 
Qualifier element, indicating that this group (NAD:2) contains only Remit To information. 
You need to hide the Party Qualifier field, because it does not need to be displayed on the 
translation object.

Use this procedure to define a constant value for the second Party Qualifier field and hide 
the field.

Step Action

1 Double-click the NAD:301 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list. 

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Remit To Party.

7 From the Type list, select String.

8 In the Value box, enter RE to indicate that the Entity Identifier Code field 
must contain the Remit To name and address.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

(Continued on next page)
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How to customize
the NAD:310

element

The NAD:310 element (Party Name) contains the name of the entity or individual to 
whom the invoice will be remitted. Your users are familiar with the standard address 
format (the name on the first line; the address on the next line(s); the city, state (or 
province or country), and postal code on the last line). For this reason, you do not need to 
label the fields containing the address, city, state, and postal code. You need to rename the 
field label (so that your users know that the fields that follow contain the remit to 
information) and add Help text to the field.

(Continued on next page)

11 From the Constants list, select RE.

12 From the Qualifies list, select 3036 PARTY NAME, which is the element 
that the Entity Identifier Code field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the dialog.

 (Contd)
Step Action
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Use this procedure to rename the field and add Help text to the second Party Name field.

How to customize
the NAD:316

element

The address information in the NAD:316 element (in the NAD:2 group) corresponds to 
the name in the NAD:310 element so there is no need to display the label associated with 
the address. For the NAD:316 element, you will remove the field label and add Help text.

Use this procedure to remove the field label and add Help text to the first Street and 
Number/P.O. Box field of the Remit To address.

Step Action

1 Double-click the NAD:310 element (in the NAD:2 group). 

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, enter Remit To to replace the existing text. This label is 
the heading for the Remit To name and address information.

4 Select the Help tab.

5 In the Help text box, enter the following text:

Enter the name of the person or organization to whom the invoice will 
be remitted. The name cannot exceed 35 alphanumeric characters.

6 Click OK to exit the dialog.

Step Action

1 Double-click the NAD:316 element (in the NAD:2 group). 

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing text.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Enter the first line of the address. This address line cannot exceed 35 
alphanumeric characters.

6 Click OK to exit the dialog.
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How to customize
the NAD:317

element

Use this procedure to remove the field label and add Help text to the second Street and 
Number/P.O. Box field of the Remit To address.

How to customize
the NAD:319

element

The NAD:319 element contains the City Name of the Remit To address. You need to 
remove the field label for this element, because it is evident to your users that they should 
enter the city name associated with the name and street address they have entered already. 
Also, you need to change the element and field lengths, because the City Name field does 
not need to be longer than 30 characters.

Use this procedure to remove the field label, change the element and field lengths, and add 
Help text to the City Name field of the Remit To address.

Step Action

1 Double-click the NAD:317 element (in the NAD:2 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing text.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Enter the second line of the address. This address line cannot exceed 
35 alphanumeric characters.

6 Click OK to exit the dialog.

Step Action

1 Double-click the NAD:319 element (in the NAD:2 group). 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 30.

4 Select the Display tab.

5 In the Label box, delete the existing text.

6 In the Maximum number of characters to be printed box, enter 30.

7 Select the Help tab.
(Continued on next page)
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How to customize
the NAD:320

element

The NAD:320 element contains the Country Sub-Entity Identification. You will remove 
the field label for this element, because it will be evident to your users that they should 
enter the country sub-entity identification (e.g., state, province, or country) associated 
with the name and street address they have entered already. Also, you will change the 
element and field lengths, because you do not need this field to be longer than two 
characters.

Use this procedure to remove the field label, change the element and field lengths, and add 
Help text to the Country Sub-Entity Identification field of the Remit To address.

8 In the Help Text box, enter the following text:

Enter the city name. The city cannot exceed 30 alphanumeric 
characters.

9 Click OK to exit the dialog.

 (Contd)
Step Action

Step Action

1 Double-click the NAD:320 element (in the NAD:2 group). 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 2.

4 Select the Display tab.

5 In the Label box, delete the existing text.

6 In the Maximum number of characters to be printed box, enter 2.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter the country sub-entity identification. The code cannot exceed 2 
alphanumeric characters.

9 Click OK to exit the dialog.
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How to customize
the NAD:321

element

Use this procedure to remove the field label and add Help text to the Postcode 
Identification field.

Step Action

1 Double-click the NAD:321 element (in the NAD:2 group). 

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing text.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Enter the postal code. The postal code cannot exceed 9 alphanumeric 
characters. Do not enter a hyphen (-) before the 4-character postal 
code extension (if used).

6 Click OK to exit the dialog.
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Customizing the PAT Group

Overview The PAT group (Payment Terms) is used to enter the payment terms code for the invoice. 
The standard allows the PAT group to be used up to 10 times in an invoice.You know that 
your users need to use the PAT segment only once per invoice so you have already 
changed the maximum use of this segment from five to one.
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Customizing the PAT Segment

Overview The PAT segment is a conditional segment that specifies the Payment Terms Basis for the 
invoice. 

How to customize
the PAT01 element

The PAT01 element contains the Payment Terms Type Qualifier, a three-character code 
that identifies the payment terms under which this invoice is valid. Gentran:Server uses a 
list (instead of an edit box or field) when you apply a standard rule that allows a selection 
of multiple items. When users use a translation object that contains a list, they select an 
item from the list instead of typing a value in the field. You will customize the PAT01 
element so that a list containing all valid codes in the Payment Terms Type Qualifier code 
list is available to your users when they use the screen entry translation object. The 
Payment Terms Type Qualifier list enables them to select the appropriate EDI code from 
the code list.

After you specify the code list table to use for the list for the Payment Terms Type 
Qualifier field, you need to rename the field label. You also need add Help text to the field.

Use this procedure to load the entire code list from the standard, rename the field label, 
and add Help text to the Payment Terms Type Qualifier field.

Step Action

1 Double-click the PAT01 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Code from the list.

(Continued on next page)
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4 Click Edit to access the Edit Code List dialog.

5 The Table ID box contains 4279, the name of the element for which this 
code list table will be used. The Desc box contains PAYMENT TERMS 
TYPE QUALIFIER, the description of the element for which this code list 
table will be used.

6 Click Load to access the Load Code List dialog. You are prompted to 
select an ODBC data source name. Select the appropriate DSN and click 
OK to access the Load Code List dialog.

7 Click Add All to select all the codes and move them to the Codes Selected 
list.

Note
Adding all the codes in the table (by using Add All) creates a much larger 
form than if you use only selected codes. However, it is necessary for your 
users to have all the codes available from which to select.

(Continued on next page)

 (Contd)
Step Action
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8 Click OK to load the code list and exit the Load Code List dialog.

9 Click Close to exit the Edit Code List dialog.

The dialog should now should look like this:

10 Select the Display tab.

11 In the Label box, enter Payment Terms Code.

12 Select the Help tab.

13 In the Help Text box, enter the following text:

Select the payment terms code from the drop-down box.

14 Click OK to exit the dialog.

 (Contd)
Step Action
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How to generate
the layout

Use this procedure to generate the layout.

Step Action

1 Click Generate Layout on the Main Toolbar to refresh the screen 
entry form display.

System Response
The Invoice Message frame now should look like this:

2 Select Save from the File menu to save your form. 
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Customizing the LIN Group

Overview The standard allows the LIN group to be used up to 200000 times in one invoice. The LIN 
group contains the following form components that you have already activated: LIN, PIA, 
IMD:2, MEA:2, QTY:2, and DTM:11 segments; MOA and TDT groups.

The fields associated with the LIN group are arranged on the 2200_Lin frame, which is 
separate from the Invoice Message frame that you have been working with thus far. Your 
users need to complete the fields on the 2200_Lin frame for each item in the invoice. The 
list of all line items in the invoice are displayed in a list box on the Invoice Message frame. 
In that list box, the invoiced items are displayed line by line, forming columns of 
information.

Procedure Use this procedure to rename the LIN frame and list box, provide a description for the LIN 
group, and add Help text to the line items list box.

Step Action

1 Click the LIN group with the right mouse button and select Properties 
from the shortcut menu. 

System Response
The Group Properties dialog is displayed.

2 In the Desc box, enter Line Items.

3 Select the Display tab.
(Continued on next page)
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4 In the Frame Caption box, enter Line Items.

5 In the List Caption box, enter Line Items to rename the list box that is 
displayed on the Invoice Message frame (listing the line items entered on 
the Line Items frame).

6 In the Frame Help Text list box, enter the following text:

This frame contains line item detail information. For online Help on 
an individual field on this frame, select the field and press F1.

7 In the Listbox Help Text list box, enter the following text:

This box contains the line item detail for the invoice. The data in this 
list box is entered or changed on the Line Items frame. To enter a new 
line item, click the list box and click New. To modify an existing line 
item, click that item and click Open.

8 Click OK to exit the Group Properties dialog.

 (Contd)
Step Action
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Customizing the LIN Segment

Overview The LIN segment contains the details of the items on the invoice. For some of the 
elements in the LIN segment, you only need to add Help text and rename the field labels 
so they more accurately reflect your company’s needs. With other elements, you need to 
change the maximum lengths for some of the fields, use accumulators to calculate the 
number of line items, or define a constant value.

The LIN group is subordinate to the Invoice Message frame, so Gentran:Server creates a 
separate frame (the Line Items frame) to contain the group data (the line item details). The 
system also creates a list box (the Line Items list box) on the Invoice Message frame to 
allow you to access the items in the list box. Each set of data is displayed as a row in the 
list box. After you customize the line item fields, the Line Items list box contains these 
four columns of data: Item No., Product Code, Quantity, and Price.

How to customize
the LIN01 and

CNT02 elements

The LIN01 element (in the LIN group) contains the Line Item Number for each item in the 
invoice. You use the Line Item Number field to identify sequentially each line item in the 
invoice. You use the Use Accum function to obtain an incremental count of the number of 
line items. This number is used in the Control Value field (CNT02 element).

You create a list box definition for the LIN01 element to include the line number in the list 
box, and rename the field label to more briefly label this field. Also, you know that your 
users will enter no more than 99,999 line items per invoice. Each line item is numbered 
sequentially, starting with one so you need a maximum length of only five digits for this 
field. You need to change the maximum length for this field to five.

Use this procedure to count line items in the LIN segment and generate a control total in 
the CNT02 element of the number of line items, rename the LIN01 field label, change the 
field and element lengths and create the list box definition for the Line Item Number field.

Step Action

1 Double-click the LIN01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 5 to allow a five-digit number in this element.

4 Select the Standard Rule tab.

5 Select Use Accumulator from the list.
(Continued on next page)
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6 Click New to access the Edit Accumulator Entry dialog to create a new 
calculation using this element.

7 From the Primary Accumulator list, select 0. Before any calculations are 
performed on an accumulator, its content is 0. When you use this 
accumulator, the system adds a new accumulator to the bottom of this list.

Note
There is only one set of accumulators for each form. This means that 
accumulator 0, whether it is used in the Primary Accumulator or Alternate 
Accum box, is the same accumulator with the same content. If you assign 
calculations to accumulator 0 at the beginning of the form and then use 
accumulator 0 again later in the form, the content of that accumulator will 
be the result of the earlier calculation. Any additional calculations you 
assign to that accumulator will be performed on the content resulting from 
an earlier calculation.

8 In the Name box, enter Item Number to give the accumulator a 
descriptive alias that enables you to distinguish it from other accumulators 
you create.

9 From the First list, select Increment primary to specify that the system 
increments the value in this accumulator by one for each iteration of the 
LIN group. This operation is the first operation that the system performs.

(Continued on next page)
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10 From the Second list, select Use primary to specify that the system loads 
the current value of the accumulator into the LIN01 (Line Item Number) 
element. This operation is the second operation that the system performs, 
after the first operation is completed.

The Edit Accumulator Entry dialog now should look like this:

11 Click OK to add the accumulator and exit the Edit Accumulator Entry 
dialog.

The dialog should now should look like this:

12 Select the Display tab.

13 Select the This field should be displayed but not editable option. 
(Continued on next page)
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14 In the Label box, enter Item No. to replace the existing field label.

15 In the Maximum number of characters to be printed box, enter 5 to allow 
five digits to be displayed in this field.

16 Select the Summary List tab.

17 Select the Display this field in summary list check box. The value in the 
Item No. field is displayed in a column in the Line Items list box.

18 In the Column Width box, enter 8 to set the width of this column in the 
Line Items list.

Note
The column width should be wider than the actual content of the column. 
The extra space that is not used for the content of the column will provide 
white space separating the columns. If the column width is the exact width 
of the data, then there will not be space separating the columns of data.

19 From the Sequence list, select 1 to indicate that this field is the first 
column in the list box.

20 Click OK to exit the dialog.

21 Double-click the CNT02 element (in the CNT segment). 

System Response
The Element Properties dialog is displayed.

22 Select the Standard Rule tab.

23 Click the Use Accumulator option.

24 Click New to access the Edit Accumulator Entry dialog to create a new 
calculation for this element.

25 From the Primary Accumulator list, select 0.

26 In the Name box, enter Item Number.
(Continued on next page)
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27 From the First list, select Use primary to specify that the system loads the 
current value of the accumulator into the CNT02 (Control Value) element.

The Edit Accumulator Entry dialog now should look like this:

28 Click OK to add the accumulator.

The dialog should now should look like this:

29 Select the Display tab.

30 Select the This field should displayed but not editable option. 

31 Click OK to exit the dialog.

 (Contd)
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Customizing the PIA Segment

Overview The PIA segment (in the LIN group) contains the Additional Product ID for each item in 
the invoice. The standard allows the PIA segment to be used up to 25 times per line item. 
Your users enter information in the PIA segment only once per line item so you have 
already changed the maximum use of this segment to one.

How to customize
the PIA01 element

The PIA01 element contains the Product ID Function Qualifier, a mandatory three-
character code that identifies the type of product identification that follows. You know that 
the only type of product identification your users enter in the Item Number field (PIA02) 
is the product code, so you need to define a constant value for the Product ID Function 
Qualifier field, designating that the constant “5” (Product Identification) always qualifies 
the value in the Item Number field. You need to hide the qualifier field, because it does not 
need to be displayed in the translation object.

When you enter the product code in the Item Number field, the system assigns the code 
“5” to the Product ID Function Qualifier field.

Use this procedure to define a constant value in the Product ID Function Qualifier field 
and hide the field.

Step Action

1 Double-click the PIA01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select the Use Constant option.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Product Identification to identify the constant.

7 From the Type list, select String to indicate that the literal constant will be 
formatted as a string data type.

8 In the Value box, enter 5 to indicate that the Reference Qualifier field must 
contain the product identification. This value is the actual value of the 
literal constant.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.
(Continued on next page)
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11 Select the Standard Rule tab.

12 From the Constants list, select 5 to identify the constant that will be used 
for this element.

13 From the Qualifies list, select 7140:2 ITEM NUMBER, which is the 
element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

14 Select the Display tab.

15 Select the This field should not appear on the form option.

16 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the PIA02 element

The PIA02 element contains the Item Number for each item in the invoice. For this 
tutorial, you need to rename the field label. Also, the standard allows up to 35 characters 
in this field. You know that your users will enter product identification numbers that are 
no longer than 10 characters, so you need to change the element and field lengths. In 
addition, you need to create a list box definition for the PIA02 element to include the 
product code in the Line Items list box on the Invoice Message frame.

Use this procedure to rename the field label, change the field and element lengths, add 
Help text, and create the list box definition for the Item Number field.

Step Action

1 Double-click the PIA02 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10.

4 Select the Display tab.

5 In the Label box, enter Product Code.

6 In the Maximum number of characters to be printed box, enter 10.

7 Select the Summary List tab.

8 In the Summary List section, select the Display this field in summary 
list check box. The value in the Product Code field will be displayed in a 
column in the Line Items list box.

9 In the Column Width box, enter 13 to set the width of this column in the 
Line Items list box.

10 From the Sequence list, select 2 to indicate that this field will be the 
second column in the list box.

11 Select the Help tab.

12 In the Help Text box, enter the following text:

Enter your company's product code for this item in the invoice. The 
product code cannot exceed 10 alphanumeric characters.

13 Click OK to exit the dialog.
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How to customize
the PIA03 element

The PIA03 element contains the Item Number Type, Coded, a three-character code that 
identifies the type of item number in the PIA02 element. You know that the only type of 
product code your users enter in the Item Number field (PIA02) is the UPC code, so you 
need to define a constant value for the Item Number Type, Coded field, designating that 
the constant, UP (UPC (Universal Product Code)), always qualifies the value in the Item 
Number field. Then, you will hide the qualifier field, because it does not need to be 
displayed in the translation object.

When a user enters the product code in the Item Number field, the system automatically 
assigns the code UP to the Item Number Type, Coded field.

Use this procedure to define a constant value in the Item Number Type, Coded field and 
hide the field.

Step Action

1 Double-click the PIA03 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard tab.

3 Select the Use Constant option.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter UPC Code.

7 From the Type list, select String.

8 In the Value box, enter UP.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select UP.
(Continued on next page)
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12 From the Qualifies list, select 7140:2 ITEM NUMBER, which is the 
element that the Reference Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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Customizing the IMD:2 Segment

Overview The IMD:2 segment (in the LIN group) contains the Item Description for each item in the 
invoice. The standard allows the IMD:2 segment to be used up to ten times per line item. 
Your users enter information in the IMD:2 segment only once per line item, so you have 
already changed the maximum use of this segment to one.

How to customize
the IMD:201

element

The IMD:201 element contains the Item Description Type, Coded for the invoiced item. 
You know that the only type of item description your users enter for this invoice is a free-
form description. You need to define a constant value for the Item Description Type field, 
to indicate that the constant “F” (Free Form) qualifies the text in the Item Description 
field. When a user enters a free-form description in the Description field, the system 
automatically will assign the code “F” to the Item Description Type, Coded field.

Use this procedure to define a constant value and hide the Item Description Type, Coded 
field.

Step Action

1 Double-click the IMD:201 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Free Form.

7 From the Type list, select String.

8 In the Value box, enter F to indicate that the Item Description Type, 
Coded field will be a free-form description. This value is the actual value 
of the literal constant.

9 Click OK to add the constant.
(Continued on next page)
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10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select F.

12 From the Qualifies list, select 7008 ITEM DESCRIPTION, which is the 
element that the Item Description Type, Coded field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Click the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the IMD:206

element

The IMD:206 element contains the Item Description for each invoiced item, and is defined 
by the standard to be a string of up to 35 alphanumeric characters. You need to add Help 
text to this field.

Use this procedure to add Help text to the Item Description field.

Step Action

1 Double-click the IMD:206 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Help tab.

3 In the Help Text box, enter the following text:

Enter the description of the invoiced item. The item description 
cannot exceed 35 alphanumeric characters.

4 Click OK to exit the dialog.
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Customizing the MEA:2 Segment

Overview The MEA:2 segment (in the LIN group) contains the Measurements for each item in the 
invoice. The standard allows the MEA:2 segment to be used up to five times per line item. 
Your users enter information in the MEA:2 segment only once per line item, so you have 
already changed the maximum use of this segment to one.

How to customize
the MEA:201

element

The MEA:201 element contains the Measurement Application Qualifier for each invoiced 
item. You know that the only type of measurement application your users enter for this 
invoice is a measurement. You need to define a constant value for the Measurement 
Application Qualifier field to indicate that the constant “AAE” (Measurement) qualifies 
the text in the Measurement Dimension, Coded field. When a user enters a measurement 
in the Measurement Dimension, Coded field, the system automatically assigns the code 
“AAE” to the Measurement Application Qualifier field.

Use this procedure to define a constant value and hide the Measurement Application 
Qualifier field.

Step Action

1 Double-click the MEA:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Measurement to identify the constant.

7 From the Type list, select String. 

8 In the Value box, enter AAE to indicate that the Product/Service ID 
Qualifier field will be a measurement.

9 Click OK to add the constant.
(Continued on next page)
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10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select AAE.

12 From the Qualifies list, select 6313 MEASUREMENT DIMENSION, 
CODED, which is the element that the Item Description Type, Coded 
field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the Display Properties dialog.

 (Contd)
Step Action
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How to customize
the MEA:202

element

The MEA:202 element contains the Measurement Dimension, Coded for each item in the 
invoice. For brevity on the translation object, you need to rename the field label. Also, you 
need to customize the MEA:202 element so that a drop-down list box containing all valid 
codes in the code list is available to your users when they use the screen entry translation 
object. The drop-down list box will enable them to select the appropriate EDI code from 
the ones available

Use this procedure to rename the field label, add Help text, and load the code list table 
from the standard for the Measurement Dimension, Coded field.

Step Action

1 Double-click the MEA:202 element (in the LIN group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, enter UOM.

4 Select the Help tab.

5 In the Help Text box, enter the following text:

Select the unit of measurement for the invoiced item.

6 Select the Standard Rule tab.

7 Select the Use Code option.

8 Click Edit to access the Edit Code List dialog.

9 The Table ID box contains 6313, which is the name of the element for 
which this code list table will be used. The Desc box contains 
MEASUREMENT DIMENSION, CODED, which is the description of 
the element for which this code list table is used.

10 Click Load to access the Load Code List dialog. You are prompted to 
select an ODBC data source name. Select the appropriate DSN and click 
OK to access the Load Code List dialog.

11 Click Add All to select all the codes and move them to the Codes Selected 
list.

Note
Adding all the codes in the table (by using Add All) creates a much larger 
form than if you only use selected codes.

12 Click OK to load the code list and exit the Load Code List dialog.
(Continued on next page)
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13 Click Close to exit the Edit Code List dialog.

The dialog should now should look like this:

14 Click OK to exit the dialog.

 (Contd)
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Customizing the QTY:2 Segment

Overview The QTY:2 segment (in the LIN group) contains the Quantity for each item in the invoice. 
The standard allows the QTY:2 segment to be used up to five times per line item. Your 
users enter information in the QTY:2 segment only once per line item so you have already 
changed the maximum use of this segment to one.

How to customize
the QTY:201

element

The QTY:201 element contains the Quantity Qualifier for each invoiced item. For this 
tutorial, you know that the only type of quantity your users enter for this invoice is the 
invoiced quantity. You need to define a constant value for the Quantity Qualifier field, to 
indicate that the constant, 47 (Invoiced Quantity), qualifies the text in the Quantity field. 
When a user enters a measurement in the Quantity field, the system automatically assigns 
the code, 47, to the Quantity Qualifier field.

Use this procedure to define a constant value and hide the Quantity Qualifier field.

Step Action

1 Double-click the QTY:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.

6 In the ID box, enter Invoiced Quantity to identify the constant.

7 From the Type list, select String.

8 In the Value box, enter 47 to indicate that the Quantity Qualifier field will 
be the invoiced quantity.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

(Continued on next page)
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11 From the Constants list, select 47 to identify the constant that is used for 
this element.

12 From the Qualifies list, select 6060 QUANTITY, which is the element 
that the Quantity Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the dialog.

 (Contd)
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How to customize
the QTY:202,

MOA:502, and
MOA:1002

elements

The QTY:202 element contains the Quantity for each item on the invoice. The quantity for 
each line item is used to calculate the total dollar amount of the invoice. From this 
calculation, you need to generate a running total of extended price and load the final total 
into the MOA:1002 (Monetary Amount) element.

You need to create a list box definition for the QTY:202 element to include the quantity 
invoiced in the list box. The standard allows up to 15 digits in this field. You know that 
your users do not enter a quantity of more than 99,999 (a five-digit number) for any one 
item, so you need to change the maximum lengths for this field and element to five.

Also, the screen format and EDI format of the data currently use the number format R9, 
indicating a number with an explicit decimal point and up to nine decimal places. Your 
users do not enter any quantities with a decimal point so you need to change the screen 
and EDI formats to R0, indicating a number with an explicit decimal point and no decimal 
places.

Use this procedure to use an accumulator in the QTY:202 element to generate a running 
total of extended price that is used in the MOA:1002 element, change the screen and EDI 
formats, change the field and element lengths, add Help text, and create the list box 
definition for the Quantity field.

Step Action

1 Double-click the QTY:202 element (in the LIN group).

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 5 for the maximum number of digits allowed in this 
element.

4 From the Form Format list, select R0 to allow a number with an explicit 
decimal point and no decimal places to be entered in this field.

5 From the File Format list, select R0 to format the EDI data with an 
explicit decimal point and no decimal places.

6 Select the Standard Rule tab.

7 Click the Use Accumulator option.

8 Click New to access the Edit Accumulator Entry dialog to create a new 
calculation using this element.

9 From the Primary Accumulator list, select 1.
(Continued on next page)
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10 In the Name box, enter Extended Price to give the accumulator a 
descriptive alias that enables you to differentiate the purposes of the 
accumulators you create.

11 From the First list, select Load primary to specify that the system will 
load the content of the QTY:202 element into the Primary Accumulator 
for each iteration of the LIN group. This operation is the first operation 
that the system performs.

The Edit Accumulator Entry dialog now should look like this:

12 Click OK to add the accumulator.

The dialog should now should look like this:

(Continued on next page)
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13 Select the Display tab.

14 In the Maximum number of characters to be printed box, enter 5 to allow 
five digits to be displayed in this field.

15 Select the Summary List tab.

16 Select the Display this field in summary list check box. The value in the 
Quantity field is displayed in a column in the Line Items list box.

17 In the Column Width box, enter 8 to set the width of this column in the 
Line Items list box.

18 From the Sequence list, select 3 to indicate that this field is the third 
column in the list box.

19 Select the Help tab.

20 In the Help Text box, enter the following text:

Enter the quantity of this invoiced item. The quantity cannot exceed 5 
digits.

21 Click OK to exit the dialog.

22 Double-click the MOA:502 element (in the LIN group). 

System Response
The Element Properties dialog is displayed.

23 Select the Standard Rule tab.

24 Click the Use Accumulator option.

25 Click New to access the Edit Accumulator Entry dialog to create a new 
calculation using this element.

26 From the Primary Accumulator list, select 1.

 (Contd)
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27 From the First list, select Multiply with primary to specify that the 
system multiply the value of the MOA:502 (Monetary Amount) element 
(in the LIN group) by the content of the primary accumulator, and store 
the result in the primary accumulator for each iteration of the LIN group. 
This operation is the first operation that the system performs.

The Edit Accumulator Entry dialog now should look like this:

28 Click OK to add the accumulator.

The dialog should now should look like this:

29 Click New to access the Edit Accumulator Entry dialog to create a new 
calculation for this element.

(Continued on next page)
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30 From the Primary Accumulator list, select 2.

31 In the Name box, enter Running Price to give the accumulator a 
descriptive alias that enables you to differentiate the purposes of the 
accumulators you create.

32 From the First list, select Add primary to alternate to specify that the 
system add the content of the primary accumulator to the content of the 
alternate accumulator, and store the result in the primary accumulator for 
each iteration of the LIN group.

33 From the Alternate Accum list, select 1. This operation specifies that the 
system add the value of accumulator 1, which contains the extended price 
for a line item, to the value of accumulator 2. The system stores the sum in 
accumulator 2, which contains a running total of the extended price with 
each iteration of the LIN group.

The Edit Accumulator Entry dialog now should look like this:

(Continued on next page)
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34 Click OK to add the accumulator.

The dialog should now should look like this:

35 Click OK to exit the Element Properties dialog.

36 Double-click the MOA:1002 element (in the MOA group). 

System Response
The Element Properties dialog is displayed.

37 Select the Standard Rule tab.

38 Click the Use Accumulator option.

39 Click New to access the Edit Accumulator Entry dialog to create a new 
calculation for this element.

40 From the Primary Accumulator list, select 2.
(Continued on next page)
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41 From the First list, select Use primary to specify that the system load the 
content of the primary accumulator into the MOA:1002 (Monetary 
Amount) element.

The Edit Accumulator Entry dialog now should look like this:

42 Click OK to add the accumulator.

The dialog should now should look like this:

43 Select the Display tab.

44 Select the This field should be displayed but is not editable option.

45 Click OK to exit the dialog.

 (Contd)
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Customizing the DTM:11 Segment

Overview The DTM:11 segment (in the LIN group) contains the Date/Time/Period for each item in 
the invoice. The standard allows the DTM:11 segment to be used up to 35 times per line 
item. Your users enter information in the DTM:11 segment only once per line item so you 
have already changed the maximum use of this segment to one.

How to customize
the DTM:1101

element

The DTM:1101 element (Date/Time Qualifier) is a mandatory element for the DTM:11 
segment. The DTM:1101 element contains the two-character code from your EDI data to 
indicate what type of date follows (e.g., date shipped). You need to define a constant value 
for the Date/Time/Period Qualifier field, designating that the constant, 186 (Departure 
Date/Time, Actual), qualifies the date in the Date/Time/Period field.

When a user enters the date on which the item is shipped in the Date/Time/Period field, 
the system assigns the code 186 to the Date/Time/Period Qualifier field. The qualifier 
field does not need to be displayed.

Use this procedure to define a constant and hide the Date/Time/Period Qualifier field.

Step Action

1 Double-click the DTM:1101 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select the Use Constant option.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.

6 In the ID box, enter Date Shipped.

7 From the Type list, select String.

8 In the Value box, enter 186.

9 Click OK to add the constant.
(Continued on next page)
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10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select 186.

12 From the Qualifies list, select 2380 DATE/TIME/PERIOD.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the dialog.
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How to customize
the DTM:1102

element

The DTM:1102 element in the DTM:11 segment contains the Date/Time/Period qualified 
by the Date/Time/Period Qualifier field. This element is defined by the standard to be a 
string of 35 characters. In this tutorial, you know that the ship date always is an eight-
character string, so you need to change the element and field lengths to accommodate the 
new length. Also, you need to rename the field label and add Help text to the field

Use this procedure to change the element and field lengths, rename the field label, and add 
Help text to the Date field.

Step Action

1 Double-click the DTM:1102 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab. 

3 In the Max box, enter 8 to allow the entire date, including separators 
(/), in this element.

4 Select the Display tab. 

5 In the Label box, enter Date Shipped.

6 In the Maximum number of characters to be printed box, enter 8.

7 Select the Help tab. 

8 In the Help Text box, enter the following text:

Enter the date on which this invoiced item was shipped. Use the 
format MM/DD/YY.

9 Click OK to exit the dialog.
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Customizing the MOA Group

Overview The MOA group (in the LIN group) contains the Monetary Amount for each line item. 
The standard allows the MOA group to be used up to five times per line item. You have 
already changed the maximum use of the MOA group and promoted the group to obtain 
just one instance of the MOA group, and to place the price on the Line Items frame.
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Customizing the MOA:5 Segment

Overview The MOA:5 segment (in MOA group which is in the LIN group) contains the Monetary 
Amount for each item in the invoice.

How to customize
the MOA:501

element

The MOA:501 element (Monetary Amount Type Qualifier) is a mandatory element for the 
MOA:5 segment. The MOA:501 element contains the three-character code from your EDI 
data to indicate what type of monetary amount follows (e.g., price). You need to define a 
constant value for the Monetary Amount Type Qualifier field, designating that the 
constant 146 (Unit Price) qualifies the monetary amount in the Monetary Amount field.

When a user enters the price for an item in the Monetary Amount field, the system assigns 
the code 146 to the Monetary Amount Type Qualifier field. The qualifier field does not 
need to be displayed.

Use this procedure to define a constant and hide the Monetary Amount Type Qualifier 
field.

Step Action

1 Double-click the MOA:501 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab. 

3 Select Use Constant from the list.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.

6 In the ID box, enter Unit Price.

7 From the Type list, select String.

8 In the Value box, enter 146.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.
(Continued on next page)
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How to customize
the MOA:502

element

The MOA:502 element contains the Monetary Amount for each item in the invoice. You 
have already used an accumulator for this field so that the price for each line item is used 
to calculate the total dollar amount of the invoice. From this calculation, a running total of 
extended price is generated and the final total will be loaded into the MOA:1002 
(Monetary Amount) element. You need to create a list box definition for the MOA:502 
element to include the unit price in the Line Items list box.

You need to rename the field label. The standard designates an R9 screen format and EDI 
format for this field, meaning that the price is formatted with an explicit decimal point and 
up to nine decimal places. Your users enter a price in an R2 format (a number with up to 
two decimal places) so you need to change the screen and EDI formats from R9 to R2.

(Continued on next page)

11 From the Constants list, select 146.

12 From the Qualifies list, select 5004 MONETARY AMOUNT, which is 
the element that the Monetary Amount Type Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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The standard defines this element as having a maximum length of 18. The items you sell 
to Pet Zone are not priced at more than $9,999.99 each, so this field needs a maximum 
length of only eight (four places for the dollars; two places for the cents; one place for the 
decimal point; and one place for a plus or minus sign, if present).

Use this procedure to rename the field label, change the field and element lengths, change 
the number formats, add Help text, and create the list box definition for the Monetary 
Amount field.

Step Action

1 Double-click the MOA:502 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8.

4 From the Screen Format list, select R2 to indicate that this field on the 
translation object accept a number with an explicit decimal point and up to 
two decimal places.

5 From the EDI Format list, select R2 to format the EDI data with an 
explicit decimal point and two decimal places.

6 Select the Display tab.

7 In the Label box, enter Price to replace the existing text.

8 In the Maximum number of characters to be printed box, enter 8 to allow 
eight numeric digits in this field, including a plus or minus sign and a 
decimal point.

9 Select the Summary List tab.

10 Select the Display this field in summary list check box. The value in the 
Price field is displayed in a column in the Line Items list box.

11 In the Column Width box, enter 8 to set the width of this column in the 
Line Items list box.

12 From the Sequence list, select 4 to indicate that this field is the fourth 
column in the list box.

13 Select the Help tab.

14 In the Help Text box, enter the following text:

Enter the unit price for this item. The price cannot exceed 8 digits, 
including a plus or minus sign and a decimal point.

15 Click OK to exit the dialog.
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Customizing the TDT Group

Overview The TDT group (in the LIN group) contains the Details of Transport for each line item. 
The standard allows the TDT group to be used up to 10 times per line item.You use the 
TDT group only once per line item. You have already changed the maximum use of the 
TDT group and promoted the group to obtain just one instance of the TDT group and to 
place the transport method on the Line Items frame.
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Customizing the TDT:2 Segment

Overview The TDT:2 segment (in the LIN group) contains the Details of Transport for each item in 
the invoice.

How to customize
the TDT:201

element

The TDT:201 element (Transport Stage Qualifier) is a mandatory element for the TDT:2 
segment. The TDT:201 element contains the three-character code from your EDI data to 
indicate the type of transport (e.g., main-carriage transport). You need to define a constant 
value for the Transport Stage Qualifier field, designating that the constant “20” (Main-
Carriage Transport) qualifies the transport type in the Type of Means of Transport 
Identification field.

When a user selects a transport method from the Type of Means of Transport 
Identification list box, the system assigns the code “20” to the Transport Stage Qualifier 
field. The qualifier field does not need to be displayed.

Use this procedure to define a constant and hide the Transport Stage Qualifier field.

Step Action

1 Double-click the TDT:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.

6 In the ID box, enter Main-Carriage Transport.

7 From the Type list, select String.

8 In the Value box, enter 20.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.
(Continued on next page)
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Customizing the TDT:2 Segment 3 - 127
11 From the Constants list, select 20.

12 From the Qualifies list, select 3127 CARRIER IDENTIFICATION, 
which is the element that the Transport Stage Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the TDT:205

element

The TDT:205 element, the Type of Means of Transport Identification, contains the eight-
character string that identifies the means of transportation (e.g., ship) for each invoiced 
item. You need to customize the TDT:205 element so that a drop-down list box containing 
all valid codes in the Transportation Method/Type Code list is available to your users 
when they use the screen entry translation object.

After you specify the code list table to use for the drop-down list box for the Type of 
Means of Transport Identification field, you need to rename the field label to identify this 
field better.

Also, the standard allows this field to contain an eight-character string. You know that the 
codes from which your users will select are no longer than two characters, so you need to 
change the element and field lengths to two.

Use this procedure to load the code list table from the standard, change the element and 
field lengths, rename the field label, and add Help text to the Transportation Method/Type 
Code field.

Step Action

1 Double-click the TDT:205 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 2 for the maximum number of characters allowed in 
this element.

4 Select the Standard Rule tab.

5 Select Use Code from the list.

6 Click Edit to access the Edit Code List dialog.

The Table ID box contains 8179, the name of the element for which this 
code list table is used. The Desc box contains, TYPE OF MEANS OF 
TRANSPORT IDENTIFICATION, the description of the element for 
which this code list table is used.

7 Click Load to access the Load Code List dialog. You are prompted to 
select an ODBC data source name. Select the appropriate DSN and click 
OK to access the Load Code List dialog.

8 Click Add All to select all the codes and move them to the Codes Selected 
list box.

9 Click OK to load the code list and exit the Load Code List dialog.
(Continued on next page)
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10 Click Close to exit the Edit Code List dialog.

The dialog should now should look like this:

11 Select the Display tab.

12 In the Label box, enter Transport Method.

13 In the Maximum number of characters to be printed box, enter 2.

14 Select the Help tab.

15 In the Help Text box, enter the following text:

Select the transportation method code for this invoiced item 
from the drop-down list box.

16 Click OK to exit the dialog.

 (Contd)
Step Action
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How to customize
the TDT:207

element

The TDT:207 element contains the Carrier Identification, a 17-character string that 
identifies the carrier for each line item. Your users enter a carrier code no longer than 12 
characters, so you need to change the element and field lengths. You also need to rename 
the field label to more accurately describe the contents of this field for your users and add 
Help text to this field.

Use this procedure to change the element and field lengths, rename the field, and add Help 
text to the Carrier Identification field.

Step Action

1 Double-click the TDT:207 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 12.

4 Select the Display tab.

5 In the Label box, enter Carrier Code.

6 In the Maximum number of characters to be printed box, enter 12.

7 Select the Help tab.

8 In the Help Text box, enter the following text:

Enter your company’s reference number for this carrier. The 
reference number cannot exceed 12 alphanumeric characters.

9 Click OK to exit the dialog.
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Customizing the UNS Segment

Overview The UNS segment contains the Section Control for the invoice. The Section Control 
contains EDI data to instruct the system that the data that follows pertains to the summary 
section of the invoice, not the header or detail sections.

How to customize
the UNS01 element

The UNS01 element (Section Identification) is a mandatory element for the invoice. The 
UNS01 element contains the one-character code to indicate that the data that follows 
pertains to the summary section of the invoice. You need to define a constant value for the 
Section Identification field, designating that the constant S (Summary) indicates that the 
summary section follows. The system assigns the code S to the Section Identification 
field, which does not need to be displayed.

Use this procedure to define a constant and hide the Section Identification field.

Step Action

1 Double-click the UNS01 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.

6 In the ID box, enter Summary.

7 From the Type list, select String.

8 In the Value box, enter S to indicate the Summary section of the invoice.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.
(Continued on next page)
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11 From the Constants list, select S.

The dialog should now should look like this:

12 Select the Display tab.

13 Select the This field should not appear on the form option.

14 Click OK to exit the dialog.

 (Contd)
Step Action
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How to generate
the layout

Use this procedure to generate the layout.

Step Action

1 Click Generate Layout on the Main Toolbar to refresh the screen entry 
form display.

System Response
The Line Items frame now should look like this:

2 Click Save from the File menu to save the form.
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Customizing the CNT Segment

Overview The CNT segment contains the Control Total for the invoice. You have already used an 
accumulator to generate the total number of line items in the invoice. The standard allows 
the CNT segment to be used up to 10 times per invoice. You need to use the CNT segment 
only once per invoice so you have already changed the maximum use of this segment to 
one. Changing the maximum use of this segment placed the total number of line items on 
the main Invoice Message frame. 

How to customize
the CNT01

element

The CNT01 element (Control Qualifier) is a mandatory element for the CNT segment. 
The CNT01 element contains the three-character code from your EDI data to indicate 
what type of control follows (e.g., total number of line items). You need to define a 
constant value for the Control Qualifier field, designating that the constant, 2 (Number of 
Line Items in Message), qualifies the value in the Control Value field. The system assigns 
the code 2 to the Control Qualifier field so this field does not need to be displayed.

Use this procedure to define a constant and hide the Control Qualifier field.

Step Action

1 Double-click the CNT01 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Select Use Constant from the list.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.

6 In the ID box, enter Number of Line Items.

7 From the Type list, select String.

8 In the Value box, enter 2 to indicate that the Control Qualifier field will 
contain the total number of line items in the invoice.

9 Click OK to add the constant.

(Continued on next page)
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10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select 2.

12 From the Qualifies list, select 6066 CONTROL VALUE, which is the 
element that the Monetary Amount Type Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option. 

15 Click OK to exit the dialog.

 (Contd)
Step Action
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Customizing the CNT Segment Creating a Screen Entry Form3 - 136
How to customize
the CNT02

element

The CNT02 element contains the Control Value for the invoice. You have already used an 
accumulator for this field to generate a total of the number of line items and made this 
field display-only so that users cannot change the value in this field.

You must rename the field label to more clearly identify its contents. The standard 
designates an R9 screen format and EDI format for this field, meaning that the number is 
formatted with an explicit decimal point and up to nine decimal places. The data is 
formatted in the N0 format (a number with an implicit decimal point and no decimal 
places) so you need to change the screen format and EDI format from R9 to N0.

The standard defines this element as having a maximum length of eight. Your users enter 
no more than 99,999 line items so this field needs a maximum length of only six.

Use this procedure to rename the field label, change the field and element lengths, and 
change the screen and EDI formats for the Control Value field.

Step Action

1 Double-click the CNT02 element. 

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 6.

4 From the Screen Format list, select N0 to indicate that this field on the 
translation object will accept a number with an implicit decimal point and 
no decimal places.

5 From the EDI Format list, select N0 to format the EDI data with an 
implicit decimal point and no decimal places.

6 Select the Display tab.

7 In the Label box, enter Number of Line Items.

8 In the Maximum number of characters to be printed box, enter 6 

9 Click OK to exit the dialog.
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Customizing the MOA Group

Overview The MOA group contains the Monetary Amount for the invoice. The standard allows this 
MOA group to be used up to 100 times per invoice. You need to use this MOA group only 
once per invoice. You have already changed the maximum use of the MOA group to one 
and promoted the group to obtain just one instance of the MOA group and to place the 
total invoice amount on the main Invoice Message frame.

Note
The MOA group that you want to customize is at the bottom of the map NOT in the LIN 
group.
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Customizing the MOA:10 Segment

Overview The MOA:10 segment contains the invoice’s Monetary Amount. You have already used an 
accumulator to calculate the total dollar amount invoiced.

How to customize
the MOA:1001

element

The MOA:1001 element (Monetary Amount Type Qualifier) is a mandatory element for 
the MOA:10 segment. The MOA:1001 element contains the three-character code from 
your EDI data to indicate what type of monetary amount follows (e.g., total invoice 
amount). You need to define a constant value for the Monetary Amount Type Qualifier 
field, designating that the constant “77” (Invoice Amount) qualifies the value in the 
Monetary Amount field. The system automatically will assign the code “77” to the 
Monetary Amount Type Qualifier field, so this field does not need to be displayed on the 
translation object.

Use this procedure to define a constant and hide the Monetary Amount Type Qualifier 
field.

Step Action

1 Double-click the MOA:1001 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.

6 In the ID box, enter Invoice Amount.

7 From the Type list, select String.

8 In the Value box, enter 77.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

(Continued on next page)
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How to customize
the MOA:1002

element

The MOA:1002 element contains the Monetary Amount for the invoice. You have already 
used an accumulator for this field to calculate the total dollar amount invoiced and made 
this field display-only so that users cannot change the value in this field.

You need to rename the field label to more clearly identify its contents. Also, the standard 
designates an “R9” screen format and EDI format for this field, meaning that the number 
is formatted with an explicit decimal point and up to nine decimal places. The data is 
formatted in the “R2” format (a number with an explicit decimal point and up to two 
decimal places) so you need to change the screen format and EDI format from “R9” to 
“R2.”

(Continued on next page)

11 From the Constants list, select 77.

12 From the Qualifies list, select 5004 MONETARY AMOUNT which is 
the element that the Monetary Amount Type Qualifier field qualifies.

The dialog should now should look like this:

13 Select the Display tab.

14 Select the This field should not appear on the form option.

15 Click OK to exit the dialog.

 (Contd)
Step Action
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The standard defines this element as having a maximum length of 18. The total invoice 
amount will total no more than $999,999.99 so this field needs a maximum length of only 
10 (six places for the dollars; two places for the cents; one place for the decimal point, and 
one place for a plus or minus sign, if present).

Use this procedure to rename the field label, change the field and element lengths and to 
change the screen and EDI formats for the Monetary Amount field.

How to generate
the layout

Use this procedure to generate your layout and to save your form.

Now that you have customized all of the elements used in this invoice, you are ready to 
format the fields and labels to make the frames more consistent and visually attractive.

Step Action

1 Double-click the MOA:1002 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10 to allow a10-digit number in this element, 
including a plus or minus sign and a decimal point.

4 From the Please choose the format of the data in the form list, select R2.

5 From the Please choose the format of the data in the file, select R2.

6 Select the Display tab.

7 In the Label box, enter Total Invoice Amount.

8 In the Maximum number of characters to be printed box, enter 10.

9 Click OK to exit the dialog.

Step Action

1 Click Generate Layout on the Main Toolbar to refresh the print form 
display.

2 Click Save from the File menu to save the form.
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Format the Screen Entry Form 0

Overview

Introduction In the previous section of this tutorial, you customized the screen entry form for an 
EDIFACT 92.1 invoice (INVOIC) that your users use to enter data to invoice Pet Zone for 
items that were shipped to them. After successfully customizing the fields and elements of 
the screen entry form, you are ready to format the layout of the form.

This section explains how to format the form, field by field.
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Resizing the Invoice Message Frame Creating a Screen Entry Form3 - 142
Resizing the Invoice Message Frame

Overview When a form is compiled into a translation object, the fields are arranged according to 
how the frames and the fields contained in them were arranged when the form was 
compiled. You should eliminate unnecessary space as you arrange the fields on each 
frame.

Warning
Your screen resolution must be the same as that of the end user of the completed form.

Procedure Use this procedure to resize the Invoice Message frame.

Step Action

1 Click the INVOIC file icon to display the Invoice Message frame in the 
Layout Window.

2 To display more of the form on your screen, click and drag the center bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want to view.

(Continued on next page)
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3 To resize the Invoice Message frame, click and drag the right side of the 
frame approximately to the 14 cm. mark on the horizontal ruler so that the 
form is wide enough to format the fields according to the instructions in 
this tutorial.

Note
Use the horizontal ruler at the top of the frame to help you resize the 
frame. The instructions in this tutorial are given in centimeters. You can 
toggle from inches to centimeters by double-clicking the yellow square 
where the vertical and horizontal rulers meet.

The Invoice Message frame now should look like this:

 (Contd)
Step Action
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Arranging the Fields on the Invoice Message Frame

Overview You will begin formatting the screen entry form by arranging the fields on the Invoice 
Message frame. You need to place the fields in the translation object in a logical order, 
then align the fields to give the frame a consistent and orderly appearance. 

Message frame When you have finished arranging the fields, your Invoice Message frame should look 
like the one in the example below.

By default, each field and its associated label are displayed on its own line. It is common 
for invoices to place two or more fields on a line.

You prevented some of the field labels from being displayed by removing the field label in 
the Display Properties dialog. These fields the fields are displayed on your screen entry 
form, but their associated labels are not displayed. 

Note
If you forget which unlabeled field contains what data, you can click the field. Its 
associated element is highlighted in the EDI File Format Window, providing you with a 
description of the field.
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How to resize,
move, and align

the fields

Use this procedure to resize, move, and align the fields on the Invoice Message frame of 
the screen entry form.

Note
If a field and its corresponding field label move together, the Lock Labels to Fields option 
is turned on. Clear the Lock Labels button on the Main Toolbar to turn off the Lock Labels 
option.

Step Action

1 Click and drag the bottom of the frame to the bottom of the Forms 
window, so that as many of the fields on the frame are displayed as 
possible.

2 Select the following fields:

◗ Invoice No.
◗ Invoice Date
◗ P.O. No.
◗ P.O. Date
◗ Contract No.
◗ Contract Date
◗ City Name (both Ship To and Remit To)
◗ Country Sub-Entity Identification (both Ship To and Remit To)
◗ Number of Line Items
◗ Total Invoice Amount

Note
To select more than one field, select the first field, press CTRL and click 
the second field. Repeat this process for each subsequent field you want to 
select.

Note
If any of these fields is not in the part of the Invoice Message frame that 
currently is displayed, then use the scroll bar to scroll down the frame 
until you locate the hidden field(s).

3 Select Size to Length from the Display menu. The selected fields will be 
resized to the lengths specified in the Maximum number of characters to 
be printed box of the Display Properties dialog for each field.

Note
If you format a form component in a way you did not intend, select Undo 
from the Display menu to undo your last formatting action.

(Continued on next page)
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4 Select the following fields and drag them closer to their respective field 
labels:

◗ Invoice No.
◗ Invoice Date
◗ P.O. No.
◗ P.O. Date
◗ Contract No.
◗ Contract Date

5 Select the Invoice Date label and field and drag them to the upper right 
corner of the Invoice Message frame.

6 Select the P.O. No. label and field and drag them to the left side of the 
frame, below the Invoice No. label and field.

7 Select the P.O. Date label and field and drag them to the right side of the 
frame, below the Invoice Date label and field.

8 Select the Contract No. label and field and drag them to the left side of 
the frame, below the P.O. No. label and field.

9 Select the Contract Date label and field and drag them to the right side of 
the frame, below the P.O. Date label and field.

10 Select the Ship To field (not the field label), the two Street and Number/
P.O. Box fields, and the City Name field of the Ship To address. (The two 
Street and Number/P.O. Box fields and the City Name field are located 
below the Ship To field.)

11 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

12 Select the Country Sub-Entity Identification field of the Ship To 
address and drag it to the immediate right of the City Name field of the 
Ship To address.

13 Select the Postcode Identification field of the Ship To address and drag it 
to the immediate right of the Country Sub-Entity Identification field of the 
Ship To address.

14 Click and drag all of the Ship To fields (not including the Ship To field 
label) closer to the Ship To label, so that none of the fields extend beyond 
the right side of the frame.

(Continued on next page)
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15 Click and drag all of the Ship To fields (including the Ship To field label) 
to the left side of the frame, below the Contract No. label and field.

Note
To select a group of items, click and drag the mouse diagonally across all 
the fields and field labels you want to select. When you release the mouse 
button, all the fields and field labels completely included within the 
dragged-across area will have handles, indicating they were selected.

16 Select the Remit To field (not the field label), the two Street and Number/
P.O. Box fields, and the City Name field of the Remit To address. (The 
two Street and Number/P.O. Box fields and the City Name field are 
located below the Remit To field.)

17 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

18 Select the Country Sub-Entity Identification field of the Remit To 
address and drag it to the immediate right of the City Name field of the 
Remit To address.

19 Select the Postcode Identification field of the Remit To address and drag 
it to the immediate right of the Country Sub-Entity Identification Code 
field of the Remit To address.

20 Click and drag all of the Remit To fields (not including the Remit To field 
label) closer to the Remit To label, so that none of the fields extend 
beyond the right side of the frame.

21 Click and drag all of the Remit To fields (including the Remit To field 
label) below the Ship To address.

22 Select the Payment Terms Code list.

23 Click and drag its right handle so that the list box is approximately 1.5 cm. 
wide (including the Down Arrow).

24 Click and drag its bottom handle to make the drop-down part of the list 
box long enough to list approximately four codes (approximately 2 cm. 
long on the vertical ruler).

25 Click and drag the Payment Terms Code drop-down list box closer to its 
label.

26 Select the Payment Terms Code drop-down list box and label and drag 
them to the center of the frame, below the Remit To address.

27 Select the Line Items list box and drag it closer to its label.

(Continued on next page)
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28 Select the Line Items list box and label and drag them to the center of the 
frame, below the Payment Terms Code list box and label.

Note
Leave extra space between the Payment Terms Code list box and label, 
and the Line Items list box and label, to add column headings (using static 
text) to label the data in the list box.

29 Select the Number of Line Items field and drag it closer to its label.

30 Select the Number of Line Items label and field and drag them to the 
center of the frame, below the Line Items list box.

31 Select the Total Invoice Amount field and drag it closer to its label.

32 Select the Total Invoice Amount label and field and drag them to the 
center of the frame, below the Number of Line Items label and field.

 (Contd)
Step Action
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How to resize the
invoice message

frame

You should resize the Invoice Message frame to make the most efficient use of space. You 
have already resized the frame horizontally before you began arranging the fields. Then, 
you arranged the fields on the frame so the fields do not use the same amount of vertical 
space as before you arranged the fields. To make better use of the frame space, you need to 
resize the frame vertically.

Step Action

1 To resize the Invoice Message frame, scroll to the top of the Invoice 
Message frame, then click and drag the bottom of the frame to just below 
the Total Invoice Amount label and field.

System Response
The Invoice Message frame now should look like this:

2 Select Save from the File menu. 
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How to align the
fields and field

labels

Now that the fields in the Invoice Message frame are resized and moved to their proper 
locations, you can align the fields and labels. 

Use this procedure to align the fields and field labels on the Invoice Message frame.

Step Action

1 Select the following field labels:

◗ Invoice No.
◗ P.O. No.
◗ Contract No.
◗ Ship To
◗ Remit To

2 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected field labels are 
aligned.

3 Select the following fields:

◗ Invoice No.
◗ P.O. No.
◗ Contract No.

4 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

5 Select the following field labels:

◗ Invoice Date
◗ P.O. Date
◗ Contract Date

6 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected field labels are 
aligned.

7 Select the following fields:

◗ Invoice Date
◗ P.O. Date
◗ Contract Date

8 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

(Continued on next page)
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9 Select the following field labels:

◗ Number of Line Items
◗ Total Invoice Amount

10 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected field labels are 
aligned.

11 Select the following fields:

◗ Number of Line Items
◗ Total Invoice Amount

12 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

(Continued on next page)
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13 To align the tops of all of the field labels and fields, select each row of 
fields and labels (one row at a time), select Align Controls from the 
Display menu, then select Top from the Align Controls submenu. The 
fields and labels for each row are listed below:

◗ Invoice No. label and field, Invoice Date label and field
◗ P.O. No. label and field, P.O. Date label and field
◗ Contract No. label and field, Contract Date label and field
◗ Ship To label and field
◗ City Name, Country Sub-Entity Identification, and Postcode 

Identification fields of the Ship To address
◗ Remit To label and field
◗ City Name, Country Sub-Entity Identification, and Postcode 

Identification fields of the Remit To address
◗ Payment Terms Code label and drop-down list box
◗ Line Items label and list box
◗ Number of Line Items label and field
◗ Total Invoice Amount label and field

The Invoice Message frame now should look like this:

 (Contd)
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How to add
column headings

to the line items list
box

Gentran:Server labels the fields on the Line Items frame, but does not label the column 
headings for the Line Items list box on the Invoice Message frame. The Line Items list box 
displays the information entered into the fields on the Line Items frame. To label the 
columns in the Line Items list box, you must add the column headings with static text (text 
that is always included in the screen entry translation object).

You will add the following column headings to the Line Items list box on the Invoice 
Message frame:

Use this procedure to add and position the column headings.

Column Heading 
(Static Text) Placement Above Line Items List 

Item First column

Product Second column

Qty. Third column

Price Fourth column

Step Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame, 
displayed in the upper left corner of the frame. If the template is larger 
than the frame (there is a scroll bar on the right side of the frame), the 
static text is displayed in the upper left corner of the part of the template 
that is displayed, not at the top of the template.

2 Select the new text box and enter Item. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

3 Click and drag it to above the Line Items list box, immediately to the right 
of the left margin of the Line Items list box (so it looks like the example 
on 3 - 154).

4 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

5 Select the new text box and enter Product. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

6 Click and drag it to above the Line Items list box, to the right of the Item 
column heading (so it looks like the example on 3 - 154).

7 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

(Continued on next page)
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8 Select the new text box and enter Qty. (note the period in the text). The 
Text Properties dialog is displayed as you are typing. Click OK to add the 
text.

9 Click and drag it to above the Line Items list box, to the right of the 
Product column heading (so it looks like the example on 3 - 154).

10 Click Add Text on the Main Toolbar to add text to the current frame in the 
upper left corner.

11 Select the new text box and enter Price. The Text Properties dialog is 
displayed as you are typing. Click OK to add the text.

12 Click and drag it to above the Line Items list box, to the right of the Qty. 
column heading (so it looks like the example on 3 - 154).

13 To ensure that the column headings (static text) you just added are aligned 
properly, select all the static text you just added (Item, Qty., Product, 
Price). Select Align Controls from the Display menu, then select Top 
from the Align Controls submenu.

14 The Invoice Message frame now should look like this:

 (Contd)
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How to set the tab
sequence on the
invoice message

frame

The tab sequence is the order in which the cursor moves from field to field in the screen 
entry translation object when a user presses TAB. When you create a screen entry form, 
the system automatically positions the fields and sets the tab sequence for those fields. 
However, you usually will want to modify the tab sequence of the fields to meet your 
screen entry requirements and the new positions of the fields on the frame.

Use this procedure to set the tab sequence for the fields on the Invoice Message frame.

Step Action

1 Select Set Tab Order from the Display menu. 

System Response
Numbers are displayed in the fields on the frame to indicate the current 
tab sequence.

(Continued on next page)
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2 Click the fields listed below in the order in which they are listed. As you 
click each field, the tab sequence number for that field will change to the 
next sequential number in the tab sequence.
Note
If you click a field out of sequence, you must begin setting the tab 
sequence again. To start over, select Set Tab Order from the Display menu 
so that the tab sequence numbers are no longer displayed in the fields on 
the frame, and then begin these steps again.

a. Invoice No.

b. Invoice Date

c. P.O. No.

d. P.O. Date

e. Contract No.

f. Contract Date

g. Ship To Party Name

h. Ship To Street and Number/P.O. Box (first line of address)

i. Ship To Street and Number/P.O. Box (second line of address)

j. Ship To City Name

k. Ship To Country Sub-Entity Identification

l. Ship To Postcode Identification

m. Remit To Party Name

n. Remit To Street and Number/P.O. Box (first line of address)

o. Remit To Street and Number/P.O. Box (second line of address)

p. Remit To City Name

q. Remit To Country Sub-Entity Identification

r. Remit To Postcode Identification

s. Payment Terms Code

t. Line Items

u. Number of Line Items

v. Total Invoice Amount
(Continued on next page)

 (Contd)
Step Action
Gentran:Server for Windows – November 2005 Forms Integration EDIFACT Tutorial Guide



Creating a Screen Entry Form Arranging the Fields on the Invoice Message Frame 3 - 157
3 The new tab sequence should look like this:

Note
When you click the last field in the sequence (Total Invoice Amount), the 
tab sequence is set, and the tab sequence numbers no longer are displayed 
in the fields.

 (Contd)
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Arranging the Fields on the Line Items Frame

Overview Now that the fields, labels, and static text are arranged on the Invoice Message frame, you 
are ready to arrange the fields on the Line Items frame. You will place the fields in a 
logical order, then align the fields (as you did with the fields on the Invoice Message 
frame) to give the frame a consistent and orderly appearance. 

How to resize the
line items frame

Before you begin arranging the fields on the Line Items frame, you should resize the frame 
so that it is the same width as the Invoice Message frame. When this form is compiled into 
a translation object, the fields will be arranged according to how the frames and the fields 
contained on them were arranged when the form was compiled. You should eliminate 
unnecessary space as you arrange the fields on each frame.

Use this procedure to resize the line items frame.

Step Action

1 Click the LIN group to display the Line Items frame in the Layout 
Window.

2 To resize the Line Items frame, click and drag the right side of the frame 
to the 14 cm. mark on the horizontal ruler so that the form is wide enough 
to format the fields according to the instructions in this tutorial.

(Continued on next page)
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3 To display more of the form on your screen, click and drag the center bar 
between the EDI File Format Window and the Layout Window to the left 
until the Layout Window is wide enough to display as much of the form as 
you want.

The Line Items frame now should look like this:

 (Contd)
Step Action
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How to resize the
fields

Use this procedure to resize the fields on the Line Items frame of the screen entry form.

Note
If any of the fields are not in the part of the Invoice Message frame that currently is 
displayed, then use the scroll bar to scroll down the frame until you locate the hidden 
field(s).

How to move and
align the fields

Use this procedure to move and align the fields on the Line Items frame of the screen entry 
form.

Step Action

1 Select the following fields:

◗ Item No.
◗ Product Code
◗ Quantity
◗ Date Shipped
◗ Price
◗ Transport Method
◗ Carrier Code

Note
To select more than one field, select the first field, press CTRL and select 
the second field. Repeat this process for each subsequent field you want to 
select.

2 Select Size to Length from the Display menu. 

System Response
The selected fields are resized to the lengths specified in the Maximum 
number of characters to be printed box of the Display Properties dialog for 
each field.

Step Action

1 Select the UOM field and drag its right handle so that the field is 
approximately 2 cm. wide (including the Down Arrow).

2 Drag its bottom handle so that the field is long enough for four codes to be 
displayed in it when the drop-down part of the drop-down list is open 
(approximately 2 cm. on the vertical ruler).

3 Select the Transport Method and UOM fields (in that order).
(Continued on next page)
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4 Select Size Equally from the Display menu. The Transport Method field 
is the same size as the UOM field. The UOM field is the reference, 
meaning that it is the field relative to which all other selected items in the 
form are formatted. The reference is indicated by an outline of diagonal 
lines, whereas all other selected items are outlined by a solid line. The last 
item (field, field label, or static text) selected in a group of selected items 
is the reference.

5 Select each field on the frame individually and move it closer to its 
respective field label.

6 Select the Product Code label and field and drag them to the right of the 
Item No. label and field (use the example on 3 - 164 for reference).

Note
The Item No. label and field have already been positioned where you want 
them to be (in the upper left corner of the frame). You do not need to move 
them.

7 Select the Quantity label and field and drag them to the right of the 
Product Code label and field (use the example on 3 - 164 for reference).

8 Select the UOM label and field and drag them below the Item No. label 
and field. The left side of the UOM field label should be aligned with the 
left side of the Item No. field label. (Use the example on 3 - 164 for 
reference.)

9 Select the Price label and field and drag them below the Product Code 
label and field. The left side of the Price field label should be aligned with 
the left side of the Product Code field label. (Use the example on 3 - 164 
for reference.)

10 Select the Item Description label and field and drag them below the 
UOM and Price labels and fields. The left side of the Description field 
label should be aligned with the left side of the Item No. and UOM field 
labels. (Use the example on 3 - 164 for reference.)

11 Select the Date Shipped label and field and drag them to the left side of 
the frame, below the Item Description label and field. The left side of the 
Date Shipped field label should be aligned with the left side of the Item 
No., UOM, and Item Description field labels. (Use the example on 3 - 164 
for reference.)

12 Select the Transport Method label and field and drag them to the right of 
the Date Shipped label and field (use the example on 3 - 164 for 
reference).

(Continued on next page)
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How to resize the
line items frame

Use this procedure to resize the line items frame.

How to align the
fields and field

labels

Use this procedure to align the fields and field labels on the Line Items frame.

13 Select the Carrier Code label and field and drag them to the right of the 
Transport Method label and field (use the example on 3 - 164 for 
reference).

 (Contd)
Step Action

Step Action

1 To resize the Line Items frame, click and drag the bottom of the frame to 
below the last row of fields and labels (Date Shipped, Transport Method, 
and Carrier Code).

Note
Allow enough space between the last row of fields/labels and the bottom 
of the frame for the Transport Method drop-down list box to be opened.

The Line Items frame now should look like this:

Step Action

1 Select the following labels and fields:

◗ Item No.
◗ Product Code
◗ Quantity

2 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected items are aligned.

(Continued on next page)
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3 Select the following labels and fields:

◗ UOM
◗ Price

4 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected items are aligned.

5 Select the Item Description label and field.

6 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the label and field are aligned.

7 Select the following labels and fields:

◗ Date Shipped
◗ Transport Method
◗ Carrier Code

8 Select Align Controls from the Display menu, then select Top from the 
Align Controls submenu. The tops of the selected items are aligned.

9 Select the following field labels:

◗ Item No.
◗ UOM
◗ Item Description
◗ Date Shipped

10 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The tops of the selected field labels are aligned.

11 Select the following fields (in this order):

◗ UOM
◗ Item No.

12 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

13 Select the following field labels:

◗ Product Code
◗ Price

14 Select Align Controls from the Display menu, and select Left from the 
Align Controls submenu. The left margins of the selected field labels are 
aligned.

(Continued on next page)
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How to set the tab
sequence on the
line items frame

Use this procedure to set the tab sequence of the fields on the Line Items frame.

15 Select the following fields (in this order):

◗ Price
◗ Product Code

16 Select Align Controls from the Display menu, then select Left from the 
Align Controls submenu. The left margins of the selected fields are 
aligned.

The Line Items frame now should look like this:

 (Contd)
Step Action

Step Action

1 Select Set Tab Order from the Display menu. 

System Response
Numbers are displayed in the fields on the frame to indicate the current 
tab sequence.

(Continued on next page)
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2 Click the fields listed below in the order in which they are listed. As you 
click each field, the tab sequence number for that field changes to the next 
sequential number in the tab sequence you are now setting.

a. Product Code

b. Quantity

c. UOM

d. Price

e. Item Description

f. Date Shipped

g. Transport Method

h. Carrier Code

i. Item No.

Note
The Item No. field is the last field in the tab sequence, although it is the 
first field in the layout of the Line Items frame. This field is display-only, 
displaying the next consecutive item number for the invoice (the item 
number is generated by an accumulator in the Item No. field). By placing 
the Item No. field last in the tab sequence, this field can be skipped easily 
by users entering data. The first field in the sequence is the Product Code 
field, which is the first field into which users can enter a value.

The new tab sequence should look like this:
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Changing the Invoice Message Frame Title

Overview The system titles the frames in a screen entry form when the form is created, based on the 
name of the file, segment(s), or group(s). You can modify the frame titles (for example, at 
the file or message level) to distinguish one form from the others. The parent frame of the 
invoice currently is titled Invoice Message. You need to give this frame a more descriptive 
title to distinguish it from other invoices that your company uses.

Procedure Use this procedure to change the frame title.

Step Action

1 Click the INVOIC file icon with the right mouse button and select 
Properties from the shortcut menu. 

System Response
The File Format Properties dialog is displayed.

2 Click the Display tab.

3 In the Frame Caption box, enter EDIFACT Invoice (INVOIC) - Pet 
Zone.

4 Click OK. 

System Response
The new frame title is displayed in the frame title in the Layout Window.
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How to generate
the layout

Use this procedure to generate your layout and to save your form.

You have completed your Invoice form. Now, you are ready to finalize the form.

Step Action

1 Click Generate Layout on the Main Toolbar to refresh the display of the 
screen entry form.

2 Select Save from the File menu to save the form.
Forms Integration EDIFACT Tutorial Guide Gentran:Server for Windows – November 2005



Overview Creating a Screen Entry Form3 - 168
Finalize the Form 0

Overview

Introduction Now that you have created and customized a screen entry form, you are ready to compile 
the form to generate the translation object (*.TPL) that Gentran:Server uses before you 
print the report and test the compiled translation object.
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Compiling the Form

Overview The Compile function generates the form. The form that you create is a source form. 
When that source form is compiled, the result is a compiled translation object.

After you save the translation object, you must register it with Gentran:Server system 
before you can use it. You will use the Compile function after the form is completed and 
saved.

Procedure Use this procedure to compile the form.

Step Action

1 Select Compile from the File menu to display the Run-Time Translation 
Object Name dialog.

(Continued on next page)
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2 Click Save to accept the translation object name (peteinvs.tpl) in the File 
name box.

This name for the compiled translation object (.TPL file) is the same file 
name as the source form (.STP file). Preserving the same file name (with 
different file extensions) ensures that the relationship between the source 
form and the compiled translation object remains evident.

CAUTION
DO NOT TO OVERLAY THE SOURCE FORM WITH THE 
COMPILED TRANSLATION OBJECT. USE THE .TPL 
FILE EXTENSION TO DISTINGUISH THE COMPILED 
TRANSLATION OBJECT.

The system compiles the form and generate an error report. The error 
report is displayed in the Compile Errors dialog. 

3 Click OK to exit the Compile Errors dialog.

Note
If the Compile Errors dialog contains errors, you must fix the problem(s) 
by redoing the appropriate section of the tutorial. Recompile the form 
after you correct the error(s) and save the form.

4 Select Save from the File menu to save the form. The date on which you 
compiled the form is automatically loaded into the Compiled on box on 
the Translation Object Details dialog.

(Continued on next page)
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5 Select Edit/Details to access the Translation Object Details dialog. The 
date on which you compiled the form is loaded automatically into the 
Compiled on box.

6 Click Cancel to exit the dialog.

 (Contd)
Step Action
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Printing the Report

Overview The Gentran:Server report enables you to validate and review the translation object, and 
make modifications as needed. If you review the report and determine that the translation 
object is incorrect, you need to make modifications, save the form, recompile the form, 
and print the report again.

Procedure Use this procedure to print the Gentran:Server report.

Step Action

1  Select Print from the File menu to access the Print Options dialog.

2 Click OK to accept the defaults on this dialog (all options selected), so the 
report includes all sections and only the activated form components. 

System Response
The Print dialog is displayed.

3 Do you need to change setup options (to select a specific printer, paper 
orientation, or size and source of paper) ? 

◗ If yes, click Properties. Set the appropriate options. Click OK to 
begin the print process.

◗ If no, click OK to begin the print process.
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Testing the Translation Object

Overview After you compile the form, print and verify the report, and register the translation object 
with Gentran:Server, you should test the translation object to verify that the data is 
translated correctly. To test the compiled translation object, you should use the translation 
object to create a new document. You also should verify acknowledgement processing (if 
applicable) and verify communications with your network.

Procedure Following is an overview of the procedure for testing the screen entry translation object 
you just created.

Step Action

1 Register the PETEINVS.TPL translation object with Gentran:Server. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on registering a translation object.

2 If you have not done so already, import the PETZONE2.PAR partner 
relationship into Gentran:Server. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on importing a partner.

3 Verify (in Partner Editor) that the Screen INVOIC Pet Zone screen entry 
translation object is selected for the Outbound Relationship. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on selecting outbound translation objects.

4 Create a new document (partner PETZONE2 and relationship 
PETZONE2_EDIFACT_INVOIC) to enter the data in the screen entry 
translation object you created. 

Reference
See the “Gentran:Server® Windows® User’s Guide” for more 
information on creating a document.
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GLOSSARY

Glossary

?In Documents This Gentran:Server browser contains a list of documents that were received by the 
system but failed compliance checking or that do not have an identifiable partner or 
transaction set.

?Out Documents This Gentran:Server browser contains a list of documents that were imported into the 
system via unattended processing but are invalid.

acknowledgement This term is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999 
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system 
activates all the groups, segments, composites, and elements that are defined as 
“mandatory” (must be present) by the standard. The system does not enable you to 
deactivate the mandatory groups, segments, composites, and elements. When translating 
data, the system does not process groups, segments, composites, and elements (or records 
and fields) that are not activated. Therefore, you must activate the groups, segments, 
composites, and elements that are not defined as mandatory by the standard, but that you 
have determined that you need to use in mapping.

AIAG The Automotive Industry Action Group (AIAG) is the standards-setting group for the 
automotive industry. The standards form a subset of the ANSI X12 standard. 

ANA Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and 
services, such as safety glasses and battery capacities. The ANSI X12 committee is the 
chief EDI standards-setting organization for the United States.

application file If you are creating an import or export map, you must define your application file to the 
Application Integration subsystem. In Gentran:Server terminology, your application file is 
also referred to as a fixed-format file or a positional file. Your application file must contain 
all the information that you either need to extract from your partner’s document (if the 
map is inbound) or need to send to your partner (if the map is outbound), so that your 
system can accurately process the data.
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application system Computer systems, outside of EDI, designed to fulfill specific business functions. These 
include accounting, purchasing, materials control, human resources, shipping, and other 
systems.

browser A browser is a window that displays a list of items, such as documents (transaction sets), 
interchanges, translation objects, etc. A document browser displays only documents.

check box A check box enables you to select or clear options from a list. You can select as many 
options from the list as you need. A selected check box contains a checkmark. The labels 
of unavailable options are dimmed.

code list tables These are used by EDI standards as repositories for lists of codes. Each EDI standard 
provides a code list for each element that can be further defined with a code.

colours This feature enables you to select foreground and background colors to visually define the 
various map components. The use of color is optional.

communications
session

Everything sent and received to/from one telephone number in one continuous period of 
connection. This could include sending two or three interchange envelopes to a network, 
each for a different trading partner.

compile This function creates a translation object. The form that you create is a source form. When 
that source form is compiled, the result is a compiled translation object. This translation 
object will need to be registered with the Gentran:Server system before you can use it.

compliant This means that the document conforms to the EDI standards as defined by the translation 
object.

component data
element

A simple data element that belongs to a composite data element. Component data 
elements are also called subelements.

composite data
element

A composite data element contains two or more component data elements or subelements. 
Composites are defined by the EDI standards that use them (EDIFACT, TRADACOMS, 
and certain ANSI X12 standards).

conditions See relational conditions.
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constant This standard rule enables you to move a literal constant value to the specified element or 
field, indicate a qualifying relationship with another element or field, and map the current 
date or time to the specified element or field.

cross-reference
table

This table is created in Partner Editor and is used to convert your values to your trading 
partner's values during outbound processing, or your partner's values to your values during 
inbound processing.

date/time This type of field or element contains a date or time. If you specify that a field or element 
will be a date/time type, you must specify exactly how the date or time must be formatted.

deactivation This function enables you to make map components unavailable for use by the system. 
The system does not enable you to deactivate the mandatory groups, segments, 
composites, and elements.

default A predefined value – programs use these built-in values unless you specifically override 
them.

document One transaction set containing actual data and treated as a single entity. The amount of 
data does not affect whether something is a document or not, only the fact that it is treated 
as a single entity. For example, regardless of whether a purchase order contains one item 
or ten thousand, if it is one purchase order, it is one document.

If a trading partner sends you a communication containing 10 purchase orders, you have 
received 10 documents. If the communication contained 15 invoices, you have received 
15 documents.

EANA International Article Numbering Association, Brussels, Belgium.

EDI Electronic Data Interchange (EDI) is the process by which companies can exchange 
business documents directly from application to application by computer without paper 
documents being produced.

EDI File Format
Window

The EDI File Format Window contains the EDI file format. When you click a segment or 
group in the EDI file format, the corresponding frame is displayed in the Layout Window. 
When you click an element in the EDI file format, the corresponding layout component is 
highlighted in the Layout Window.

EDI standard This is the rules for turning a business document into an EDI document.
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EDIA The Electronic Data Interchange Association, formerly known as the Transportation Data 
Coordinating Committee (TDCC). 

EDIFACT This is the standards organization of the United Nations Economic and Social Council. 
The acronym is short for the Electronic Data Interchange for Administration, Commerce, 
and Transport.

element The smallest piece of usable information defined by the standards. Examples include a 
quantity, unit price, or description. An individual element can have somewhat different 
meanings depending on context. Therefore, elements are normally not considered to have 
useful meaning until they are combined into segments. An element is the EDI map 
component that is mapped (linked) to a corresponding application field to move data to 
and from the EDI file.

There are three types of data elements, as illustrated in the table below:

envelope A way of separating information in transmissions for ease of processing. Each envelope 
contains a header segment and a trailer segment, which separate the envelope from other 
envelopes and provide information about the contents of the envelope. There are three 
levels of envelopes, as follows:

Transaction Set
Each transaction set (business document) is contained within a transaction set envelope.

Functional Group
An envelope containing related business documents. The standards define which 
transaction sets should be placed together into a functional group envelope.

Interchange Envelope
All material being sent to one trading partner in one communication. The term Interchange 
Envelope is the term used by ANSI. EDIA uses the term Transmission Envelope to refer 
to this level of envelope. Since we use the term transmission for other uses, we will refer 
to Interchange Envelope only.

Note
A communications session could easily include a number of interchange envelopes. For 
this reason, the standards-setting bodies are considering a fourth level of envelope to cover 
an entire communications session.

Data Element Definition

Simple data element A single piece of information defined by the 
standards.

Composite data element A data element that is made up of multiple 
component elements.

Component data element A simple data element that belongs to a composite 
data element. Component data elements are also 
called subelements.
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equalize This function enables you to reinstate the two sides of the map with focus in equal 
dimensions. The use of the Equalize function is optional.

export map This map defines how to move data from the EDI standard-formatted documents that your 
partners send you to your application file (flat file definition). An export map is necessary 
for inbound processing.

export translation
object

See export map.

extended rules These rules enable you to use a Gentran:Server proprietary programming language to 
perform virtually any mapping operation you require.

field The smallest piece of information defined in the application file. A field is the application 
map component that is mapped (linked) to a corresponding EDI element to move data to 
and from your application file.

fixed-format file See application file.

form A form is a set of instructions you define in the Forms Integration subsystem that indicates 
how the system should format data

frame A frame contains the groups, repeating segments, and elements at that level (single 
segments are not represented on the frame). Gentran:Server uses frames to format the EDI 
file for the translation object.

functional group A group of transaction sets that the standards-setting body (such as ANSI) has defined as 
fitting together with other related transaction sets. An example might be a Functional 
Group defined as containing all purchasing transaction sets.

group A looping structure that contains related records/segments and/or groups that repeat in 
sequence until either the group data ends or the maximum number of times that the loop is 
allowed to repeat is exhausted. If you create a group that is subordinate to another group (a 
subgroup), this corresponds to a nested looping structure (a loop within a loop). The 
application (positional) file and the EDI file are both groups and therefore, they is visually 
represented the same way as other groups and subgroups in Gentran:Server.

import This command enables you to import data from an external application file. Depending on 
the content of the file, the system may prompt you for partner, transaction, or translation 
object information.
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import map This map defines how to move data from your application file (flat file definition), which 
may contain multiple documents, to the EDI standard-formatted documents that your 
partners expect to receive from you. An import map is necessary for outbound processing.

import translation
object

See import map.

inbound mapping The system translates your trading partner’s EDI standard formatted business document to 
your application file format, so you can receive documents from you partners. To translate 
inbound data, you need to create an export map.

In Documents This Gentran:Server browser contains a list of documents that the system received but that 
have not yet been processed by the user. Once the documents are processed (printed or 
exported) the documents will be transferred to the In Drawer.

In Drawer This Gentran:Server browser contains a list of documents that were received and 
processed.

interchange The interchange contains all the functional groups of documents (transaction sets) sent 
from one sender to one receiver in the same transmission.

 Layout Window The Layout Window contains the actual format of the translation object. Each group (with 
a maximum usage greater than one) and repeating segment has a corresponding frame in 
the Layout Window. When you click a segment or group in the EDI file format, the 
corresponding frame is displayed in the Layout Window. When you click an element in 
the EDI file format, the corresponding layout component is highlighted in the Layout 
Window.

literal constant These are used by the system as a repository to store information that will be used at a 
later point in the map. Typically, constants are used in an outbound map to generate a 
qualifier.

location table This is a table created in Partner Editor that is used to contain address-related information 
about the partner.

lookup table This is a table created in Partner Editor that is used to select information related to a value 
in inbound or outbound data.
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loop count This standard rule enables you to count the number of times a loop is repeated, if the 
element or field is part of a loop. If the loop is a nested loop, you can track the current loop 
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop 
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can 
choose to count either the “15” (Y loop) or the “3” (X loop).

loop start/loop end Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE 
segments differentiate between two or more loops of the same type. If the transaction 
contains LS and LE segments and depending on whether your map is inbound or 
outbound, you will need to define the LS and LE segments for the loops you will be using 
in the map in one of two different ways.

map A set of instructions you define in the Application Integration subsystem that indicates the 
corresponding relationship between your application file and the EDI standards, and 
defines how the system should translate data. 

network Also known as a third party network or value-added network (VAN) that accepts and holds 
transmissions from companies until it is convenient for a trading partner to accept them.

number This type of field or element contains either an integer or real number. If you specify that a 
field or element will be a number type, you must designate the format by specifying a 
format of either “N” (integer) or “R” (real) and the number of decimal places.

ODETTE The Organization for Data Exchange by Tele-Transmission in Europe.

outbound mapping The system translates your application file format to EDI standard formats, so you can 
send documents to your partners. To translate outbound data, you need to create an import 
map and a system import map in the Application Integration subsystem.

Out Documents This Gentran:Server browser contains a list of documents that are ready to be sent. After 
the documents are successfully sent, they are automatically transferred to the Out Drawer.

Out Drawer This Gentran:Server browser contains a list of documents that were successfully sent out 
by the system.

partner Another firm with which your company trades documents. Also referred to as a trading 
partner.
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Partner Editor This Gentran:Server function enables you to define, edit, and delete all partner 
information for your company and all of your trading partners.

positional file See application file.

post This Gentran:Server function enables you to move compliant documents from the 
Workspace to the Out Documents.

predefined On a data entry translation object, a default value for a particular element. You can change 
the value as necessary.

printout This is produced when data received from a trading partner passes through a print 
translation object. You do not have to actually print the data. The printout could be to a file 
on your hard disk.

print translation
object

A print translation object organizes and formats the printout of EDI documents that are 
received from or sent to the trading partner(s) for which you have established a trading 
relationship (inbound or outbound) that utilizes that print translation object. The print 
translation object enables you to view the EDI document in an easily readable format.

promote This function extracts one iteration (instance) of a group or repeating segment. This 
enables you to map unique data from your application file, and/or enter a specialized 
definition. Gentran:Server specifies that only one-to-one (no loops) or many-to-many 
(loop) mapping relationships are valid.

qualifier This is an element that has a value expressed as a code that gives a specific meaning to the 
function of another element. A qualifying relationship is the interaction between an 
element and its qualifier. The function of the element changes depending on which code 
the qualifier contains.

radio buttons Radio buttons indicate a group of mutually exclusive options. You can only select one 
option at a time. Select an option by clicking the radio button or pressing the SPACE BAR 
until the option you want is selected. The selected option contains a black dot. The labels 
of unavailable choices are dimmed.

receive This Gentran:Server function enables you to manually initiate a communications session 
to receive data from a network through an invocation of the Connection Manager.

record Contains a group of related fields. A record can occur once or can repeat multiple times.
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relational
condition

This function enables to connect fields together for syntax or compliance reasons. For 
example, Field A is invalid unless Field B is present. Therefore, if you set up a condition 
that pairs Fields A and B, the system will generate a compliance error if one of those fields 
is not present.

respond This Gentran:Server function enables you to create a turnaround document (using the Turn 
Around translation object in the partner relationship) in response to one or more selected 
document(s) in the In Drawer.

responsible agency An organization that develops and updates standards for EDI communications. These 
organizations include ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.

screen entry
translation object

A screen entry translation object provides a standardized format for keying an EDI 
document into the Document Editor, for translation and transmission to your trading 
partner(s), for which you have established an outbound trading relationship that utilizes 
that screen entry translation object. The screen entry translation object ensures that your 
users key all the data necessary to create the required EDI document.

segment A group of related elements or composite data elements that combine to communicate 
useful data. Segments are defined by the EDI standards. A segment can occur once or can 
repeat multiple times. For example, a catalog price segment might consist of elements for 
item description, volume, price, lead time, etc. By themselves, none of these elements 
would communicate useful information. Together, they provide the information necessary 
for someone to tell if the item is what is desired, whether the price is reasonable, etc. A 
number of segments together form a transaction set.

select This standard rule enables you to select entries from a location table, cross-reference table, 
partner table, or lookup table (all tables created in the Gentran:Server Partner Editor). You 
can then map the fields in those tables to one or more fields in the data. The Select 
function uses the value of the current field to perform the selection.

send This Gentran:Server function enables you to manually start a communications session to 
send data to a network through an invocation of Connection Manager. Only selected 
documents are enveloped and sent. If no documents are selected, ALL documents will be 
sent. Successfully sent documents are moved to the Out Drawer.

set See Transaction Set.

simple mapping See link.
Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows – November 2005



split GlossaryGL - 10
split This function enables you to split (break) a group or repeating segment into two loops. 
You will typically use this function when you need more than one instance of the same 
map component that still occurs multiple times.

standard rules These rules give you access to functions that are necessary for mapping operations that are 
more complex than simple linking, but less involved than extended rules. Each of the 
standard rules are mutually exclusive (you can use only one on a particular field).

static text Static text is text that is always included in the screen entry or print translation object. 
Examples of static text include legends and column headings. Field labels, which usually 
accompany fields to identify the contents of the fields, are not considered static text.

status bar The status bar of an application window defines information about a selection, command, 
or process, defines Menu Bar items as the user highlights each item, and indicates any 
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key).

string This type of field or element contains one or more printable characters. If you specify that 
a field or element will be a string type, you must designate the format by specifying a 
syntax token.

syntax token This function enables you to designate a “token” that defines ranges of characters and/or 
numbers that are allowed to be used for a string-type element or field. You can then use 
the syntax tokens in the Format field of the Field Properties dialog. This enables you to 
define what type of characters should be used while compliance checking each element/
field (e.g., alphanumeric within a certain range).

system import map The translator uses this map to determine which trading relationship (established in 
Partner Editor) corresponds to each document in the application file, so the system will 
know which import map to use to process the document. You need a system import map 
that is defined in EDIMGR.INI to translate outbound data.

system import
translation object

See system import map.

system translation
object

These translation objects control the creation and separation of interchanges, functional 
groups, and transaction sets. They also used to generate and reconcile functional 
acknowledgements. All the required system translation objects are automatically installed 
with the Gentran:Server system.

TDCC See EDIA.
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TDF TDF is the Transaction Data File. This file serves as a filter between your document files 
and the Gentran:Server translator. For outbound processing, data is imported from a TDF 
file and translated to EDI format using a TDF Import translation object. The data is then 
ready to be posted and sent to your trading partner. For inbound processing, EDI 
documents that are received by Gentran:Server can be exported to a TDF-formatted file 
using a TDF Export translation object. This data file is then ready to be processed or 
converted to your internal application files.

third-party
network

See Network.

title bar The title bar of an application window contains the name of the application and enables 
you to move the window to another position on your desktop.

toolbar This contains buttons that graphically represent commands available in the Menu Bar.

TRADACOMS The U.K. standards for EDI that are published by the Article Numbering Association 
(UK) LTD. 

trading partner Another firm with which you company trades documents. Also referred to as a partner.

transaction set
(document)

A business form as defined by the standards. Examples include an ANSI 850 purchase 
order or an UCS 880 invoice. The standards define each transaction set in terms of the 
segments and elements that make up the form, the order in which they appear, and the 
relationships among them. This is also known as “message” in Europe.

translation object A predesigned layout set up to ensure that input or output for a particular transaction set 
exists and is presented in a usable fashion. You must specify which translation object(s) 
will be used by each partner relationship.

Inbound Translation Objects:
Turn Around: This translation object is used when a document is received, to create the 
natural response document that contains as many elements from the received document as 
possible.

Export File: This translation object indicates that when a document is received, it will be 
exported to a specified file format.

Print: This translation object is used to print documents.

Outbound Translation Objects:
Import: This translation object is used to import data from an application file.

Print: This translation object is used to print documents.

Data Entry: This translation object is used to enter data into the Document Editor facility.
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translator This is the engine that processes data for the Gentran:Server, Application Integration 
subsystem and Forms Integration subsystem.

transmission See Communications Session.

transmission chain A path an EDI communication could follow, including one company, one trading partner, 
and one or more network services.

turnaround
document

A document into which data elements from the source document have been automatically 
transferred using a turnaround map.

turnaround map A series of instructions that the system uses to create a turnaround document (a logical 
response document to the source) from an inbound (source) document, by transferring 
data from the source document to elements in the target document (translation object).

UCS The Uniform Communications Standard is the standard used by the grocery industry.

update This standard rule enables you to update a specific field in a document record, envelope 
segment, interchange, group, current partner, or document (if the map side format type is 
EDI), with the contents of the element or field.

use accum This standard rule gives you access to a set of numeric variables that you can manipulate 
via numeric operations, and then transfer to and from fields. This function enables you to 
add, change, or delete calculations for the element/field, including hash totals (used to 
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you 
to map the accumulated total into a control total field, and use accumulators. 
Accumulators are used generally for counting the occurrences of a specific element or 
generating increasing or sequential record or line item numbers.

use code This standard rule enables you to match an element or field against a predefined code 
table, specify whether or not a compliance error will be generated if the element or field 
does not contain one of the values in the code table, and store a code’s description in 
another element or field.

user translation
object

These translation objects control data entry, importing, exporting, document turnaround, 
and creating printed reports. These translation objects are created using the Application 
Integration or Forms Integration subsystems. The Application Integration subsystem 
enables you to generate import, export, and document turnaround translation objects. The 
Forms Integration subsystem enables you to generate data entry and print translation 
objects.
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version Each standards-setting body updates its standards on a regular basis. Each formal update is 
referred to as a version.

VICS The Voluntary Inter-industry Communication Standards is the standards-setting body for 
the retail industry, a subset of ANSI X12.

Workspace This Gentran:Server browser contains a list of outbound “Work in Progress” documents. It 
also contains recently imported or data entry documents.

X12 The ANSI committee that sets and publishes standards for EDI. 
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